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Introduction to
Executive Card Manager

Welcome to Hewlett-Packard’s Executive Card Manager (ECM) is an

Executive Card information management system that captures the speed
and power of your personal computer within the
Manager convenient form of a rotary card file.

You use ECM just as you'd use a ROLODEX Card File,
except ECM simplifies your work. When you add cards,
ECM automatically files them in their proper place. If you
want to read a specific card, ECM finds it for you. If you
want to inspect these cards that refer to a specific event,
ECM quickly locates them and displays them for you to
view. If you want to place a phone call, ECM not only
finds the appropriate card but also dials the number for
you. ECM will also generate your reports while giving
ample formatting flexibility. Futhermore, ECM lets you
design and print form letters and their accompanying
mailing labels.

You may have as many different cardfiles as you need to
meet a wide variety of business, professional, and personal
needs, such as:

client information
patient histories
employee information

invoices
personal addresses

tax records

|

|

|

|

@ phone messages
|

|

@ bibliographies
|

record or book catalogs

Introduction to Executive Card Manager 1



How to Use the
Books for ECM

Executive Card Manager: Templates (HP Product Number
68335F) is a companion product to ECM. It consists of a
series of predesigned forms and report formats that can be
put to immediate use. These Templates will save you the
time of gathering all the information that it takes to design
your own card forms. You can use the Templates as they
are or adapt an existing form to create a card form that
suits your needs.

Three books are provided for you with ECM. They are:
& Setting Up Executive Card Manager

& Executive Card Manager

B Quick Reference Card to Executive Card Manager

Setting Up Executive Card Manager provides the details to
get ECM up and running on your personal computer. Read
this manual and follow the instructions for installing ECM,
setting up your printer, and authorizing ECM as a
preliminary step before you begin using ECM.

This book, Executive Card Manager, includes both
Learning Executive Card Manager and Using Executive
Card Manager. If using ECM is a new experience for you,
we suggest that you begin by using Learning Executive
Card Manager. It is a tutorial that teaches you how to use
ECM. The tutorial contains five sessions that teach you the
basics of using and creating a cardfile. Altogether, the
sessions take about an hour to complete, but you can stop
at the end of any session and continue at a later time.
When you are finished, you will know enough about ECM
to set up and use your own cardfiles.

2 Introduction to Executive Card Manager



Using Executive Card Manager is a complete reference
guide to the features of ECM. You'll probably read this in
bits and pieces when you need specific information on a
certain task.

A Quick Reference Card to Executive Card Manager. You
will find this card is a handy reminder for more difficult

tasks for ECM. The card opens out of the binder for easy
reading, or you can take it out and set it up next to your
computer.

Executive Card Manager: Templates
If you have purchased the Templates package, you also
received a manual that describes each of the templates and

shows a variety of ways that you may print the information
contained within the form.

Introduction to Executive Card Manager 3



What We Mean
When We Say...

ECM works with three input devices: your computer’s
keyboard, touch, and a mouse. The following table tells
you what our instructions mean for the different input

devices.

When we say. . . And you're using. . . You should. . .
Choose the keyboard Choose the function key that
corresponds to [[INIITIREITIN -
touch Touch on the display.

a mouse Move the Pointer to
on the display, then press and release
the left button of the mouse.

Highlight the keyboard Press (or + ) until the
item you're choosing becomes
highlighted.

touch Touch the item on the display that
you're choosing.

a mouse Move the Pointer to the item on the
display that you're choosing, then
press and release the left button of the
mouse.

Press the keyboard Press on the keyboard. (You can't
use touch or a mouse.)
Type text the keyboard Type text on the keyboard as you

would on a typewriter.

4 Introduction to Executive Card Manager



KGYbOal'dS The keys on your personal computer keyboard are grouped
according to their functions. The location of some keys on
the HP Vectra keyboard varies from that on the IBM AT
keyboard; however, they perform the same functions in
ECM. The following keyboard pictures show how the keys
are grouped on each keyboard. Refer to your personal
computer manual if you need more information about your

keyboard.
HP Vectra Keyboard
Function Typewriter Cursor Control Status
Keys Keypad Keypad Lights
N I
i G BN e 7 - . 31

/ § -

[ A ([ [ o [ A [ [ R
tEB -~ EEEE)
MH) E)OOOOO0NO0O0000 oo
DOOOROO0000 DO D00
NN [ Gl [ Y | o0 [ ﬂ
i ) ]|
” Numeric
Keypad
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IBM AT Keyboard

Tab Key Status Lights
af h
) o) o]
(=] (=) @E] Sl
()] @@@DDDD@

[~ (=] GO Y GO G T G G e G A Y el LB
G | G0 G} GO 1 G O 5 i A

(o] [ _ (5a]

- _J
Function Typewriter Key Area Numeric
Keys Pad
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Before You Begin

;\Gett(iqg Started with ECM

This session shows you how to begin using ECM. You will:
® Start ECM from PAM or DOS.

® Look at a typical ECM menu.

B Get some tips for learning ECM.
B Get the cardfile you want to use.
& Locate cards.

B Select a card for reading.

® Read a card.

|

Print a card.

Before you begin using ECM you should have:

8 your computer set up
B your printer set up
m a work copy of ECM

If these are not done, refer to Setting Up Executive Card
Manager. This booklet contains information concerning in-
stalling your application, setting up your printer and
authorizing your application.

You can start ECM from PAM or DOS. If you need

assistance with either PAM or DOS, refer to the manual
that came with your personal computer.

Getting Started with ECM 1-1
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Starting ECM With the PAM Main screen on your display:
from PAM 1. Is your ECM work copy on a flexible disc?
If YES. . . place the ECM work copy into the drive.

If NO. . . your work copy is on a hard disc, go on to
step 2.

2. On the PAM Main screen, highlight
[ £xecutive CardManager B

3. Choose |IHEE Applic

.
rla}n Menu

Stact Applie, or type a DUS command 0

7-31-1985 9:15:u48

Highlight this box to select ECM. =

Choose this label to start the
application.

The PAM Main screen goes away, and ECM displays its
Main menu.

1-2 Getting Started with ECM



Starting ECM
from DOS

Type ECHM at the DOS prompt and
press to start the application.

With the DOS prompt on your display:
1. Is your ECM work copy on a flexible disc?

If YES. . . place the ECM work copy disc into the

If NO. . . your work copy is on a hard disc, go on to

2. At the DOS prompt, type ECM.

3. Press [Enter].

r

\_

In a moment the ECM Main menu is displayed.

Getting Started with ECM 1-3
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Looking at an
ECM Menu

The Main menu is one of several menus that ECM presents
to help you perform a task. Like all ECM menus, it con-

tains information to help you use the program.

Take a moment to study the following picture and locate
the information as it actually appears on your display.

MESSAGE LINE prompts you and —

provides other helpful information.

Refer to this when you're not sure
what to do next.

INPUT LINE is where you type
responses to ECM. When ECM is
ready for a typed response from
you, the cursor automatically ap-
pears on the input line.

1-4 Getting Started with ECM

MENU NAME tells you where you
are in ECM and usually describes
the task you're currently
performing.

CARDFILE NAME tells you which
cardfile ECM is\currently using.

Executive Card Manager

MAIN Cardfile: A:\None
"

I
FUNCTION LABELS present you
with a menu of actions for ECM to
take. When the menu name
changes, so do the function labels
that appear.



Tips for Finding
Your Way
Around ECM

Get Familiar with
the ECM Menu
Organization

If You Get Lost,
Read the Menu
Name...

...Then Choose the
Function Key...

O
=3
[
T
-
[1]
=
-

The following tips can make it easier for you to learn ECM
while you use this booklet. They can also help you develop
the skills you need to explore more advanced features on
your own.

Take the time now to learn where ECM displays helpful in-
formation in a menu. We'll be constantly referring to menu
names, function labels, and messages throughout this
booklet to help you verify that you're in the right place in
ECM. (If you didn't study the picture of the Main menu in
the section on Looking at an ECM Menu, please do before
you begin the next section.)

The menu name is your signpost to where you are in
ECM. 1t tells you the kind of tasks you can perform with
that menu, and can usually tell you which menu was on
the screen just before the current one.

The function key does two important things:
m It takes you to the menu before the current menu.

® It cancels anything you've done at the current menu (ex-
cept in the Select, Field Types, Make/Adjust, Adjust
Field, Printer Setup, Break Options, and Set Breaks
menu).

Getting Started with ECM 1-5



If you're not at the menu you want, you can choose this
function key to get you to the previous menu—probably
the one at which you took the wrong turn. If that menu
doesn’t look familiar, you can continue this process until
you get to the Main menu.

...And Use the Map The Map of ECM, located in the back cover of this book,

to ECM shows you how to get from menu to menu. The map is
easiest to use when you're at the Main menu, but it can
help you no matter where you are.

1-6 Getting Started with ECM
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Getting a Cardfile In these exercises you use a sample cardfile named
IMPORTS.

To get the IMPORTS cardfile:
1. From the Main menu, choose IR IEITEENEH.
ECM displays the Cardfile Tasks menu:

This part of the menu name tells
you which menu was on the
display before the current one.

|

ILE_TASKS Cardfile: A:\None

2. Choose [ISESIFTITN -

Notice that the message line prompts you to type in
the cardfile name. On the input line, ECM
automatically types in the file pathname for you, so
all you have to enter is the cardfile name.

Getting Started with ECM 1.7



3. Type imports, checking the input line for the text as
you type it.

If you make a typing mistake, just back up to the in-
correct letters and type over them.

When typing a cardfile name, you can type capitals, small
letters, or a combination of the two.

i
S o i [ o I *

_— —— e

—

O8O OUUBED0) EEEE)
e @@@@D@@@ (k)
(G o o G Gl G 0 ) G A EOO)E 0
T OONAORORO00E |6
] ( ] ) e k]
_ /[

If you make a typing mistake, use
either key to back up to the incor-
rect letters.
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4. Press [Enter].

The message line tells you that ECM is opening the
cardfile. In a moment, ECM shows you the IMPORTS
cardfile on the Cardfile Tasks menu:

Each card has an index tab with
information that identifies it.

( Executive Card Manager MAIN: CARDFILE TASKS Cardfile: A:\IMPORTS \

_/ Robinson-\ /
/ Scientif-\
/ Toys Int-\

/ Wines of-\
/ Wines of-\
/

Boerinan-\
merican Exports, Inc.
hirley Cochrane
18-125-0110

/ Autos of-\

/ azilia-\
B‘ / Ceramics-\
\ / Chocolat-\

/ Dallas S-\_

The cards are arranged
alphabetically.

\
_/ Hellenic-\ \

/ Irish Im-\ \
/ Lati

Tl‘7is is the open card, or the one
in open-card position.

5. Choose |IETSEEN .
ECM returns to the Main menu with the IMPORTS
cardfile displayed.

Getting Started with ECM 1-9
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Locating Cards
in the Cardfile

Scrolling the Cardfile

ECM looks and works much like the familiar desktop
rotary cardfile. You can “turn its knobs” by scrolling to scan
many cards quickly. Or, you can pinpoint a specific card if
you know which card you want to see, without scrolling
through lots of cards. You'll locate some cards in the IM-
PORTS cardfile using both methods.

To scroll the cardfile with the cursor keys:

1. Locate the [a] and [v] keys on your keyboard:

D ) i [

= =
CIJ@IEI B I I CIEEE]

Ca[alalalslalas]sn] O
MEFD BOOOO0O00000 D000
OEEDO00000000E Lme)
\ I ) e )

J
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You press one of these keys to
scroll the cardfile.

2. Press|[a].

ECM scrolls up the cardfile continuously until you
stop pressing the key.

3. Press[¥].
Now the cardfile scrolls down.



Scrolling card-by-card with cursor keys. To scroll one card,
you press the [a] or [v] key once instead of pressing it
continuously.

Scrolling with  If you ordered HP Touch or a mouse with your personal
Touch or a Mouse computer, you can also scroll the cardfile using touch or a
mouse. The following table describes the steps you will

use:
Scrolling with. . . You must. . . Then. . . What happens
a mouse move the Pointer to press the left button ECM scrolls up (or
an up (or down) of the mouse. down) the cardfile con-
arrow on the right (or tinuously until you
left) knob. release the button.
touch touch an up (or ECM scrolls the card
down) arrow on the file continuously until
right (or left) knob. you take your finger off

the knob.

Executive Card Manager MAIN: CARDFILE TASKS

_/ Robinson-\
/ Scientif-\
/ Toys Int-\
/ Wines of-\
/ Wines

Left Knob—up arrow —|

_/ ‘Aperican-\
American Exports, Inc.
Shirley Cochrane
218-125-0110
/ Autos of-\
/ Brazilia-\

/ Ceramics-\_

Left Knob—down arrow —-

_/ Hellenic-\
/ Irish Im-\
/ Latin Am-\

Getting Started with ECM 1-11
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Asking for a Card
by Name

1-12 Getting Started with ECM

If you know which card you want and it isn't on the
menu, you can pinpoint the card, bringing it into the open-
card position without scrolling. You do this by asking for it
by name—that is, by typing the name that appears on the
index tab. Try this now.

To pinpoint the card for Hellenica Exports:

1. With the rotary cardfile appearing on your display,
type hellenic.

Look at the input line to see the text that you just
typed. Notice that you typed in only the first eight
characters of the company name. When pinpointing a
card, ECM uses at most eight characters of the name
you type in.

2. Press [Enter ],

ECM brings the card for Hellenica Exports into the
open-card position.

Suppose there were no card for Hellenica Exports in the
cardfile? Then ECM would have pinpointed the card after
the one you asked for; in this case, Irish Import-Export
Service.



O
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SEIECting a Card When you want to read more than just the first three lines
for Reading of a card, you can select a card and ECM will display it.

Selecting a Card  To select the Chocolates of Belgium card with the
with the Keyboard  keyboard:
1. With the rotary cardfile appearing on your display,

scroll the cardfile until you see the index tab that says
Chocolat-.

2. Press (or + ) until the index tab of the
Chocolates of Belgium card is highlighted.

3. Locate on the keyboard:

- R
o N o e - % 3m
OoON0000UD00D000E BEEE)
I |G} ) Gl G A O O GO G A 1 ) ] ) | B E B &)
G G i G G ) O DO a0
S | G G GOl G )l 2SN | P

L |
|

You press this key to select the
chosen card for reading.

4. Press [Fo].
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ECM brings up the Select menu and shows you the
Chocolates of Belgium card:

< )

\IMPORTS
Bz

Cardfile:

Chocolates of Belgium

/ Chocolat-\

##% IMPORTS CARDFILE w###

Company
Agent’s Name
Telephone

Next Contact 8

(YY/MM/DD)
Street Address
City

Country

Card Last Updated

Specialties DEF

-

Now, return this card to the cardfile:

5. Choose |BGEFRE.

ECM returns to the Main menu with the previously

selected card—Chocolates of Belgium—in the open-card
position.
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Selecting with
Touch or a Mouse

If you ordered HP Touch or a mouse with your personal
computer, you can also use touch or a mouse to select a
card. The following table describes the steps you will use.

With the rotary cardfile appearing on your display:

To Select a Card
with. . .

You must. . .

Then. . .

What Happens

a mouse

touch

move the pointer to
the card’s index tab.

touch the card’s index
tab

press and release
the left button of
the mouse.

ECM shows you the
card in the Select
menu.

ECM shows you the
card in the Select
menu.

Getting Started with ECM 1-15
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Reading a Long
Card

Flipping Pages of
a Long Card

The cards in IMPORTS are long cards. That means every
card contains more than one page—a screenful—of
information.

To read the entire card, you can flip the pages back and
forth. Or, you can roll the card up or down one line at a
time.

1. With the rotary cardfile appearing on your display,
select a card of your choice.

The card you chose appears in the Select menu.
2. Locate [PgDn]and [Paur] on the keyboard:

You press one of these keys to flip
the pages of a long card.

116 Getting Started with ECM




3. Press[Pgon]
ECM shows you the second page of your card:

SELECT

Executive Card Manager
1y
1

Cardfile: A:\IMPORTS

Comments

This is the bottom of the card. It
means that ECM is displaying the
last page of the card.

.

4. Press[rgup].
ECM brings back the previous page of your card.

This is the first page of the card. (You can tell it’s the first
by the index tab at the top of the page.) Notice that this
page doesn’t have a bottom. That’s how you can tell that a
card is long: the first page won't have a bottom.

Getting Started with ECM 1-17
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Rolling a Long Card

1-18 Getting Started with ECM

You can also roll a long card using the keyboard. With the
Select menu on your display:

1. Press on your keyboard.

The status light comes on. This means when you press the
(2] and [v] keys, the card on your screen will scroll (rather
than the cursor move).

2. Press once.
The card rolls up by one line.
3. Now press [2] until the computer starts to beep.

ECM rolls up the lines of the card until it reaches the
bottom of the card—that’s when it starts beeping.
ECM also stops rolling when you release the keys.

4. Press again.

The status light goes out and the cursor arrow keys return
to their normal functions.

Now return the card to the cardfile:

5. Choose IRSEETE.

ECM brings up the Main menu, ready for another
task.

Rolling a Long Card with a Mouse

If your computer doesn’'t have a mouse, continue to the
next section titled, Printing a Card.

1. With the rotary cardfile appearing on your display,
select the card you want to read.



Printing a Card

2. Holding down the left button of the mouse, drag the
mouse so that the Pointer moves toward the bottom
of the card.

The card rolls up until you stop dragging the mouse,
release the button, or until you reach the bottom of
the card.

3. Now do the same thing in step 2, but in the opposite
direction.

The card now rolls down.
4. Return the card to the cardfile by choosing |ETEFE

If your computer doesn’t have a working printer attached, con-
tinue to the next section titled End of Session 1.

You can get a convenient printed copy of a card by selec-
ting the card, then printing it from the Select menu. Try it
with a card of your choice in the IMPORTS cardfile:

1. With the rotary cardfile appearing on your display,
select the card you want printed.

The card you selected appears in the Select menu.
2. Choose ESEEN

ECM prints the entire card.
3. Choose to return to the Main menu.

There are other ways to print information in a cardfile. You
can print just a portion of a multipage card. Or you can
print reports and mailing labels. (In Session 5, you'll see
how to print reports.)
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End of Session 1 Now that you know how to select and read cards, feel free
to browse through the the IMPORTS cardfile on your own.
When you're finished browsing, be sure to return to the Main
menu.

Leaving ECM  If you want to exit ECM at this time, go to step 1. If you
want to continue, go on to Session 2, Creating a New
Cardfile.

With the Main menu on your display:

If the Main menu isn't there, use the Map of ECM on the
inside of the back cover to help you return to the Main
menu.

1. Choose |00

ECM prompts you to confirm that you want to leave
the program.

2. Choose KIS

After a few moments, the PAM screen (or the DOS
prompt) appears.
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Before You Begin

Creating a New Cardfile

To create a new cardfile, you first draw the form of its card
to show the information you want in it and how it’s laid
out. Then you tell ECM such things as how the cards
should be ordered in the cardfile. Finally, you tell ECM to
save a new cardfile on the disc which uses the form for its
cards. At that point, you've created a new cardfile and can
begin adding cards to it.

In this session, you will:

B Draw the card form on the display.
m Tell ECM to arrange your cards in the order you want.

B Save a new cardfile on the disc.

If you left ECM after Session 1, start the program again. (For
a refresher on starting ECM, reread Starting ECM, in Ses-
sion 1, page 1-2.)

Creating a New Cardfile 2-1
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Drawing a Form To begin drawing a card form:
1. From the Main menu, choose [[RIETEETTE
ECM shows you the Cardfile Tasks menu.

2. Choose [NTTITEFIFIINT.

In a moment, ECM shows you the Create menu:

f Executive Card Manager CREATE ) ) Cardfile: None \

You draw the card form specifica- —_
tions in here. -

The cursor’s row and column _—
numbers in the card form.

2-2 Creating a New Cardfile



Moving the Cursor As
You Draw a Form

You can use these keys to move the cursor as you draw the

form:

000
00
e

JE_—)

)

J

Try these keys to see how they work. Watch the row and
column numbers change as the cursor moves.

Creating a New Cardfile 2-3
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A Sample Form: This is the form you'll draw in this session:

BIRTHDAYS

-

Titles

/ \

Labels

/] ]

AN

Fields %

tFirst Name ;

BIRTHDAYS

% Last Name

Birthdate (MY

.

Giving Your Form A title describes a cardfile’s contents and serves as a
aTitle memory aid for you. A title is optional, and you can
position it where you like on the form.

To give your form the title BIRTHDAYS:

1.

2.

2-4 Creating a New Cardfile

In the Create menu, move the cursor to row 3,
column 35.

Watch the row and column numbers to confirm
R 3 C 35.

Type BIRTHDAYS.




Creating Fields on A field is the blank you fill in with information. You need
Your Form  one field for each item of information. You can add a label
in front of a field to describe the information the field
contains.

To create the First Name label and field in the
BIRTHDAYS form:

1. In the Create menu, move the cursor to R ? € 5.
2. Type First Name.

If you make a mistake while typing the label,
backspace to the incorrect letters, then type over
them.,

3. Move the cursor to € 1t in the same row.
This puts a space between the label and the field.
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The first and last column numbers
of the field.

The highlighted backslash tells
you this column is in the field.

When you create a field, ECM
sitarts it at the column where the
cursor is located.

2-6 Creating a New Cardfile

]

4. Choose EIIYICREITICY
After a few moments, ECM displays the Make/Adjust

menu:

(Executive Card Manager CREATE: MAKE/ADJUST Cardfile: None

Row 7 Start Col 16 End Col 16

\

BIRTHDAYS

First Name ¥

|1

\_ ' Y,

5. Watching the End Col indicator, choose
so that the end column is 3k.

How wide did you make the field? For a big field, there’s a
quick way to figure it out without counting each backslash:
End Col - Start Col + 1 = Field Width. So the First
Name field is 36 — 16 + 1 = 21 columns wide.

6. Choose (TSI

ECM saves the First Name field and returns to the
Create menu. The cursor is in the first column of the
new field.



Modifying Fields lets you shorten, widen, move, and delete
on Your Form  existing fields in the form.

To shorten the First Name field:

1. Make sure the cursor is in the First Name field.

The cursor must be in the field you want to modify.
2. Choose to bring up the Make/Adjust

menu.

Z 1aydeyn

3. Choose [HEEIEEN once.
Now End Col 35.

4. Choose [ETTITEIP

ECM saves the change and returns to the Create
menu.

To make any change to a field, you use the same process

as before—except for step 3. The following table shows you what
to do instead:
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2-8 Creating a New Cardfile

If you want to do this . . .

Use this in step 3 . . .

move the field

widen the field

delete the field

(a], [¥], [, [=].

With touch: touch the field
and leaving your finger on it,
move your finger to where you
want the field positioned, then
let go.

With a mouse: position the
Pointer on the field, hold
down the left button, move
the field, then release the
button.

Widen Field

(Skip step 4—ECM
automatically returns to
the Create menu.)




Practice Creating  Create the other fields and labels of the BIRTHDAYS form.
Fields and Labels Use the following picture to help you position the fields at
the proper row and column numbers:
R3C 3\5 R7 IC 38 Row 7 Start Col 48 End Col 67
/
4 AN
T
[
©
! g
Row 7 Start Col 16 End Col 35 BIRTHDAYS
il \\ o
R 7C5 First Name
R9C5 Birthdate (MM/DD/YY)
R 11 C 5/,___—-Phone
L1
Row 11 Start Col 11 End Col 23—
ch (—
) )
— J

Row 9 Start Col 26 End Col 33
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Arranging Your
Cards in the
Order You Want

210 Creating a New Cardfile

To make ECM arrange your cardfile alphabetically by
name, last name first:

1. In the Create menu, choose [FTSEETITN.

The Field Types menu appears with the BIRTHDAYS
form:

BIRTHDAYS

First Name Last Name

Birthdate {MM/DD/YY)

Phone |

2. Move the cursor anywhere in the Last Name field.

3. Choose INSUSIXTIIR

The Last Name field is now set as the primary key
field:



When a field contains this, it's
been set as the primary key field.

/
)

BIRTHDAYS

Last Name Ki

Birthdate (MM/DD/YY)

The up arrow tells ECM to arrange
the cards in ascending order—
that is, from A to Z.

J

Because you set the last name field as the primary
key field, ECM will arrange the cards in alphabetical
order of the last names.

4. Move the cursor anywhere in the First Name field.

5. Choose [NSHSIEIEN

You set the First Name field as the secondary key field.
So cards with the same last name will be further ar-
ranged with first names in alphabetical order.

6. Choose [KEETTENTEI.

ECM saves the field type information and brings back
the Create menu.

If you don't choose any key fields, ECM picks one for you.
It sets the first field in the card as the primary key field.

Creating a New Cardfile 2-11
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Saving a New
Cardfile on the
Disc

End of Session 2

2-12 Creating a New Cardfile

ECM takes your form, builds a cardfile which uses the
form for its cards, and saves the cardfile on the disc. You
must give the new cardfile a name so that ECM can save it
on the disc.

To save a cardfile named after you:

1. From the Create menu, choose NS
ECM prompts you to type in a cardfile name.
2. Type the first eight letters of your first name (if your

first name is less than eight letters, type your entire
first name).

3. Press [Enter].

ECM tells you it’s creating the cardfile. When it’s
done, ECM displays your cardfile on the Main menu,
ready for you to add cards to your new cardfile.

If you want to exit ECM at this time go to step 1. If you
want to continue go on to Session 3, Adding, Updating,
and Deleting Cards.

1. Choose to return to the Main menu.

If you have trouble returning to the Main menu, use
the Map to ECM on the inside of the back cover to
help you return.



FYI: Other Ways to
Create a New Cardfile

2. Choose I 140 .

ECM prompts you to confirm that you want to leave
the program.

3. Choose K.

After a moment, the PAM screen (or the DOS
prompt) appears.

You don't always have to start from scratch to create a new
cardfile. You may be able to take advantage of work that
you or somebody else has already done:

@ Use Executive Card Manager: Templates for ready-made
forms (HP Product Number 68335F). This companion
product to ECM contains over 20 ready-to-use forms, in-
cluding Address Book, Appointment Scheduler, Business
Contacts, Travel Expense Report, Stock Portfolio, and
Inventory.

B Copy an existing cardfile so you get not only the same
card form, but all of the same cards as well. (Refer to
Chapter 18: Copying Techniques in the Using part of
this book.

®m Copy just the card form of an existing cardfile, then
adapt the form to create a new cardfile. (Refer to
Chapter 9: Creating a New Card Form in the Using part
of this book.

Creating a New Cardfile 2-13
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Before You Begin

Adding, Updating, and Deleting
Cards

This session covers the basic tasks of maintaining a card-
file. You'll learn to:

B Add a card to a cardfile.
8 Update the information in a card.

B Delete a card from a cardfile.

£ 101deyd

1. Are you continuing directly from Session 2?

If YES. . . go the the next section titled Adding a
Card to the cardfile.

If NO. . . go on to step 2.

2. Start ECM. (If you need help, refer to Starting ECM
in Session 1, page 1-2 for instructions.)

3. Get the cardfile you created in Session 2 (it’s named
after you). If you need help, refer to Getting a Card-
file in Session 1, page 17 for instructions.

4. Return to the Main menu.
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Adding a Card to In this exercise, we'll provide the information for the first

the Cardfile card you add, and show you how to move the cursor to
other fields.

To add a card for John Doe:

1. From the Main menu, choose [IFFTEXE.

ECM shows you the Add menu with a BIRTHDAYS
card ready to be filled in:

Executive C
P 29 _ _— N N ’

BIRTHDAYS

The cursor is ready
for you to fill First Name
in the first field.

Last Name

Birthdate (MM/DD/YY)

Phone

After you fill in a card, choose this Choose this when you're finished
to file the card in the cardfile. adding cards.

2. Type John.

If you make a mistake, backspace to the error and
type over the incorrect letters.
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Caution w

You type information in the fields using capitals and small
letters—exactly as you want it to look on the card.

3. Press [Enter].
The cursor moves to the next field, labeled Last
Name.

4. Type Doe.

5. Press [mo].

[Tb ], like [Enter |, moves the cursor forward from one
field to the next. The cursor is now in the Birthdate
field.

6. Type 11s/22/33.

ECM automatically moves the cursor to the Phone
field because you filled in the last character of the
Birthdate field.

Watch out for fields where you fill in the last character
position. Remember not to press or after filling in
such a field. Otherwise, you’ll skip the field next to it.

Let’s say the birthdate should actually be 12/22/33. The next
step shows you how to move the cursor back to the
previous field:

7. Press + [Tab].

The cursor moves back to the first character in the
Birthdate field.

8. Change the month to 12.

Adding, Updating, and Deleting Cards 3-3
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9. Move the cursor to the next field in the card—the
Phone field.

10. Type (309)555-4u4yy.

Even though you filled in the entire Phone field, the
cursor stays put because Phone is the last field in the
card.

11. Choose IS
ECM files John Doe’s card and clears the fields.

If you had more cards to add, you could do that now
without leaving the Add menu. Since you have no more
cards to add to the cardfile:

12. Choose R

ECM takes you back to the Main menu. The last card
you added is in the open-card position.

Practice Adding Cards  Add at least one more card to your cardfile now. Try ad-
ding cards that don't have Doe as the Last Name field to
see ECM file them alphabetically. You can also add cards
for Jane Doe and Jeff Doe to see the First Name work as
the secondary key field.
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Updating To update John Doe’s phone information:

Information 1. From the Main menu, select John Doe’s card. (If you
ina card need help with selecting a card, reread the section,
Selecting a Card for Reading in Session 1, page 1-13.)

2. Move the cursor to the Phone field.

3. Type any new phone number you like.

If you make mistakes changing information, you might
want to go back to the way the card looked before you
started. To do that:

4. Choose [ETTTTIEETICTENN.

ECM shows you the original phone number. If you
had changed more than one field, ECM would have
returned all of them to their original form.

5. Back up to the first character in the Phone field and
retype the new phone number.

¢ 1a1deyd

6. Make sure the information in the card is what you
want saved.

If you choose I SEEIEE, PPN or IRTERT in

the Select menu, ECM automatically saves the card infor-
mation as it appears in this menu.

7. Choose [HOEFTE.

ECM returns the updated card to the cardfile and
shows you the Main menu.
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Deleting a Card 1. From the Main menu, select the card you want to

from the Cardfile delete.
2. Choose ESTTEEITN.

ECM asks you to confirm that you want to delete the
current card.

Caution w Once you delete a card, you cannot retrieve it.

3. When you are certain that this is the card you want
to delete, choose 3.

ECM deletes the card and shows you the next card in
the cardfile. (If you had deleted the only card in the
cardfile, ECM would have automatically returned to
the Main menu.)

4. Choose [BIEMER

ECM returns to the Main menu, where you can see
that the card you deleted is gone from the cardfile.
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End of Session 3

This is the end of Session 3. You may continue on to
Session 4, Finding Sets of Cards or you can exit ECM. If
you need assistance with exiting, refer back to Session 1,
Leaving ECM, page 1-20, for instructions.

¢ iaydeyd
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Before You Begin

Finding Sets of Cards

In this session, you'll learn how ECM can find all the cards
in the category you choose.

For example, suppose you want to know which companies
in the IMPORTS cardfile are in Italy. You would ask ECM,
“Which cards have Italy in their Country fields?” You pose
the question to ECM by asking for cards with specific
information in a particular field. ECM gets the answer by
searching the entire cardfile to find just those cards.

In this session you will ask ECM to do two kinds of
searches:

B Find all cards having the same information in a field.

@ Find all cards having similar information in a field.

v 131deyd

1. Are you continuing directly from Session 3?
If YES. . . go on to step 2.

If NO. . . Start ECM, (refer to Starting ECM in
Session 1 if you need help), then go to step 2.

2. Get the IMPORTS cardfile.

3. Return to the Main menu.

Finding Sets of Cards 4-1



Finding All Cards
with the Same

information in a
Field

4-2 Finding Sets of Cards

To find all companies in Italy:

1. From the Main menu, choose EEFREREEN.

ECM shows you the Find menu, where you see a
blank card for the IMPORTS cardfile:

N

sxs ITMPORTS CARDFILE ww»

Company
Agent’s Name
Telephone

Next Contact  (Yv/MM/DD)

Street Address
City
Country

Card tast Updated

Specialties

2. Move the cursor to the field labeled Country.

3. Type italy.

If you make a typing mistake, backspace to the
incorrect letters and type over them. You can type the
information in capitals, small letters, or a combination
of the two.



4. Choose IR

ECM searches IMPORTS for cards having Italy in the
Country field, then displays the workset of cards it
found on the workset Main menu:

You're using a workset and not a 1
cardfile. T N

Executive Card Manager MAIN Workset of: A:\IMPORTS

/ Orchards-\
/ Wines of-\

You can do the same tasks with a \_
workset that you can with a l, I
cardfile. I

A workset is a temporary cardfile that ECM creates from
the cards found in the search. It works very much
like a regular cardfile: you can scroll it, read and print
cards from it, even do searches on it.

5. If you viewed a card, choose to return to
the Workset Main menu.

Exiting a Workset = When you exit a workset, its cards are returned to the
original cardfile that they came from. Try that now:

1. From the workset Main menu, choose |

ECM asks you to confirm that you want to exit the
workset.

2. Choose to confirm.

ECM puts the workset cards back into IMPORTS and
returns you to the cardfile on the regular Main menu.

Finding Sets of Cards 4-3
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Finding All Cards  This is called a wildcard search. You ask ECM to look at
2 e’ portions of text in a field, rather than the entire field of
with SImlIar text. You'll see how useful a wildcard search can be in the

Information in a exercise which follows.
Field

To find all companies in which the next contact occurs in
1986:

1. Choose ITYISFA

2. Move the cursor to the field labeled Next Contact.
Notice that the date has the year first, then the
month and day.

3. Type gLx.
The asterisk tells ECM to search only for the dates
beginning with 8k and ignore the rest of the date.

4. Choose HTETYR

ECM searches the cardfile, then shows you the
workset of cards for all companies with dates for Next
Contact in 1986.

You can select a card for reading if you'd like to check the
Last Contact date. If you do, make sure you return to the
workset Main menu when you're done.

5. Exit the workset to return to IMPORTS on the regular
Main menu.
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End of Session 4

FYI: Other Kinds
of Searches

This is the end of Session 4. You may continue on to
Session 5, Printing Reports or you can exit ECM. If you
want to exit ECM at this time, refer to Session 1, Leaving
ECM, page 1-20, if you need assistance.

We covered the most basic kinds of searches in this
session. When you found all cards with the same
information in a field, you did a literal (character by
character) whole word search. Finding cards with similar
information is a literal partial word search. ECM offers even
more types of searches, including:

8 Multiple-field search. You can fill in more than one field
in the Find menu.

@ Negative search. ECM matches everything that differs
from the text you entered in the field.

@ Numerical search. ECM compares numbers by their
values, not by the characters. You ask for cards with
values equal to, greater than, or less than the number
you filled in.

p ia1deyd

For details on these searches, refer to Chapter 14:
Searching for Specific Cards in the Using part of this
book.
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Before You Begin

Printing Reports

This last session shows you how to make a report from the
information in the IMPORTS cardfile. You will:

B Define a format for a report.

B Print a report on the printer.

® Save a report format.

® Conclude Learning Executive Card Manager.

1.

Are you continuing directly from Session 4?

If YES. . . go to the next section titled, Getting Ready
to Print Reports.

If NO. . . go on to step 2.
Start ECM.
Is the cardfile appearing IMPORTS?

If YES. . . go to the next section titled, Getting Ready
to Print Reports.

If NO. . . go on to step 4.
Get the IMPORTS cardfile.

Return to the Main menu.

Printing Reports 5-1
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Getting Ready to You need to get to the Print menu:
Print Reports 1. From the Main menu, choose [STTNTIITINTS.

In a moment, ECM displays the Print menu:

‘\

: A:\IMPORTS

5-2 Printing Reports



Defining a
Format for a
Report

Getting Fields
for a Report

A format provides ECM with instructions on how you want
the printed report to look. You normally create a format for
a specific cardfile. It takes three steps to define a format:

B Getting the fields to be included in the report
B Arranging the field layout and adding titles and headers
® Setting up the printer for printing reports

The report that you'll print for the IMPORTS cardfile will
include these fields in the order listed:

® Company
& Country
@ Agent’s Name

To get the fields for the IMPORTS report:

1. From the Print menu, choose [FTIEICEN.

The Get Fields menu with the IMPORTS card form
appears:
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( Executive Card Mana

This tells you the fields you've —4—
selected so far. / \

PRINT: GET FIELDS

: A:\IMPORTS

###% IMPORTS CARDFILE w#ww

ECM gives each field an identifica- — et
tion number, Telephone 3

Next Contact 4 (YY/MM/DD)

Street }
ity 6
Country 9

Card Last Updated

w

2. 1f no asterisk is in [T choose its
corresponding function key so that an asterisk
appears.

The asterisk in tells ECM that you're
getting fields for a report (and not a label) format.

You get the fields in the order in which you want them to
appear in the report. Begin with field 1:

3. Make sure the cursor is in field 1, labeled Company.
The field at the cursor position is highlighted.
4. Choose NSTIREIEEN

You just selected field 1 for inclusion in the report
format. Notice the message line:

Selected Fields: 1
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5. Get these fields in the order listed following the
instructions in Steps 3 and 4:

i. Country, field 9
ii. Agent's Name, field 2
6. Check to make sure the selected fields are in order:
Selected Fields: 1.9.2

If they're not in order, choose EITEISUSEEN and

start again from step 3.

7. Choose

ECM returns to the Print menu with the fields you've
gotten. The cursor is in field 2, the last field you
selected for inclusion in the report:

( kExecutive Card Manager PRINT Cardfile: A:\IMPORTS‘ \
pesi ; ’ v et Tarmery IR i)

Printing Reports 5-5

S 191deyd



5-6 Printing Reports

The next step will enable you to see the other fields as
well:

8. Press [Home].

Now you can examine the default report layout:

~

(Execut'we Card Manager PRINT Cardfile: A:\IMPORTS
Dedign & print format: Ty idig, orgekia Tarmatl R AE
1

Hysd {_

6 Hreaw T et 8 ECHM
. Options Fields o Main

_J

In the default report layout, the fields are the same size as they
appear in the card form, and they’re all placed on Row 1 in the
order that you got them.



Adjusting Fields
for a Report

When you get fields for printing a report, ECM
automatically adjusts them in a default, or standard, report
layout. ECM will print the report according to this layout
unless you readjust it.

Notice that field 2 (Agent's Name) runs past the end of
the display. This is normal if you are making a 132-column
report. In the following example you will adjust the fields
to fit in an 80-column report.

To do this, you will shorten each of the three fields. By
doing so, you will also shorten the amount of information
printed in each field. For example, if you shorten field 1
(Company) to 32 columns, you will only print the first 32
characters of each company’s name.

For this report, you'll shorten field 1 (Company) to 32
columns, field 9 (Country) to 20 columns, and field 2
(Agent's Name) to 24 columns.

G 1a1deyd
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To adjust the print width of fields 1, 9, and 2:

1. With the cursor in field 1, choose I¥FNEIIEN-

ECM displays the Adjust Field menu with field 1
chosen for adjusting:

Executive Card Manager PRINT: Adjust Fleld Cardhle A:\IMPORTS

M-@@
EJOEI0
Q-ﬂﬂ
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3.

Watching the End Col indicator, press until End
Col 31.

Notice that the other fields automatically shifted to
the left by one column each time you pressed [0eL]. (If

you had chosen instead of pressing
[oEL], the other fields would not have shifted.) Field 1

is now 31 columns wide.

But the field should be 32 columns wide. Here’s how to
widen the field:

4.

Press [ins].

This turns on Insert mode. When Insert mode is on,
the characters “IC” appear next to function label 5 on
your screen. Using with Insert mode
will automatically shift the other fields to the right in
addition to widening the field.

Watching the fields, choose once.

This adds a column to field 1 and shifts the other
fields to the right by one column. Now End Col 32.

Press [ins ] to turn off Insert mode.

The characters “Ins” disappear and you are no longer
in Insert Mode. Also, you've finished adjusting the
width of field 1.

Choose EITENI

ECM saves the changes to field 1 and returns to the
Print menu.

Now you adjust field 9 so that it’s 20 columns wide.
{(When field 9 is 20 columns wide, End Col 54.)

Printing Reports 5-9
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5-10 Printing Reports

9. Adjust field 2 so that it’s 24 columns wide (End Col
a0).

When you're finished adjusting the fields, you're back at
the Print menu.

Adding Titles

You can add titles and column headers to a report just like
you did when you drew a card form to create a new
cardfile. They can be different from the labels you used in
the form, too.

To add a title and column headers to the report:

1. Make sure the Print menu appears.

2. Press to move the cursor to the beginning of the
report.

3. Locate and [1] on the keyboard:




4. Press + [ four times to insert four lines.

5. Move the cursor to R1 €37 and type IMPORTS
REPORT.

6. Move the cursor to R3 €1 and type Company.

7. Move the cursor to R3 (35 and type Country.

8. Move the cursor to R3 €57 and type Agent's Name.
Your report layout now looks like this:

Executive Card Manager

PRINT Cardfile:

A:\IMPORT!
armat, 3

IMPORTS REPORT
Company Country Agent’s Name

g
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Setting Up the Printer
for a Report

5-12 Printing Reports

ECM comes with general-purpose printer setup values.
These values let ECM work with most printers in most
situations. But you can change these values to handle
exceptional cases; for example:

® You want to use a particular feature of your printer, such
as compressed print (check your printer manual for its
available features).

® You're creating an unusual, stylized report layout.

® Your printer requires special setup to work with ECM.

For this exercise, you'll create a typical report. However, if
your printer is either an HP Laserfet or a sheet-feed printer ,
it requires special setup values which you'll need to set in
the Printer Setup menu.

If you don't have one of these printers, you can continue to
the next section titled, Printing a Report on the Printer.



To change the printer setup values for the HP LaserJet or a
sheet-feed printer:

1. From the Print menu, choose NI

The Print Options menu appears:

IMPORTS REPORT

Company Country Agent’s Name

@]
3z
=D

o
o
2
w
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2. From the Print Options menu, choose [ETTIETNTE.
ECM shows the Printer Setup menu:

Executive Card Manager

S h gs

PRINT: PRINTER SETUP Cardfile: A:\IMPORTS

Top Margin Printer {agepdetyupTy @

Auto feed

VRS
£ ~
Compress Print NG

Print Width |

Lines Per Pag Lines Per Inch ! ]

This picture shows the defauItJ
printer setup values. The values in
your menu many be different.

Printer Setup String i

Print Blocks Across Page
Print Date |

Print Page Numbers

Lines Per Card | {$elect Screen Only)

Save sbDetallt THEE
. Values : L

For the HP LaserJet, this value For a sheet-feed printer, this
should be k0. value should be NO.

\—

The HP Laser]et prints 60 lines per page. A sheet-feed
printer works best if there is no auto feed; with no
auto feed, the printer will pause at the end of a page
s0 you can insert a new sheet of paper into it.

3. Check the picture above to locate the value that you
need to change for your printer. Move the cursor to
that field.

4. Choose |IFNTIEEMN or until the field
contains the proper value.
5. Choose RTINS

ECM beeps and tells you that it has saved the values.
These printer setup values will be used by ECM from
now on, until you change and save the values again.
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If you change the values but don’t choose [EYTEETN
ECM will use those new values until you exit ECM. Then
when you start ECM, the old values will be in effect.

6. Choose FIETIITEIN
7. In the Print Options menu, choose .

ECM returns to the Print menu.

g 1aydeyd

Printing Reports 5-15



Printing a Report If your computer doesn’t have a working printer attached,
continue to the next section titled, Saving a Report Format.

on the Printer

5-16 Printing Reports

1.

Make sure the printer is turned on and there is paper
in the printer.

In the Print menu, choose I ITEIIITITE.
ECM displays the Print Options menu.

If does not contain an asterisk, press its
corresponding function key.

The asterisk tells ECM you want to print the report
on the printer.

Choose NS

ECM tells you it’s printing, and the function labels
temporarily change to allow you to cancel printing:



When ECM is finished printing, the Print Options
function labels reappear.

5. When ECM is finished printing, choose |EEREIN -

Printing Reports 5-17
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Saving a Report You can save the format you defined. Then, at a later time,

Format you can get it and reuse it. This is especially useful when
you want to print reports for different worksets of the
same cardfile.

To save a report format under your name:
1. In the Print menu, choose | ITREA .
ECM prompts for a file name.
2. Type your last name and press [Enter].

ECM saves the format under the first eight characters
of your last name.

3. Choose to return to the Main menu.
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End of Session 5

FYI: Sample Formats

You've completed all the sessions in Learning Executive Card
Manager. You can exit ECM or try printing the sample
formats in the next section.

You'll find a couple of sample format files on your work
disc that work with the IMPORTS cardfile. They
demonstrate additional features of ECM’s print capabilities.
Use to bring up these formats:

@ ILABELS: this format prints out mailing labels for the
IMPORTS cardfile.

# IREPORT: this format is similar to the one you created
in this session, but includes a count field.

Along with ready-made card forms, Executive Card
Manager: Templates (HP Product Number 68335F) contains
report format files designed to work with its forms.

For more information on printing labels and reports, refer

to Chapter 17: Printing Reports, Mailing Labels, and Form
Letters in the Using part of this book.

Printing Reports 5-19
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End of Learning

Executive Card
Manager

5-20 Printing Reports

If you've completed all of the sessions in this book, you're
ready to begin making and using your own cardfiles. You
also know enough about ECM to do more sophisticated
tasks on your own. As you explore other features, you'll
find that the Using part of this book will be the best
reference tool to use.

We hope you've enjoyed this tutorial!



~Computer
=Museum

Preparing to Use ECM

Before you can put ECM to work, you must set up your
personal computer. Since a variety of personal computers
support ECM, you should consult the owner’s manual for
your computer for the necessary set-up procedures.

You should also read Setting Up Executive Card Manager as a
preliminary step to using ECM. This manual provides
useful information on connecting peripherals to your
personal computer for use with ECM and how to install
the ECM program.

We strongly recommend that you make a working copy of
ECM for use in your day-to-day tasks, then store the
master disc that came with this package in a safe place.
See the owner’s manual for your personal computer and
the set-up guide for this information.

Preparing to Use ECM 6-1
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The Equipment
You Will Need

6-2 Preparing to Use ECM

To use Executive Card Manager, you need:

B a personal computer that supports ECM

B sufficient internal memory to provide at least 128K bytes
of execution space

B a work disc with ECM installed on it

B a fixed disc; some blank, formatted flexible discs; or a
RAM disc with at least 32K bytes of available space

ECM works well without a printer. However, your
productivity with ECM may increase if one is available for
printing cards, labels, and reports.



Starting ECM

If you are using the HP Vectra personal computer, the
simplest way to use ECM is through the facilities of PAM
(Personal Application Manager). As its name implies, PAM
aids you in managing your application programs.

To start working with ECM, you should bring up the PAM
menu and choose ECM from the list of installed
applications. Your actual steps may vary depending upon
which personal computer you are using. (See your Setting
Up Executive Card Manager manual for the necessary
installation procedures.)

Bypassing PAM

You can also have ECM come up automatically, bypassing
PAM. (This procedure is called autostart.) For these details,
see the instructions on setting an application to start
automatically in the owner’s manual for your computer.

9 Jaidey)
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Some Special Certain words and phrases are especially important in
Terms ECM. The following list gives a brief definition of each.

autodial

card

card form

cardfile

current cardfile

field

field label

6-4 Preparing to Use ECM

The ability to have ECM dial a
telephone number, once you have
given it the proper instructions.

A card holds the information for each
entry in your cardfile. It resembles a

card in a ROLODEX Card File, except
ECM cards may contain multiple

pages.

The layout for a particular set of cards.
This includes all the items on the card
as well as the order in which they

appear.

A set of cards, which share the same
card form, that you have grouped
together under one name.

The cardfile with which you are
presently working.

The blanks that you fill in for each
item on a card. A field can be from 1
to 80 columns wide.

A name that you use to describe the
information that is stored in a field.



group

key field

function key boxes

function label

open-card position

pathname

workset

A set of fields that ECM links together
then treats as a unit when searching
for information.

A field that ECM uses to sort your
cards. For example, if you designate a
Last Name field as the primary key
field, ECM arranges your cards
alphabetically by last name. (Each card
form may contain a maximum of three
key fields.)

The eight highlighted boxes along
the bottom of your display that
correspond to the function keys
([F]~-[re] and [1]-[]) on the
keyboard.

The message inside a function key box
that describes which task that function
key currently performs.

When the image of a cardfile appears,
ECM shows the first three field lines
of the card that is currently in the
center of the rotary cardfile. This card
is said to be in the open-card position.

The information required by ECM to
pinpoint the location of a file on a
particular disc.

A temporary cardfile that ECM creates

for a specific task (such as finding
cards that meet certain criteria).

Preparing to Use ECM 6-5
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Looking at the
ECM Main Menu

Menu Heading

Working with ECM involves interacting with the image that
appears on your display. To simplify this task, most images
have a consistent look.

You will quickly learn that several screens seem to be
nearly identical. In fact, on some screens the center portion
remains the same and only the top line and function labels
change. Therefore, this manual uses the word menu to
focus your attention on these areas and to draw it away
from the screen.

A typical cardfile menu contains three parts:

i ; Cardfil A:\IMPORTS‘ “W

Screen Display —

Menu Labels ——C

6-6 Preparing to Use ECM

/ Orchards-\-

/ Robinson-\
- / Scientif-\
/ Toys Int-\
/ Wines of-\
/ Wines of-\
/

American Exports, Inc.
Shirley Cochrane
218-125-0110

/ Autos of-\
/ Brazilia-\

/ Ceramics-\
/ Chocolat-\

/ Dallas S-\_

_/ Hellenie-\
/ Irish Im-\

/ latin Am-\




The top portion of the menu contains three lines:

@ The top line is the banner line. It lists the menu’s name
and the name of the cardfile you are currently using.

@ The second line is the status line. It contains messages
for you and an indicator that shows the cursor’s current
position.

# The third line is the input line. When you must enter a
response on this line to tell ECM what to do, ECM
automatically positions the cursor here for you.

On the Main menu, the center portion displays a rotary
card file with its index tabs showing. Notice that this image
remains the same when you access the Cardfile Tasks
menu. On other menus, the center portion may display a
card form or some other structure. The important point to
remember is that you can always tell where you are by
inspecting the banner line and function labels.

The bottom of the menu contains the function labels. You
tell ECM what tasks to do by choosing the appropriate
label.

Be especially aware of the message for [Fe]. At times, you
may press this key when you decide you don’t want to
continue a task that you have begun. It is as if you had
started rearranging the furniture in a room and then
decided that you preferred the room in its original
condition. For example, when the message for indicates
IBSEE choosing this key returns control to the Main
menu and leaves everything the way it was. The only
exception to this rule is the Select menu. When you leave
this menu, any changes you have made to a card are
incorporated into your cardfile. (See Chapter 13 for details
on using the Select menu.)

Preparing to Use ECM 6-7
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USing ECM with The following keys perform special functions when the
Your Keyboard image of a cardfile or a card appears on your display.

(Some of these keys take on additional functions under
other menus. The appropriate chapter describe these

functions.)
Key
-

and

[n]- s8]

[a][¥]
<]

[Sertek] + [2]
[sere] + [7]

6-8 Preparing to Use ECM

Operation

These keys correspond to the function
labels that appear at the bottom of
your display. Choosing a function key
performs the task that the label
implies.

The arrow keys move the cursor one
row or one column at a time in the
direction of the arrow.

When a cardfile appears on your
display, pressing the [a ] key scrolls
forward one card while pressing the
(v ] key scrolls backward one card.

When an individual card contains so
many fields that its entire contents
won't fit on the display, pressing

+ [2] scrolls forward to the next
line of text, while pressing + [¥]
scrolls backwards to the previous line
of text.

When you press [seriek |, the Scroll
lock status light lights. Now, when
you press [2 | the text moves up on
you screen instead of the cursor
moving up. Press again to turn
the status light off and return the
cursor to its normal function.



When a card form contains multiple
pages, pressing the key brings
the next page of information into view.

When a card form contains multiple
pages, pressing the key displays
the previous page of information.

When a cardfile appears on your
display, pressing the key
highlights the tab for the first card in
that cardfile.

When a card appears on your display,
pressing the key moves the
cursor to the first field on the display.
If the cursor is already within the first
field that appears on the display,
pressing the key moves the
cursor to the first field on the form.

When a card appears on your display,
pressing the key moves the cursor
to the last field that appears on the
display. If the cursor is already within
the last field that appears on the
display, pressing the key moves
the cursor to the last field on the
form.

Preparing to Use ECM 6-9

9 131deyn



6-10 Preparing to Use ECM

Tab

(s + (W)

F10

When a cardfile appears, pressing
centers the cardfile on the first
card.

When a card appears, pressing
moves the cursor to the next field.

When a cardfile appears, pressing
highlights the index tab of the next
card in the file.

When a card appears, pressing
moves the cursor to the next field.

When a cardfile appears on your
display, holding down and
pressing highlights the index tab
of the previous card in the file.

When a card appears on your display,

holding down and pressing
moves the cursor to the previous field.

Pressing the key pulls a card from
a cardfile so you may inspect the
information on that card.



Using ECM with

Touch or a
Mouse

While you are working with ECM, you can simplify several
tasks if your personal computer supports touch or a
mouse.

Using touch is as intuitive as pointing out an object with
your finger. Using the mouse is an equally natural
extension of your hand. As you can make adjustments
when you try to touch an object, you can make similar
adjustments with the mouse.

You move the pointer to different parts of the display, then
press the left button to choose the object that the pointer
indicates. With touch, you combine the movement and the
pressing by simply touching the object. If the object is a
field, you choose that field. If the object is an index tab,
you choose that tab. If the object is a function label, you
choose that task.

Additional information on using these pointing devices for
a particular task appears as a NOTE with the instructions
that document that task.

You should use touch or a mouse only when ECM is
expecting directions from you and not when ECM is
performing a task.

Preparing to Use ECM 6-11

g 1a1deyn



LeaVing CM When you are ready to leave ECM:
1. Return to the Main menu.

If you are currently doing a task, you must tell ECM
you have finished each part of that task before you
can return to the Main menu.

2. Once the Main menu appears, choose |ESTIRGE.
ECM requests confirmation:
To confirm exiting ECM+ press "Yes"™.

3. If you decide to continue working with ECM, choose

o B

4. If you want to leave the program, choose K.

When you leave the program, ECM incorporates any
changes you have made, closes the current cardfile, then
returns control to PAM.

When the PAM menu appears, you can safely remove your
ECM application disc and your personal work disc.

Always remove your flexible discs from their drives before
you turn off the computer.
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Removing a Disc

Follow these instructions carefully to ensure the integrity of
the information that is stored on your discs.

To remove the ECM application disc:

Before you can safely remove the ECM application disc,
ECM has to pass control to PAM or the File Manager
program.

If you remove the ECM application disc, the following
message may appear:

Please put the application disc back in the
drive and press ENTER.

This happens when the task you want to do is not in
memory at that moment. You have not damaged your disc.
Simply replace the application disc into its drive as the
message requests.

Preparing to Use ECM 6-13
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Caution w

6-14 Preparing to Use ECM

To remove a personal work disc:

You can safely remove a personal work disc only when you
are in File Manager or when ECM displays the message:

You can switch discs now-

Avoid removing a disc from its drive when you are using a
cardfile that is on that disc. If you must remove the disc to
access another file (such as a print format file), be sure to
replace the cardfile disc you were using so you can
complete your task. When you forget this step, ECM
reminds you to:

Replace the cardfile disc in drive #.
(The # is replaced by the proper drive designator.)

Simply follow the instructions in the message to continue
your work.

If you remove a disc from its drive while ECM is accessing it
(that is, the red light is flashing on the face of the disc drive),
you may irreparably scramble information or lose it completely.
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Naming and Locating Cardfiles

This chapter introduces the terminology you need to work
with ECM cardfiles and your computer’s operating system.

Since ECM has to identify the individual cardfiles in your
cardfile library, you give each cardfile you create a name.
Then you use this name whenever you want access to that
cardfile.

Besides the cardfile’s name, ECM may require additional
information to locate a cardfile. In particular, if you have
created different directories or are using several discs, you
must give ECM a complete description of where it may
find your cardfile. Although the exact form of this
information depends on the operating system under which
ECM is running, the information that precedes the
cardfile’s name completely specifies the location. This
manual refers to that information as the cardfile’s
pathname.
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Naming a ECM uses the naming conventions established by your
cardfile personal computer’s operating system:
B A file name cannot contain any blank characters.

B A file name has a limit on the number of characters it
may contain. With DOS the limit is eight.

B A file name may contain upper-case and lower-case
letters; however, with DOS they are indistinguishable.

Thus, if you type RESTAURANTS or restaurants for a
cardfile’s name, DOS uses RESTAURA for the cardfile’s
name.

See the owner’s manual for your personal computer for a
complete listing of the naming rules that pertain to your
operating system.
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How ECM Handles
Cardfile Names

Although ECM recognizes cardfile names, it uses file
names when it interacts with your computer’s operating
system. That is, instead of sending the operating system
your cardfile, ECM supplies the operating system with
three files that, when taken collectively, constitute your
cardfile.

2 Jerdeyn

ECM gives each file a name that consists of your cardfile
name plus a file extension. (A file extension consists of a
period (.) followed by a maximum of three more
characters.) For example, if you named a cardfile IMPORTS,
ECM creates three files:

B IMPORTS.EDT
B IMPORTS.EFM
# IMPORTS.EIX

While the base name IMPORTS implies that the three files
are closely related, the extensions identify specific files,
each of which constitutes a part of your cardfile:

® The EDT file contains the information you entered in the
fields (such as names, addresses, phone numbers, and
so forth).

® The EFM file contains the design for the card form.

® The EIX file contains an index that tells ECM how to file
the cards.
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Choosing the Name

Caution w

Within the limits established by your computer’s operating
system, you should choose a name that describes the
cardfile’s contents. You may build the name from any of
the following characters:

B the letters A through z
the digits 0 through 9
the dollar sign

the ampersand &

the pound sign #

the percent sign
the apostrophe
parentheses ()

the underscore _

the commercial at sign @
the caret a

braces { }

the tilde ~

the exclamation point !

Some application programs require the first character of a
file name to be a letter.

Although you may use file extensions to group closely
related files, you should avoid using a file extension when
naming cardfiles.

If you are putting your own files in a directory that contains
ECM cardfiles, you should avoid using the following
extensions:

.EDT .EIX .EFM .SAV .IN% .RM% .VOL .DSK .MNU .MSG
.COM .BAT .EXE
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Locating a
Cardfile

What Is a Pathname?

When ECM asks for the cardfile’s name, it displays a
default pathname. For example, if the default drive is drive
B and the disc has no subdirectories, ECM displays: B:\
for the default pathname. (The B: stands for drive B, and
the slash (\) refers to the disc’s root directory.) When you
enter just the name for a cardfile, ECM uses the directory
identified by this pathname to locate the cardfile.

Each of the three files that make up your cardfile has its
own file name. Each file also has a pathname that tells
where it is stored. The form of the pathname varies
depending on which operating system your personal
computer uses. Because DOS considers each disc to have
its own root or main directory, it builds the pathname
starting with a drive designator that specifies which disc is
being used. Together, the pathname and file name specify
the full file name. For example, assume a file named
FICTION.EDT is stored in a subdirectory called FRANK on a
disc in drive B. Its full file name is:
B:\FRANK\FICTION.EDT. You may always distinguish
between files (or cardfiles) by giving the full name.
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What Is a Drive A drive name specifies which drive contains the disc you
Name? are using to store your files. If you have set up your
computer according to the instructions in your owner’s
manual, the disc drives assume these values:

& If you are using dual flexible discs, the drive on the top
is drive A and the drive on the bottom is drive B.

® If you are using a fixed disc, the fixed disc is in drive C
and the flexible disc is drive A.

& If you are using a fixed disc and dual flexible discs, the
drive on the top is drive A, the drive on the bottom is
drive B, and the fixed disc is drive C.

ECM displays the drive name as a letter, followed by a
colon, then a backslash (for example, A:\ or B:\). The
backslash (\) indicates the root directory for the disc in
that drive.

What Is a Directory? A directory is a grouping of files, just as a telephone
directory is a grouping of phone numbers. Every disc has a
root directory. But if you want to separate groups of files,
you can create subdirectories. For example, if you want to
keep your business cardfiles distinct from your personal
cardfiles, you could create two subdirectories: one called
BUSINESS and the other called PERSONAL. (The names for
subdirectories obey the same rules as file names.)

ECM identifies the root directory with a single backslash.
One or more subdirectories can follow the root directory,
and each subdirectory is followed by another backslash. For
example, A:\JIM\BUSINESS\ identifies Jim's business
subdirectory on the disc in drive A.
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Using the Default
Pathname

Changing the Default
Pathname

£ 1a1deyd

ECM assumes your cardfiles are located under a default
pathname. Unless you tell ECM otherwise, ECM always
searches for and stores your cardfiles in the location
specified by this pathname. Thus, when you want to use
the default settings, you just give the cardfile’s name.

If you don't want to use the default settings, you can
change the pathname in one of two ways:

B You can type the pathname that you want ECM to use.
B You can change ECM's default pathname.

When you want to access several cardfiles with another
pathname, you may use ECM to change the default
settings. (Thus, you avoid typing the pathname each time
ECM asks for a cardfile’s name.)
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To set a new default pathname:

1. Start from the Main menu where the function labels
have the following values:

2. Choose
labels:

Carcfiie Tasks

3. Choose IS "y
ECM now requests you to:

Type a directory name and press ENTER.
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4. Type one of the following responses:

If you only enter a drive name, ECM makes that drive
the default drive and that disc’s root directory the
default directory.

If you enter a drive name and a series of directories,
ECM uses this pathname for the default setting.

5. If you want to review what directory names are
already in use, you may choose [[ESTSERETTIa.

Choosing cancels the current operation leaving the
default pathname in effect. Also, the function labels return

to their previous values so you may continue with the task
at hand.

(You may also change ECM’s default pathname by using
the File Manager program. See Appendix E for the
necessary details.)
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Renamlng a The following procedure summarizes the necessary steps to

Cardfile with rename a cardfile using ECM’s built-in facilities. Chapter 18
provides more information on copying a cardfile (steps 47);
ECM and Chapter 10 gives additional details on deleting a

cardfile (steps 9-11).

By using ECM to rename a cardfile, you avoid the
bookkeeping associated with changing the individual files
in a cardfile as ECM does this work for you.

This procedure requires disc space to hold the new cardfile
and your time to build and delete the cardfile. You may
avoid these time and space requirements by using the File
Manager to change the cardfile’s name. Appendix E
provides these details.

To rename a cardfile:

1. Start from the Main menu.

2. Get the cardfile you want to rename.

3. Choose to display the Cardfile Tasks
labels if these labels don’t appear:

4. Choose ISTTREITIINT.
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5. Type a name for the new cardfile you are creating. Q

o
6. Copy FE
7. Choose to return to the Main menu. ~
8. Choose FETIREEE

labels:

9. Choose .
10. Type the name for the original (current) cardfile.

11. Choose to confirm that you want to delete this
cardfile.
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Keeping Track of These hints may help you remember a cardfile’s name:

Cardfile Names @ Use names that suggest the contents of the cardfile. For
example, if you have a cardfile for your clients, you
could name that cardfile CLIENTS. Or, if you have a
cardfile on fine hotels, you might name that cardfile
HOTELS.

@ Write the cardfile’s name on the label of the disc where
you stored it.

® Create a cardfile that contains all your cardfile names
(including the subdirectories where they are stored).
This cardfile resembles the data dictionaries of larger,
data base systems. When you create a new cardfile, call
up your “cardfile of cardfile names” and add another
card for that cardfile.

if You Forget a When you haven't worked with a cardfile for awhile, you
H P could easily forget the exact spelling of that cardfile’s name.
Cardfile’s Name If this happens, check the file listings under File Manager
and look for groups of file names that end with the
appropriate extensions (.EDT, .EFM, and .EIX). Whenever
you see this grouping, you know you've found a cardfile.

Once you discover the correct name (it is the base word
before the file extensions), you can return this information
to the ECM program. ECM calls this operation “returning a
file to ECM”. As this involves using File Manager, refer to
Appendix E for this procedure.
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Planning an ECM Cardfile

Suppose you just bought a new desktop card file.
Normally, the cards in it are blank since the manufacturer
has no idea how you will use the card file. If you're like
most people, you treat the empty cards as if they had a
predefined pattern, by putting information in specific
areas. For example you might place a person’s name on the
first line, their street address on the second line, and their
telephone number on the third.

g 121deyd

With ECM you go a step further as you put your mental
image of the card’s pattern into a concrete form. That is,
you first construct a form with special areas to hold the
pertinent information. These areas become the fields of
your card. Then, when you fill out individual cards, you
only type information into these fields; ECM prevents you
from typing information anywhere else. You may also put
helpful messages on the form. For example, you might
name the form with a descriptive title of the card’s
contents and give every field a label to ensure that you
enter the information correctly.

This manual calls the “fill-in-the-blanks” outline that you
create the card form.
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Creating a Card
Form

The Design Process

8-2 Planning an ECM Cardfile

Before you can put cards in an ECM cardfile, you must
create the basic form that each card will have. You can
have several cardfiles with the same form, or you can have
different forms for each cardfile.

You create a card form in one of two ways:

® Design a new form from scratch.

B Adapt a form that already exists.

Chapter 9 describes how you create a card form. The
remainder of this chapter gives guidelines that you should
consider when planning any cardfile.

Designing a card form, whether with ECM or with an
ordinary card file, takes a little thought. For example, you
should make a Last Name field long enough to hold the
longest name that you're likely to encounter; you should
make a ZIP Code field big enough for a 9-place number;
and you should decide what items belong on a single line
and what items belong on separate lines.

You may find that creating a card form is mostly
experimenting and improvising. In general, exploring the
alternative possibilities until one emerges as the best.
Therefore, ECM allows you to change the form as often as
you wish while you are designing it.



Deciding Upon Fields

2nd Sort Field

A card can be up to 255 lines long and 80 columns wide.
Within this area, you may place fields anywhere you wish.
If the form becomes so large that it exceeds the display
area, this poses no problem. ECM stores all the
information, and you can bring different portions of the
card into view by pressing the appropriate keys. (See
Chapter 6 for details on using your keyboard.) Each screen-
full of lines represents one page of the card. Besides
making cards of several pages, you may also shorten a card
if you want to conserve space.

Before you start placing fields on your form, you should
decide:

# what fields you need

# where on the card to put each field

@ how to label those fields that you want to label

#® how much room to set aside for each field

@ which field (or fields) to use for sorting the cards

('VExecutive Card Manager ADD Cardfile: A:\IMPORTS “\

/ \

#ad IMPORTS CARDFILE ###

st Sort Field

(YY/MM/DD)

Card Last Updated

Specialtie:
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8-4 Planning an ECM Cardfile

With a little thought, you can create a form that meets
your current and future needs. The following sections aid
you in this process. Check off the features on this list that
you need; then read the sections that pertain to these
features.
—planning the open-card display
filing your cards by name

filing your cards by date or time

using the automatic date or time stamping
feature

using the autodial feature
using ECM with other programs

planning to split a cardfile into smaller pieces

ECM extended features allow you to print the information
in a cardfile in a variety of ways. It also provides simple
solutions to sorting cards or transferring information
between programs. However, a little planning can also
simplify the use of these features.




Planning the

Open-Card
Display

When ECM displays a cardfile, it always shows one card in
the open-card position. For this card, ECM displays the
information that occurs within the first three field lines. By
placing the most pertinent information on these lines, you
can use your cardfile efficiently, without displaying the
entire card to read this information. Consider the following
card form:

(" )

/ A\

Address Book

. Last Name |

Title First Name

Street Address :

City ©
Phone Numbers: Home
Company

Street Address
City

\_ Y,

Is this a reasonable design?

When a card is in the open-card position, the person’s
name, business affiliation, and telephone numbers are
readily available. If you are using this cardfile as a
telephone directory, it probably gives you the most vital
information at a glance. However, if you want to send the
person an invitation for a social engagement, then you
must display the entire card.

Planning an ECM Cardfile 8-5
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8-6 Planning an ECM Cardfile

The conventional form for an Address Book might replace
the Company field with a Street Address field and replace
the Phone Number field on the third line with fields for
the City, State, and ZIP Code. This traditional form would
be less effective if you need quick-access to a telephone
number or the company name.

(" )

/ \

Address Book

Title Last Name

Street Address
City

Phone Numbers: Hom

Company
Street Address
City

. J
Furthermore, remember that the information on the tab
refers to the primary key field. When you add cards to a
cardfile, ECM displays the entry (up to eight characters)
from the primary key field on the tab. Carefully choosing
this field increases the usefulness of the cardfile. For
example, Last Name would be a logical choice for an
Address Book or Telephone Directory. If you had a listing
of restaurants, however, you might choose the primary key
field from a list that included the restaurant’s name, its
cuisine, or the town where it is located. A traveling
executive might choose a different key field than a person
who was listing the restaurants in his neighborhood.




Planning To Sort
by Name

ECM considers all the characters in a key field when it files
your cards in alphabetical order. Remember these points if
you plan to alphabetize by name:

® You may define a maximum of three key fields for each
card form. With multiple key fields, ECM first orders
cards by the information in the primary key field. Then,
when several cards have identical information in their
primary key field, ECM orders the cards by the
information in their second key field. When cards have
identical information in their primary and secondary key
fields, ECM orders the cards by the information in the
third key field. When all key fields match, ECM files the
cards in the order in which they were entered.

# ECM evaluates the characters in each key field in
sequential order. For example, if a key field holds a
person’s full name with the last name first (such as
Jones, Alan), ECM files the cards under the last name.
With this scheme, ECM alphabetizes all the first names
under the same last name. Therefore, if you have cards
for Jones, Stephen, Jones, Barbara, and Jones, Alan,
ECM puts Alan before Barbara and Barbara before
Stephen. When you begin a single name field with the
first name, however, (as in: Alan Jones), ECM files the
cards by first name.
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Planning to Sort
Numbers

8-8 Planning an ECM Cardfile

® If you create two separate fields for last name and first
name, and you only choose one key field, ECM uses
just the name in the key field to alphabetize your cards.
For example, if you choose the Last Name field as the
key field, ECM files each new Jones card before all the
existing Jones cards in the order that you add them
rather than alphabetically within the Jones group.

B If you place last name and first name in two separate
fields and you choose last name as the primary key field
and first name as the secondary key field, ECM files
your cards alphabetically by last name, then
alphabetically by first name within each last-name

grouping.

ECM can also sort fields numerically. Each of the three key
fields can optionally be designated as a numeric field.
Then ECM will treat the information in that field as a
number rather than as an alphabetic string.



Planning To Sort

by Date or Time

Planning To Date
a Card

If you plan to sort or search by a date or a time of day,
you must enter the information consistently so ECM
interprets the numbers correctly.

@ For dates, design your field so you can enter two digits
each for year, month, and day, with a slash between the
three elements (YY/MM/DD). In this case, ECM sorts
your cards by year, then month, then date. For example,
enter 84/03/22 for March 22, 1984. To help you
remember the correct order, you can include the format
as part of the label, as in Birthdate (YY/MM/DD).

& For times, design your field to show times on a 24-hour
clock (for example, 08:30 for 8:30 a.m.; and 20: 30 for
8:30 p.m.).

g 131dey)

If you define an Auto Time or Auto Date field, ECM will
automatically stamp your card with the current time and/or
date when you last changed the information on that card.
With these special fields, ECM interprets the time and date
correctly for sorting. Each card can contain at most one
Auto Time field and one Auto Date field.
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Planning for Once you have given ECM the proper instructions, it can
Automatic Phone automatically dial a telephone number for you. Part of
. as these instructions is defining an autodial field. ECM sends
D|a||ng up to 39 characters to the modem to dial; however, you can
make the phone field longer if you want to include an
extension or a note to yourself.

You should enter telephone numbers in a consistent
format. For example, you may enclose the area code in
parentheses and put a dash between the first three digits
and the last four as in (408) 555-k349; or you may
separate the area code from the phone number with
another dash as in 408-555-k349. Choose any format that
suits your needs, but use it consistently.

Caution Avoid using the slash symbol (/) in a telephone field, since
ECM makes special use of this character.

Remember these additional points when you plan an
autodial field:

B Create a single field for the whole telephone number.
That is, don’t create distinct fields for the area code and
the phone number if you want ECM to dial both.

@ Allow room for area codes, international access codes,
outside-access code numbers, and a plus sign (+) each
time you need a pause to wait for a dial tone.

# Place multiple phone fields in close proximity to the
Autodial field. When you access the Select menu to dial
a number, ECM highlights the Autodial field. By
grouping the other phone fields around this field, you
can easily choose the number you want to call.
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Planning To
Share
Information
between
Programs

Whether you're transferring information from other
application programs into ECM (or vice versa), the
programs expect the field information to be in a specific
order and written in a specific format. Since ECM lets you
specify the transfer order and the required format at the

time you transfer the information, you needn’t build these
considerations into the card form’s design. However, you
should consider some additional guidelines.
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Programs pass information as records, where each record is
a distinct unit that holds the information found on a single
card. For example, suppose that you want to transfer the
information from an address file that contains 7 fields:

a title field of 3 characters

a first name field of 12 characters

a last name field of 20 characters

a street address field of 60 characters

a city field of 20 characters

a state abbreviation field of 2 characters

a zip code field of 5 characters
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These 7 fields form a record of the information stored in
the address file. The first field contains 3 characters, the
second field 12 characters, the third field 20 characters, and
so on. Therefore, when you are designing your card form
to accept this information, you should keep these points in
mind:

B Fields should be long enough to accept all information
that is transferred from the other program. For example,
since the Last Name field permits up to 20 characters,
the Last Name field of the ECM card form should be at
least 20 characters in length. If your field is shorter than
the corresponding transfer field, any excess characters
are lost. If your field is longer than the corresponding
transfer field, the extra space is padded with blank
characters.

B You should ensure that the information from the other
program is placed into the correct fields on your form.
When the order of the fields don't correspond, you may
reorder the fields when you transfer the information into
your cardfile.

B You should write numbers in the same style that the
sending application program uses. For example, if the
other program uses MM/DD/YY for its date form, you
should set up your ECM card form in the same way.

See Appendix D for more information about using ECM
with other application programs and how you may reorder
fields in the transfer process.



Planning To Spilit
Up a Cardfile

When you design a card form, you might consider splitting
off portions of the cardfile to meet special needs. You
might use this feature to divide a large cardfile into smaller
pieces, or to create subsets of a cardfile that you could
carry with you on a portable computer. You can allow for
this possibility by creating a special break field. For
example, if you're just starting your own business, you
could create a “yes” or “no” Out-of-State break field. Most
of your original customers may be in-state buyers, but as
your business grows, you may eventually have more out-of-
state buyers. You could then use this field to split the
cardfile in two, or to create a subset of the cardfile if you
were going out of state on a business trip.

As another example, when you have a field that contains
numbers, you can do comparative searches (using the
greater than sign (<) and less than (>) sign) to create
worksets (see Chapter 14). Then, you could make a
workset for all the cards with dates before 1981 by using
<81/01/01 (earlier than January 1, 1981). Or, you could
create a workset for cards with dates after 1980 by using
>80/12/31 (later than December 31, 1980).
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Getting to the
Create Menu

Creating a New Card Form

ECM gives you the freedom to create a card form that suits
your particular needs. In the design process, you may
create a new form or adapt an existing form. This chapter
explains both procedures.

If you purchased ECM: Templates, you can modify any of
these templates to suit your needs. You may want to
change the title of a template and add or delete fields. This
can be done quickly and easily by modifying the old form
and creating a new template from this form.

Whether you're designing a new form or adapting an old
form, the basic premise remains the same. You are creating
a new card form. Therefore, your first step is accessing the
Create menu.

To display the Create menu:

1. Start from the Main menu.

2. Choose to display the Cardfile Tasks
labels:
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9-2 Creating a New Card Form

3. Since you want to create a new cardfile, choose
[ (reatoCararile B
ECM displays the Create menu:

¢ anager oo REATE Cardfile: None\
e Toraior Weapt an mld fern then Bress Sdvetardtileli R Bt e

/ \

T8l ECM

. Main

Notice that ECM expects you either to:

Draw a new form or adapt an old form then press
"Save Cardfile”.

When you draw a new form you start with a blank index
card. When you adapt an old form, you modify the card
form of an existing cardfile to produce a new card form.
Either pathway, however, is an interactive procedure where
you can make changes to the design as you go along.

The next section tells how you display an existing card
form on the Create menu. If you want to begin with the
blank card form, you may skip this section.



To modify an old form:

1. Choose EENTEICETIEN.
ECM asks you to:

Type a cardfile name and press ENTER.

ECM also updates the function labels to assist you in
entering the correct cardfile name.

2. Type the name of the cardfile whose form you want
to adapt.

If this cardfile is in a different directory, remember to
provide the proper pathname.

3. When you finish typing the name, press [Enter].
ECM tells you that it is:
Getting old form.

After a few seconds, ECM displays a copy of the
requested form.
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Placing Text on A card form consists of fields and text. ECM concerns itself

Your Card Form with the fields and the information these fields contains.
Other parts of the card form, including the card’s border,
are text. ECM stores this information but makes no other
use of it, so you can do with it as you wish.

-

Executive Card Manager CREATE Cardfile: None

Title we# IMPORTS CARDFILE ww#

J—_ Company
Labels Agent’s Name
Telephone

Format
Instructions

Next Contact YY/MM/DD)

Street Address
City
Country

Fields /

- _J

You can place text anywhere on a card form. The only
restriction is that you can’t place text over a field. If you
want to make room for text, you can:

® Use + [1]to push a field (and the rest of the print
format) down one line.

# Use [ns] to push a field (and the rest of the line) to the
right as you type characters.
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Widening the
Card Form

When Drawing a New
Card

When Adapting an
Oid Form

Before you begin adding fields and text to your card form,
you should decide whether you want to include the card’s
border as part of your design. By removing the borders,
you can increase the card’s width from 78 to 80 columns.
Since fields must fit on a single line, you might consider
this option, if you have a field that requires 80 characters.

If you decide to keep the card’s border, proceed to the
section, Giving Your Form a Title.

When you are starting from scratch, it is a simple
procedure to remove the card border:

1. Move the cursor to row 2, column 1.

2. Press the + [5] keys.
ECM erases the card’s border.

6 sa1deyd

When you are modifying an old form that contains the
card border, you can still remove the border, but since
other text probably appears on the form, you must take
some additional steps so you don't erase the text that you
want to keep.
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9-6 Creating a New Card Form

To remove the side borders:
1. Use the space bar to erase the side borders from all
the lines that you want to leave in your new form.
2. Move the cursor BELOW the last line you want to
leave in the new design.

3. Press the + keys. to erase all the text from that
line through the end of the form.

Pressing the + keys only erases text. If the old form
has fields below the last line you want to retain, you must

use from the Make/Adjust menu to delete
each field individually.

To remove the bottom border:

If you followed the above procedure to erase the side
borders, choosing the + [s]keys also removes the
bottom border. However, it is conceivable that the old form
had fields on the same line as the card form’s “notches”.
When you want to remove the notches but retain the fields
and their labels, follow this procedure:

1. Move the cursor to one of the “notches”.

2. Use the space bar to erase each outline by overwriting
the “notches” with spaces.



Giving Your Form
a Title

A title (such as Prospective Clients or Restaurants in New
York City) describes a card’s contents. You may make the
title as long as you want. For instance, it can run across
several lines of the card form.

The title serves as a memory aid; ECM makes no use of it.
That is, ECM refers to the cardfile by its cardfile name and
not by the card form’s title. Of course, you can use the
same name (for example, Clients) as both the title of the
card form and also the name of the cardfile.

To give your form a title:
1. Position the cursor where you want the title to begin.
2. Type the title.

If you make a mistake while typing, simply backspace
over the erroneous characters, then type the title
correctly.

You may also change the title by using your computer’s
text-editing keys.

Creating a New Card Form 9-7
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Using Descriptive
Labels with
Fields

9-8 Creating a New Card Form

You may supply labels to describe the different fields on a
card form. Using a descriptive name for each label aids
you in filling in cards, reading them, or searching for
information.

A label can consist of several words and be as long as you
want. (Some examples of labels are Name, Shoe Size,
Home Phone, and Amount Usually Buys.)

You may also arrange a label and its field as you wish. For
example, you can have the field label on the line above the
field or put both the label and the field on the same line.
Furthermore, when you create the card form, you can type
all the labels and then create the corresponding fields.

To give a field a label:

1. Position the cursor where you want the label to begin.

2. DPress the + [ keys or the key, if necessary, to
create room for the text.

3. Type the text for the label.

While typing text, you may use your computer’s other

text-editing keys, such as [DEL], + [t], and +[o].



the Card Form

Fields are the blanks you fill in. You need a field for each
item of information you are going to have on the card. For
example, you can have a single Name field or you could
create separate fields for First Name and Last Name.

Remember these points when you are deciding upon
fields:

@ Every form must have at least one field.

E You create each field as a separate task. That is, you
create a field, establish its length, and end that field
before you repeat this procedure for the next field.

B You should tailor the size of a field to fit the information
that it holds. Remember, however, that a field must be
from 1 to 80 columns wide.

#@ You can design a block of several lines under a single
label. For example, you might set aside four lines for
Miscellaneous Comments. ECM considers each of these
lines to be a separate field. When you print information
from your cardfile, you can decide to print only some of
these lines. In searching, ECM searches each line as a
separate field, unless you instruct ECM to group the
fields together. (See the discussion on Grouping Fields
Together, later in this chapter.)
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To add a field:

1. Position the cursor where you want the field to begin.

2. If necessary, press the + [1]keys to create a blank
line between existing lines, or press the key to
open up space between fields on the same line.

3. Choose to display the Make/Adjust
Field menu:

Executive Card Manager

"5 start Col 22 End C

CREATE: MAKE/ADJUST Cardfile: None
curser keys then press 'Create Menu".

68

/ \

wu% IMPORTS CARDFILE #ww

Company
Agent’s Name
Telephone

(SIREINRNARR

Next Contact

Street Address
City
Country

Zi§ s

Card Last Updated

Time T

Specialties
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When you are creating a new field, ECM reserves space for
the first character in that field and shows the field’s
position by listing both its Row number and also its first
and last column. Initially, when the field is one-character
wide, Start Col and End Col have the same value.

4. Choose once for each additional space
you want ECM to reserve for this field.

For example, if the longest last name in your Address
Book cardfile might contain 20 characters, you should
choose 19 times to create a field 20
characters long.

When you adjust a field, ECM marks each position in the
field with a backslash (\) so you can easily count the
number of spaces in the field. (You may also determine the
field’s length by subtracting the Start Col from the End
Col and adding back 1.)

5. After you have set aside the appropriate space,
choose XTI

ECM creates that field and returns to the Create
menu.

If you change your mind:

If you decide that you don't want a field after you have

started it, choose [ TECE
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Changing the Length  If you decide that a field is too long or too short for the
of a Field information that you will normally put in that field, you
can go back to that field and change its length.

To shorten a field:

1. Start from the Create menu.
Move the cursor to the field you want to shorten.

2.
3. Choose [SVIYHIZTIY].
4,

Now take one of the following actions:

B8 To shorten the field without affecting the rest of
the line, choose [HNITIETITE.

B To shorten the field and move the rest of the line
to the left, choose the key.

In either case, each time you choose this key, ECM
deletes the last character position in that field.

5. After you set the proper length, choose [N ITRITN.

ECM saves the changes and displays the Create
menu.
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To widen a field:

1. Move the cursor to the field that you want to widen.

2. Choose YIS

3. Now take one of the following actions:

@ To widen the field without affecting the rest of the
line, choose FEETE

@ To widen the field and move the rest of the line to
the right, press the [ins] key and then choose
IERXESTE. (After you set aside the necessary
space, press the [ins] key to take your computer out
of Insert Character mode.)

In either case, each time you choose
ECM adds another space to the end of the field.
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Pressing the [ins] key shifts the other fields on that
line to the right and breaks the card border. Choosing

ATIEVELIT T repairs these breaks.
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Changing a Field’s
Location
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When the Make/Adjust menu appears on your display, you
may use the cursor-control (arrow) keys to move a field to
a new location:

Pressing the [a] key moves the field up one line.
Pressing the [¥] key moves the field down one line.

Pressing the [>] key moves the field one column to the
right.

Pressing the [<] key moves the field one column to the
left.

Pressing the key moves the field to the left corner
of the first line that currently appears on your display. If
the field is already in this position but other lines exist
above that line, pressing the key moves the field to
the form'’s first line.

Pressing the key moves the field to the left corner
of the last line that currently appears on your display. If
the field is already in this position but other lines exist
below that line, pressing the key moves the field
below the form's last line.

If your personal computer supports a mouse, you may
move a field to a new location by placing the pointer in
that field, holding down the left button and moving the
field to its new location, and then releasing the left button.




You should remember these facts when moving fields:

# You cannot place a field above the card’s top border.

B You cannot place one field over another field.

To move a field:

1. Start from the Create menu.
. Move the cursor to the field you want to adjust.

2
3. Choose EETIFTEETSER
4

. Use the cursor-control (arrow) keys to move the field
to its new location.

5. Choose to save your changes and return
control to the Create menu.

If the field’s new position overlaps another field, ECM
informs you that:

The field is improperly positioned. Place field
in a clear part of the form-.

After you move the field to a satisfactory location, choosing

saves your changes and displays the Create
menu.
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Removing Fields In the interactive process of designing a card form, you
may decide that you don't need a field that you created.
Removing a field is a simple task.

To remove a field:

1. Start from the Create menu.

2. Move the cursor to the field you want to remove.

3. Choose to display the Make/Adjust
Field function labels:

4. Choose to delete that field.
ECM deletes the field and displays the Create menu.
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To remove a field’s label:
If the field also contains a label that you want to remove,
take these additional steps:

1. Move the cursor to the field label.
2. Use the space bar to erase the label.

You may also erase the label by using your computer’s text-
editing keys.
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Setting Special
Fields

B8 o

W
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T
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You can assign special attributes to the fields on a card
form. For example:

# Which fields should ECM use to file the cards in some
sort of alphabetic order?

® Which phone field should ECM automatically choose if
you instruct it to dial a number for you?

@ Should ECM stamp each card with the time or date
when you last modified the card?

#® Should ECM treat each field separately, or is it more
logical to treat certain fields as a group?

You can specify any of these attributes, or permissible
combinations of them, by giving each field a type. This
requires your accessing the Field Types menu.

You may assign field types individually to each field after
you create that field, or you may create all the fields then
assign attributes to each field in one call to the Field Types
menu. In either case, choosing tells ECM you
have finished setting attributes and returns control to the
Create Menu.




To display the Field Type menu:

1. Start from the Create menu.
2. Choose to display the Field Types

menu:

None \

Executive Card Manager CREATE: FIELD TYPES Cardfile:

/ \

### TMPORTS CARDFILE ###

Company

Agent’s Name
Telephone

Next Contact © (YY/MM/DD)
Street Address
City

Country

Card Last Updated

Specialties
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The following sections describe how you use the function
labels to set specific attributes.
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Setting the Fields
That File Your Cards
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When you are designing your card’s layout, you can tell
ECM how to arrange the cards in your cardfile. For
example, if you want to file your cards alphabetically by
city, you must tell ECM to sort by city.

The fields that ECM uses for arranging the cards are called
key fields.

You can set a maximum of three key fields for each card
form.

Each key field may be sorted in ascending or descending
order.

The information from the primary key field is shown on
the index tab of each card in the cardfile. ECM files your
cards in order, according to this field.

When you assign a second key field, if multiple cards
have identical information in their primary field, ECM
further orders the cards by the information in their
secondary key field.

When you assign a third key field and several cards
have identical information in both the primary and
secondary key fields, ECM further orders the cards by
the information in their tertiary key field.

When all the key fields have identical values, ECM files
the cards in the order that you entered them.

While you may assign key fields in any order, ECM
gives a sequential ordering of key fields to the final
design. For example, you may designate a First Name
field as a secondary key field then designate a Last
Name field as the primary key field and save the form
with these two key fields. However, if you assign a
primary key field and a tertiary key field and save the
design in this state, ECM makes the tertiary field the
secondary field.



® When you omit choosing a key field, ECM uses the first
field of the form as the primary key field.

B A key field may be designated as a numeric sort field.

To set the primary key field:

1. Move the cursor to the field that you want to set as
the primary key field.

2. Choose |IET St

When you choose this key, the field the cursor is in
becomes the primary key field. (The symbols K1
appear within the field to show that this field is the
primary key field and an up-arrow indicates that the
items in this field are sorted in ascending order.)
When a field is too small to display all the field type
characters, ECM shows what it can within the field,
but displays all the field type characters on the field
expansion line.

If you have chosen a primary key field, then move the
cursor to another field and attempt to make that field the
primary key field, ECM assumes you have changed your
mind. Thus, it makes the current field the primary field
and removes this designation from the former field.

~Computer

~Museum
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To set additional key fields:

1. To set a secondary key field, move the cursor to the
appropriate field and choose |NYSTRTIEN.

The letters K2 appear within the field, and an up-
arrow indicates an ascending sort.

2, To set a tertiary key field, move the cursor to the
appropriate field and choose |NSYSIETIEN-

The letters K3 appear within the field, and an up-
arrow indicates an ascending sort.

To reverse the filing order:

ECM automatically files cards in ascending order (that is,
“1” before “2” and “A’ before “B”). However, if you want
ECM to use a descending order, you must choose

while the cursor is within the appropriate
field. If room exists, a down-arrow appears within the field
to show that this field uses a descending sort. When the
field is too small to hold all the field type characters, you
can see the symbols that apply to that field by inspecting
the field expansion line.

If you decide to change this field back to an ascending sort
field, move the cursor to that field and choose
SR . This returns the field to its ascending

sort order.



To set a numeric key field:

1. Move the cursor to the key field you want to change
(this field contains the appropriate K number).

2. Choose to change K1 to K#1 (primary
key field, numeric), to change K2 to

K#2 (secondary key field, numeric), to
change K3 to K#3 (tertiary key field, numeric).

To clear a key field:

The function labels that you used to set a key field are the
same labels that remove a key field's setting.
1. Move the cursor to the field you want to change.
(This field contains the appropriate K number.)

2. Choose until the primary key field is
cleared, |NTHIEEETYEN to clear a secondary key field,

or to clear a tertiary key field.
ECM removes the key designator from that field.
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You can also clear one field by choosing the same attribute
for another field. For example, if you have chosen a
secondary key field then attempt to set another secondary
key field, ECM automatically makes the current field the
new secondary key field.
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Setting the
Autodial Field
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When you give it the proper instructions, ECM can dial a
telephone number for you. This feature is called autodialing.
(See Chapter 16 for information on using autodial.)

When setting an Autodial field, remember:

8 You can set only one field for autodialing. (ECM dials

the number in this field when you choose
from the Main menu.)

B If your card form has multiple phone fields, you can use
the Select menu to choose another phone field, and
then have ECM dial that number.

To set the Autodial field:

1. Move the cursor to the phone field that you normally
want ECM to use for autodialing.

2. Choose INTIISTNTITEIENN.
The letter A appears within that field.



If you change your mind:

1. Move the cursor to the current Autodial field.

2. Choose to clear the field.

Since a card form can have only one autodial field, you
can also change the field by moving the cursor to a new
field, and choosing INSYSEEYITEIBIN. In this case, ECM
automatically removes the A designation from the original
tield and assigns it to the current field.

6 121dey)n

Creating a New Card Form 9-25



Setting Date and
Time Fields

9-26 Creating a New Card Form

You can also create Auto Date and Auto Time fields to
show when the information on a particular card was last
changed.

The Auto Date and Auto Time fields show when you
update the information on a card; they do not show when
you created the card form.

ECM automatically maintains these fields for you and
formats them in a style that is appropriate for each
country.

For the United States, ECM displays dates in a MM/DD/YY
format, where MM is the month number, DD is the day of
the month, and vv is the last two-digits for the year.

For the United States, ECM displays times in a HH: MM AP
format, where HH is the hour, MM is the minutes after the
hour, and AP is either “am” or “pm”.

You can't assign a single field the attributes for both Auto
Date and Auto Time. For example, if you have a cardfile for
phone messages, and you want ECM to stamp the date
and time on each message, you must create two fields: one
for the date, the other for the time.



To set the date:

1. Move the cursor to the field that you want to set as
an Auto Date field.

2. Choose [ESUSTETITN.

The letter D appears in that field.

To set the time:

1. Move the cursor to the field that you want to set as
an Auto Time field.

2. Choose [EINITERN.

The letter T appears in that field.

If you change your mind:
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After setting an Auto Date or Auto Time field, if you
decide you don’t need this feature, you can remove those
attributes:

1. Move the cursor to the field that you want to change.

This field contains the letter D if it is an Auto Date
field or the letter T if it is an Auto Time field.

2. Choose to cancel an Auto Date field.
3. Choose to cancel an Auto Time field.
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Grouping Fields
Together
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When designing a form, you might envision that certain
information won't fit into neat pigeonholes. For example,
suppose you are a field biologist using ECM to record the
results of a day-long shorebird census. Your form probably
contains fields for the starting time and ending time, and
fields for different aspects of the weather (such as
temperature, cloud cover, wind direction, and so on). You
might also have a series of five Comment lines; and, as the
weather may change during the day, these lines may
contain information such as:

09:00 Fog lifts (WEATHER)

10:30 Storm brewing: wind 15 knots, SW (WEATHER)
11:55 Peregrine Falcon takes Dunlin (PREDATION)
13:10 Starting to rain (WEATHER)

Later, when analyzing your results, if you want to search
for all weather-related information, you would search the
specific fields pertaining to weather plus any miscellaneous
remarks in the Comment lines. The easiest way to find this
information is to treat the separate comment lines (each of
which constitutes one field) as a group.

To group fields together requires your accessing the Group
Fields menu,

You may not group an Auto Date and an Auto Time field
together.




To display the Group Fields menu:

1. Start from the Create menu.

2. Choose to display the Group Fields
menu:

GROUPS

Executive Card Manage

#nu JMPORTS CARDFILE #es

Company
Agent’s Name
Telephone

Y (YY/MM/DD)

Next Contact i
Street Address
City

Country

Card Last Updated

Specialties

.

Since you may want ECM to treat certain fields as part of
one group and other fields as part of another group, you
must give ECM all the information it needs to form each
group. ECM assists you in this task by displaying the
number for the currently Active group on the message
line.

J

Creating a New Card Form 9-29

6 491deyd



To define a group field:

1.

Display the group number that you want for the
Active group.

For the first group, ECM automatically displays the
number 1. If you want another group number, you

may choose or to cycle

through the permissible values of 1 through 10.
Move the cursor to a field that you want to include
within this group.

Choosing assigns the current Active
group number to that field.

Now repeat steps 2 and 3 for the remaining fields that
you want within this group.

ECM will group fields together, regardless of their position

. -on the form. For example, you can group the field on the
< .last line of the form with a field on the first line of the

- form.
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To define another group field:

1.

Choose ITTEIEITY.

ECM displays the next available group number as the
Active group.

If you want a different group number, you may

choose or to cycle

through the permissible values of 1 through 10.
Move the cursor to a field that you want to include
within this group.

Choosing assigns the current Active
group number to that field.

Now repeat steps 3 and 4 for the remaining fields that
you want within this group.
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To remove a field from its group:
You may remove one or more fields from a group by
following this procedure:

1. Move the cursor to the appropriate field.
2. Choose to remove that field from its
group.

When you finish setting group fields:

1. Choose JEFTENNE

ECM sets the groups that you have specified and
displays the Create menu.



Changing the
Length of Your
Card Form

Since a card form may have from 1 to 255 lines, after you
finish designing the card form, ECM allows you to redraw
the bottom card border at the end of the form.

To shorten your card form:

1. If you want to create a card form with less than 19
lines, move the cursor to the last line that you want
to include.

2. Press the + keys.

ECM erases all the textual information from this
point.

The + keys will not remove fields from a card form.
If you have created fields that you later decide not to
include in the card form, you may press the + keys
to erase labels and the card border, but you must use

to delete the unwanted fields.

Creating a New Card Form 9-33

6 191deyd



9-34 Creating a New Card Form

(@LLELY Redraw Border |
ECM asks you to:

Move cursor to where you want the card
to end.

If you change your mind, you may choose to
end this procedure and return the function labels to
their previous values.

Move the cursor to the line where you want the card’s
bottom border. (Be sure to allow enough room for the
notches.)

Choose to replace the bottom border.



Lengthening a
Card Form

Putting the bottom border on a card that exceeds 19 lines
requires a few more steps to remove the old bottom border.

To remove the old border:

1.
2.

Move the cursor to the old border.

Remove the border by using the space bar to
overwrite the notches and the bottom line with spaces
or use the + [o] keys to remove these lines from
the form.

To replace the bottom border:

1.

Choose ETTIFMEISTE.
ECM asks you to:

Move cursor torow for bottom border. Press
''Redraw Border''.

If you change your mind, you may choose to
end this procedure and return the function labels to
their previous values.

Put the cursor on the line where you want the card’s
bottom border.

Choose to replace the bottom border.
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Cleaning Up Stray  If you have used your computer’s text-editing keys to
Marks  modify your form, pieces of the right side border may have
been pulled inside.

To remove these marks:

1. Move the cursor under the mark you want to remove.

2. Press the space bar to erase the mark.

Finishing Up Your At this point, you should check your card form to make
Design sure it is correct and complete. For example, a final review

can show where you might want to make further changes:
B Are there any spelling errors?

B Are the fields long enough?

B Have you included all the fields you need?

W Is the card the size you want it to be?

m Have you set the appropriate key fields?

B Do you want to set an autodial field?

m Do you want to set an Auto Date or Auto Time field?
|

Do you want to group certain fields together?

While you are designing the card form, you can make any
necessary changes.
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Naming and
Saving the Card
Form

After you have completed the design process, you may
choose between two function labels to leave the Create
menu.

If unforeseen circumstances prevent you from finishing the
card’s design in one sitting, the work you have done isn't
lost. Simply save your work (using [ EIRIISEE); then
when you are ready to continue, access the Create menu
and use FFITEICETIRA o finish the design. After you
save the complete version, you may delete the cardfile with
the incomplete design.
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To save your card form:
1. Choose | HNIETTHT.
ECM asks you to:
Type a cardfile name and press ENTER.
2. Enter a name for the cardfile.

(See Chapter 7 for the necessary guidelines.)
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3. Pressing ends the name and directs ECM to
continue.

ECM tells you it is:
Creating the cardfile.

Then, ECM opens that cardfile. While it is doing this
task, ECM displays the message:

Opening the cardfile.

Eventually, ECM displays an empty cardfile on the Main
menu for the cardfile you just created.

If a cardfile with that name already exists, ECM protects
you from overwriting that file by informing you that:
Cardfile already exists. If this happens to you, press
to clear the message, then type another name for the
cardfile and press to continue.

Now you are ready to put cards in the cardfile. Chapter 11
tells you how to add cards.



To leave the Create menu without saving the form:

ECM also lets you discard an incomplete form that you
don’t want to keep.

1. Choose |H&EEE.

ECM asks for confirmation that you don't want to
save the card form:

Cardfile will not be created. Choose
"Yes"™ to confirm.

2. If you want to discard the form, choose K

ECM discards the card form. ECM then displays the
Main menu with the cardfile you were using last.

3. If you decide against discarding the form, choose
m

ECM cancels the current operation and returns to the
Create menu.
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Deleting a‘CardfiIe |

You can rid a disc of any obsolete cardfiles to make room
for other information. You do this by deleting the cardfile
from its disc. (If you are unsure whether you might use
the cardfile again, make a backup copy to another disc
before deleting the cardfile from your work disc.)

You may delete any cardfile. That is, you may delete the
current cardfile or another cardfile.

Deleting the
Current Cardfile

When you delete a cardfile, you lose that particular cardfile
forever. Therefore, you may want to display the cardfile
and scroll through its cards before you delete it. Once you
verify that you have no need for this information, ECM
allows you to delete the cardfile even though you are
currently working with it.
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To delete the current cardfile:

1. Start from the Main screen.

2. Choose
labels:

Cardfile Tasks

to display the Cardfile Tasks

3. Choose
ECM asks you to:
Type a cardfile name and press ENTER.

Delete Cardfile R

To aid you in entering the correct cardfile name, ECM
displays the default pathname and updates the
function labels to the following values:

4. Type the name of the current cardfile.
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5. Verify that the name is correct.
(If you made a mistake, backspace over the name and
correct it.)

6. Pressing ends the cardfile’s name and directs
ECM to continue.
ECM requests confirmation:

THE CURRENT CARDFILE WILL BE DELETED,
Choose "Yes™ to delete-

Caution w Once you delete a cardfile, you cannot retrieve it.

7. If you change your mind, choose |-
ECM doesn’t delete that cardfile but waits for you to
give it the name of the cardfile that it should delete.
When you want to retain the cardfile and continue
with another task, choose to return the
function labels to the Cardfile Tasks values.

8. Choosing deletes the cardfile.

When you are deleting the current cardfile, ECM informs
you that it is:
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Closing current cardfile.

Next, ECM tells you it is:
Deleting cardfile.

As the cardfile is now empty, the index tabs go blank.
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Deleting Another

Cardfile If you have just copied a cardfile, you may decide to delete
the old cardfile. Since you are probably certain of the
cardfile’s contents, you may delete this cardfile directly,
without first making it the current cardfile.

To delete a cardfile other than the current cardfile:

1. Start from the Main screen.
2. Choose to display the Cardfile Tasks
labels.
3. Choose IS
ECM asks you to:
Type a cardfile name and press ENTER.

4. You can switch work discs when the cardfile you
want to delete is not on a disc in your computer.

Caution Do not remove the ECM Application work disc. This is usually
w the disc in your primary drive.
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5. Type the name of the cardfile you want to delete.
Because the same cardfile name may appear in several
directories, you should give the full cardfile name (for
example, B:\JIM\MOTELS). This prevents you from
deleting the wrong cardfile.

6. Verify that the full cardfile name is correct. If you find
an error, backspace over the name and change it.

7. Pressing ends the cardfile’s name and directs
ECM to continue.

ECM displays the full cardfile name on the input line
and requests confirmation:

The following cardfile will be deleted-
Choose "Yes"™ to confirm.

Caution w Once you delete a cardfile, you cannot retrieve it.

8. If you change your mind, choose [FER.

ECM returns to its previous state and waits for you to
give it the name of the cardfile that it should delete.
When you want to retain the cardfile and continue
with another task, choose to return the
function labels to the Cardfile Tasks values.
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9. Choosing deletes the cardfile.

When you are deleting a cardfile other than the
current cardfile, ECM informs you it is:

Deleting cardfile.

The current cardfile remains in view. Its status stays
the same when you delete another cardfile.

If problems arise:

If ECM fails to find the cardfile that you named, it informs
you that it:

Can't find cardfile.

This may indicate one of two problems:

B You have inserted the wrong disc into the drive.

B You have entered the wrong name for the cardfile.

Use to find out which files a disc contains
and to verify the spelling for the cardfile names.

If the problem persists and you must back out of the
procedure because you can't find the right disc or cardfile
name, choose if the Cardfile Tasks labels appear
or when ECM is asking for confirmation.



ECM expects procedures to follow a predictable path.
However, you may alter a procedure to the point where
ECM becomes confused and can't continue. Since we have
stressed the importance of making back up copies of your
discs, let’s consider the following scenario:

® You make an exact copy of one of your ECM cardfile
discs as a back up.

® You place the original cardfile disc into drive B and
make one of the cardfiles (for example B: \ADDRESS) the
current cardfile.

B You remove the original disc and insert the back up
disc.

@ You attempt to remove \ADDRESS from this disc.

ECM wants to close the current cardfile before deleting it,
but it is already closed. That is, ECM can't close \ADDRESS
because the open version (on the original disc) is no longer
in drive B. ECM attempts to close \ADDRESS on the back
up disc, but it is already closed. Being hopelessly
confused, ECM simply hangs within this loop.

To delete the back up copy of a cardfile with the same path
name as the current cardfile, simply use to
make the back up copy the current cardfile before you
attempt to delete it.
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Deleting a Large

Workset

10-8 Deleting a Cardfile

When you are doing certain tasks, ECM creates a
temporary workset to hold cards for you to view. While
worksets resemble cardfiles, ECM prevents you from doing
certain cardfile tasks with worksets. In particular, if you
created a workset of inactive members from your club's
roster, you can't use to remove the cards
in this workset. Rather, you should follow a procedure
similar to this one:

Mark all the cards in the cardfile.

Use the Find menu to isolate all the inactive members.
Unmark the cards in this workset.

Exit the workset.

View all the marked cards. (This workset contains all the
active members.)

Use the Copy menu to replace the current cardfile with
this workset.
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 Adding Cards to a Cardfile

Adding a card means filling in the fields of a blank card
form then filing the completed card in its cardfile.

You may add cards:

E to a new cardfile
B to a cardfile that already contains cards

B to a workset of a cardfile

This chapter gives the simple steps involved in adding
cards to the current cardfile. When you start a session with
ECM, ECM displays the last cardfile with which you were
working if it can locate that cardfile on the disc(s) you are
using. Oz, after you create a new cardfile, the Main menu
reappears with that cardfile as the current cardfile.

If you want to get another cardfile, refer to Chapter 12 for
these details, then follow the instructions in this chapter to
add cards to that cardfile. Similarly, Chapter 14 and 15
explain worksets. After you create a workset, you may use
the techniques in this chapter to add cards to that workset.
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Displaying the
Add Menu

Caution w

11-2 Adding Cards to a Cardfile

You place information in a cardfile by adding cards to that
cardfile. This requires your filling in the appropriate
information in the Add menu.

1.

Start from the Main menu where the function labels
have the following values:

Choose to display the Add menu.

A: \IMPORTS
RisE e

##» TMPORTS CARDFILE w»»»

Company
Agent’s Nami
Telephone

Next Contact ~ (YY/MM/DD)

Street Addres
Cit

Card Last Updated

Specialtie

Do NOT remove the disc containing your cardfile while you are
displaying the Add menu. Removing it may damage your
cardfile.




Moving the
Cursor Between
Fields

When the Add menu appears, ECM positions the cursor at
the beginning of the first field. Thus, if you want to fill in
the fields in sequential order, you may start typing
immediately. Notice that when you completely fill a field,
ECM automatically advances the cursor to the beginning of
the next field.

Don't use the space bar to advance the cursor. Within a
tield, pressing the space bar prints a blank character at the
cursor’s current position. Beyond the boundaries of a field,
pressing the space bar produces an audible beep because
this is an improper keystroke at that location.

ECM also provides several ways for you to move the cursor
to the beginning of a field without typing any text:

® To move the cursor to the next field, press or [Enter].

& To move the cursor to the previous field, hold down

and press [T ].

& To move the cursor to the first field that appears on your
display, press the key.
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B To move the cursor to the first field on the form, press
the key while the cursor is within the first field
that currently appears on your display.

# To move the cursor to the last field that appears on your
display, press the key.
8 To move the cursor to the last field on the form, press

the key while the cursor is within the last field that
currently appears on your display.

You may also use touch or a mouse to move the cursor
between fields, if your personal computer supports these
pointing devices.
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Filling Out a Card

The following list gives general guidelines for filling a
blank card form:

B You can fill in the fields in any order.
E You may leave fields blank.

@ If you fill in the primary key field, ECM files the card in
its proper place in the cardfile.

B If you omit filling in the primary key field, ECM places
that card at the beginning of the cardfile. This happens
since ECM assumes nothing (that is, an empty field)
comes before anything (that is, a field with information).

B You may not enter information into an Auto Date or
Auto Time field as ECM automatically displays a value
in these fields.

Remember that ECM prevents you from typing beyond the
borders of a field. Furthermore, ECM automatically moves
the cursor to the beginning of the next field once you have
entered enough characters to fill the current field. For
example, if you have a 5-digit ZIP Code field, after you
enter the fifth character, ECM automatically advances the
cursor to the next field.
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Filling in Text
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Entering text is as simple as writing your name. These
hints may make it easier, however, to find information
later:

B Remember that the first eight characters of the card’s
primary key field appear on the index tab of the card.
Decide what information you'd like to see on the tab as
a quick reference and place it first in the primary key
field. (If the primary field contains more than eight
characters, ECM displays the first eight characters in the
tab and places a hyphen (-) after the tab to show that
more information follows.)

B ECM sorts key fields according to the way the letters
appear in that field. For example, if your form has a
single Name field, ECM files Dave Jones under the letter
D; but it files Jones, Dave under the letter J.

® If a card form has a single Name field, you can obtain a
correct sort by filling in the last name, followed by a
comma, then the first name. In this case, ECM
alphabetizes the first names within the last name group.
(For example, Jones, Dave comes before Jones, Donna).



Filling in
Numbers

Filling in Dates

ECM sorts numbers in the same way that it sorts letters.
For example, with text, ECM assumes that A comes before
ABC and ABC comes before D. Similarly, ECM assumes 1
comes before 123 and 123 comes before 4. (In other words,
ECM treats 123 as a word beginning with the “letter” 1 and
4 as a word beginning with the “letter” 4.) If you want
ECM to sort your cards by value so 4 comes before 123,
you must determine how many numbers a field might
contain, then account for all the digits by using zero as a
place holder. For example, 004 comes before 123.

However, if a field has been designated as a numeric key
field, ECM will sort numbers by their value. That is, 4
comes before 123.

The following sections tell you how to fill in numbers
where this treatment affects sorting your cards.

You may use ECM’s automatic date stamping facility to
mark your cards with the date when the information on
the card was last changed. ECM automatically converts this
date to a form that yields a proper sort. However, if you
plan to use another field with dates as a key field for filing
your cards, these pointers give the most useful way for
entering dates:

8 Give each element of the date a two-digit number. For
example, enter 84 for the year 1984; 0Ok for the month of
June; and 01 for the first day of the month. (You can, of
course, enter a four-digit number for the year if your
cardfile covers more than one century.)
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Filling in Times

Filling in Telephone
Numbers

11-8 Adding Cards to a Cardfile

B Enter year, month, and day in that order and separate
them by slashes. This way, ECM first sorts by year, then
month, then date. For example, enter 84/0b/01 for June
1, 1984. (If you enter the date as DD/MM/YY, ECM sorts
first by date, then month, then year.)

You may use ECM’s automatic time stamping facility to
mark your cards with the time when that card was last
changed. ECM manages the information in this field and
places the cards in correct numerical order when you use
this field as a key field. However, if you plan to use a time
field that you created as a key field for filing your cards,
these pointers give the most useful way for entering times:

B Convert the time to a 24-hour clock, in which noon is
12:00 and midnight is 24:00.

@ Remember to add a zero to any single-digit hour. For
example, enter 08:30 for 8:30 a.m.

B Be consistent in your form. This manual shows time in
an HH:MM format (where we include a colon for clarity).
However, the colon serves no magical purposes, so you
could just as easily write all times as HHMM.

The following pointers will help you enter telephone
numbers in the most useful way for automatic dialing:

B Be sure to include all parts of the number that ECM
needs to place your call. For example, if you use an
access number (such as a 9 to get a dial tone), include
this number in the autodial field. A telephone number
may also include the # and x symbols.

@ A plus sign (+) or comma (+) produces a two-second



pause to wait for a dial tone. For example, if you enter
9.202-555-2929, the modem pauses for two seconds
after it dials the 9.

ECM stops dialing when it reads an X (or x) in the
autodial field. If your autodial field includes an X before
an extension, ECM dials the number up to that point,
then lets you ask for the extension.

ECM recognizes the slash (/) character as a special
symbol. (See Chapter 16 for details on using the slash
symbol to pass information to a modem.)

ECM ignores everything in the autodial field except
numbers and the characters that were mentioned above.
For example, if you enter a phone number as
(202)555-2929, ECM interprets the number as
2025552929. Therefore, you can include such symbols,
if you wish, to ease the entering and reading of
telephone numbers.

ECM reads as many as 39 characters in the autodial field
(not including characters it ignores, such as
parentheses).
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Editing Fields
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Once you finish filling in your form, check it for accuracy.
If you find any mistakes, make the necessary corrections.

To redo an erroneous entry:

1. Move the cursor to the field you wish to change.

2. Type over the erroneous text with the correct
information.

3. If the correction occupies less space than the original
text, press the space bar until you have erased the
remaining characters in that field.

To make minor corrections:

When you only want to change a few characters in an
entry, you may use the computer’s edit keys (such as the
[ins ] key and the key) to simplify your work. Notice
that when you modify the text in a field, these keys behave
as if each field were a separate entity.

1. To erase a single character, move the cursor to that
position.

2. Press the [peL]key.

ECM deletes the character at the cursor’s position and
shifts the rest of the text in that field one space to the
left.



Caution W

3. To add a character (or characters) between existing
text, move the cursor so it appears under the
character before which you want to put the additional
character(s).

4. Press the [ins] key to put your computer in Insert
Character mode.

5. Type the necessary correction.

ECM inserts the text before the cursor and shifts the
remaining characters to the right.

6. Press the[in] key a second time to return your
computer to its regular mode of operation.

While your computer is in Insert Character mode, if you insert
enough characters so the field becomes full, any subsequent
characters forced to the right of the field boundary are lost.
Also, if you place the cursor at the last position in a field and
try to insert a character, the cursor advances to the next field
(if a next field exits).
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Filing aCardin After you have finished working with a card, you must
the Cardfile take one more step to place that card in your cardfile.

1. Choose IFTRISCRSIEN .

ECM adds the card to your cardfile and displays
another blank card form.

2. If you want to add another card, fill in the form and
repeat step 1.

Remember, you can add cards in any order. ECM
automatically files each card in its proper place
according to the key fields you have chosen.

To discard a card:
If you are filling out a card and decide that you don’t want

to save it, you can discard the card by leaving the Add
menu.

Caution Choosing returns you to the Main menu without
saving the current card.

1. Choose |IRTEENE .
ECM warns you that:

This card will not be added-. Press
"Yes"™ to confirm.
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2.

If you change your mind, choose [Ifl.

ECM returns you to the Add menu. Now you may
either modify the information on the card or choose
to place the card in your cardfile.

If you want to discard the card, choose KIS

If this is the only card you have worked with, ECM
returns directly to the Main menu. However, if you
have added cards to the cardfile before discarding the
current card, ECM informs you that it is:

Updating cardfile.

Once ECM adds the new cards to the cardfile, it
displays that cardfile as the current cardfile on the
Main menu.

Leaving the Add After you have saved your last card, ECM displays another
Menu blank card for you to complete.

1.

Since you have no more information to enter, choose

[ ccriain B
ECM informs you that it is:

Updating cardfile.

Once ECM adds the new cards to the cardfile, it
displays that cardfile as the current cardfile on the
Main menu. The last card you added is in the open-
card position; and all new cards are filed in their
proper order.

Lt 491deyd
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What to Do When
Your Disc Is Full

All card files have limits on the number of cards they can
hold. As this rule also applies to ECM cardfiles, you may
encounter one of two problems:

® the cardfile becomes full

B the disc becomes full

When you try addding a card to a full cardfile, ECM tells
you:

The cardfile is full-no more cards may be added-

Because a cardfile may hold up to 64,000 cards, you'll
probably never reach this limit. Therefore, the more
common occurrence is reaching the capacity of your disc.

When you try adding cards to a full disc, ECM tells you:
DISC ERROR--unable to save the card data-

You are unlikely to encounter this problem when you are
using a fixed disc. If you are using flexible discs or RAM
storage, you may create additional space by:

# deleting obsolete cards (Chapter 13) and then
condensing the disc space used by that cardfile (Chapter
18); or deleting cardfiles (Chapter 10).

® copying some of your cardfiles onto another disc
(Chapter 18).

B splitting a large cardfile into parts, and copying part(s)
of it onto another disc (Chapter 18).

® Using special procedures to conserve disc space
(Chapter 18).
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Looking at the Cards
in a Cardfile

This chapter explains how you get a cardfile to make it the
current cardfile. (ECM refers to the cardfile that appears on
the Main menu as the current cardfile.) This step is
necessary because you must make a cardfile the current
cardfile before you can work with it.

When you create a new cardfile, ECM automatically makes
it the current cardfile.

Whenever you want to work with another cardfile, you
must inform ECM of your intentions. The following section
tells you how, then subsequent sections explain ways to
locate cards within the current cardfile.

Looking at the Cards in a Cardfile 12-1



Getting a Cardfile  Your home base when working with ECM is the Main
menu, and the name of the current cardfile appears on the
banner line. (If no current cardfile exists, ECM displays
None for the cardfile’s name.)

To get a cardflle:

1. Start from the Main menu where the function labels
have the following values:

2. Choose to display the Cardfile Tasks
labels:

3. Choose [ISETIINN.

If you had been working with a cardfile, ECM
informs you it is:

Closing the cardfile.
Next, ECM asks you to:

Type a cardfile name and press ENTER.

Anticipating that you want another cardfile on the
same disc, ECM supplies the first part of the
pathname for you on the input line.
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The disc that contains your cardfile determines your next
step. If the cardfile occurs on the same disc that you are
now using, your task is straightforward, so go to step 8. If
you want to access a cardfile on another disc, go to step 6.
If you are not presently using the disc which contains that
cardfile, you have probably stored the disc in a safe place,
so continue with step 4.

4. Remove your work disc, the one that does not contain
the ECM application program.

5. Insert the disc which contains the desired cardfile into
the empty disc drive.

6. Hold down and press the + [t]keys.
ECM erases the pathname which it supplied.

7. Type the letter for the drive that contains the cardfile,
followed by a colon (:), a backslash (\) for the main
directory, then a name and backslash for each
subdirectory (if any apply).

8. Type the cardfile’s name.

After you complete this step, you have given ECM the
full cardfile name. For example, the input line might
read: B:\DONNANIMPORTS, In this case, ECM will
search for the IMPORTS cardfile in the subdirectory
called DONNA on the disc in Drive B.

9. Pressing ends the cardfile’s name.

ECM searches for that cardfile in the location you
specified. If it finds the cardfile, ECM informs you
that it is:

Opening the cardfile.
Then ECM displays that cardfile on the Main menu.
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If problems arise:

If ECM fails to find the cardfile, it informs you:

The cardfile could not be found- Press ENTER to
clear the message-

You should therefore take the following steps:

1.
2.

Pressing clears the warning message.

Ensure that you are using the correct name for the
cardfile.

(See Chapter 7 if you are unsure of the cardfile’s
name.)

Verify that the pathname you are using for the
cardfile is correct.

(Appendix E provides information on using File
Manager to determine a cardfile’s full name.)

Consult Appendix F if you see any other message
that you don’t understand.

Type the cardfile’s name again.

If the cardfile is in a different directory, give the
proper pathname.

Pressing completes the name.
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Obtaining
Information on
Your Cardfile

At times, ECM asks you to supply a cardfile’s full name;
that is, you must supply not only the name for the cardfile
but also its pathname. Also, you may wonder how many
cards a cardfile contains, especially if you are considering
splitting that cardfile into smaller pieces. ECM provides a
convenient way, therefore, for you to obtain this
information.

To ask for more information about your cardfile:

1. Start from the Main menu.

2. Get the cardfile that you want to check.

3. Choose to display the Cardfile Tasks
labels if they don't appear.

4. Choose IHTSINITRNTITS.

ECM displays the full name of the cardfile followed
by the number of cards it contains—for example,
B:\DONNA\NIMPORTS (308 cards).

zi sadeyd
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Scrolling through
the Cardfile

Index ; :
1/ Robinson-

Tabs - / Scientif-\

/ Toys Int-\
/ Wines of-\
/ Wines of-\

RETEER

merican Exports, Inc.

Open Card — hirley Cochrane

Area 18-125-0110

ECM focuses your attention on one card at a time. This
card is in the open-card position, and ECM displays the
information from that card’s first three field lines. For the
remaining cards in the file, ECM displays only their index
tabs.

/ Autos of-\
. / Brazilia-\

/ Ceramics-\
/ Chocolat-\
/ Dallas S-\_j

_/ Hellenic-\
/ Irish Im-\

/ Latin Am-\

/L

\_ J

By scrolling through your cardfile, you can bring different
cards into the open-card position and quickly scan the
cardfile for pertinent information.
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Touch the top of a knob to scroll —_

forward through the cards.

Touch the bottom of a know to

scroll backward through the cards./f/T

To scroll through a cardfile:

1. To scroll forward, press and hold down the [2]
key.

2. To scroll backward, press and hold down the
[v]key.

When you press [scrick], the status light lights indicating the
scrolling feature is on. You press again to turn the
scrolling feature off.

If your personal computer supports touch, touching the
top of one of the knobs on the card file scrolls the cards
forward, while touching the bottom of one of the knobs
scrolls the cards backward.

If your personal computer supports a mouse, you may
scroll up or down the cardfile by moving the pointer to an
up or down arrow on one of the knobs of the card file and
pressing the left button of the mouse.

Executive Card Mai

/ Orchards-\-

_/ Robinson-\
/ Scientif-\
/ Toys Int-\

/ Wines of-\
/ Wines of-\
/

Shirley Cochrane
218-125-0110

/ Autos of -\
/ Brazilia-\

/ Ceramics-\
/ Chocolat-\
/ Dallas S-

;/ Hellenic-\
/ Irish Im-\

/ Latin Am-\

/ Leather -\
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Locating Specific
Cards

When you are working with a large cardfile, you can find
cards quickly by typing part of the information that
appears within the primary key field. (This information
forms the text on the index tabs.)

When typing the information that ECM uses for its search,
you should remember these points:

You may use a maximum of eight characters for the
search. (ECM ignores any additional characters.)

You may use upper-case letters, lower-case letters, or
both. For example, ECM considers cummings,
Cummings, and CUMMINGS to be identical.

If you press the space bar before or after entering any
search characters, ECM ignores these leading or trailing
blanks. So if you press the space bar before typing the
letter P, ECM still locates the first P card.

You can go directly to the beginning of the cardfile by
pressing either the key or the key.

If your cardfile is sorted by dates, a date appears on the
index tab. When these dates have the form vy/MM/DD,
typing 81 displays the first 1981 card, (or the first 1982
card if no cards for 1981 exist). If you put slashes
between the year, month, and day (vY/MM/DD),
remember to include them when you ask for the date.
For example, if you want the first card for February 1984,
you must type 84/02, not 8402.
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To request a specific card:

1.

Type the first one to eight characters of the
information that appears on the tab.

For example, if your cardfile contains cards for
WELLINGTON and WELLINGSON, type WELLINGT if
you want the WELLINGTON card. If you want the

first W card, type W.

. Press [Ener].

ECM positions the first card whose index tab meets
your specifications in the open-card position. When
ECM fails to find a card that meets the search criteria,
it rolls the cardfile so the next sequential card beyond
this point appears in the open-card position.

Zi 1e1deyn
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Reading the
Information on a
Single Card

When a cardfile appears on your display, you see the first
three field lines of the card in the open-card position. To
read the entire card, you must pull the card from the
cardfile. When you pull a card, ECM displays it in full-card
format on the Select menu.

(fExecutive Card Manager SELECT Cardfile: A:\IMPORTS \

American N —
/ American-\

##% TMPORTS CARDFILE ##»

Company H#é

Agent’s Name
Telephone

Next Contact 8§
Street Address §
City

Country

Card Last Updated

Specialties
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To pull a card:
1. Highlight the index tab for the card you want to see.
You may accomplish this by:
® typing the characters which will identify that card

and pressing
® scrolling through the cardfile by using the +
[v]or the [2] keys

® accessing individual cards by pressing

2. Press the key.
ECM displays that card on the Select menu.

If your personal computer supports touch or a mouse, you
may choose any card whose index tab is visible by pointing
to that card’s tab.
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To read other cards without leaving the Select menu:

1. Choose ITREEN

ECM displays the card that comes next in order.

2. Choose [IXTIRIEXITY.
ECM displays the preceding card.

From the Select menu, you can update the information in
that card, place a phone call, mark that card, print it, or

delete it. Chapter 13 tells how you perform these actions.

To return to the Main menu:

1. Choose T
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Displaying the
Select Menu

Working with Individual Cards

This chapter describes updating, marking, and deleting
cards. The other tasks that you can do from the Select
menu are described in Chapter 16 (autodial) and Chapter
17 (printing cards).

You work with individual cards on the Select menu.
1. Start from the Main menu.
2. Get the cardfile you want to use.
Chapter 12 gives the details for this step.
3. Highlight the index tab of the card you want to see.

See Chapter 12 for a variety of ways to choose an
individual card from your cardfile.
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4. Press the key to display this card on the Select
menu.

Executive Card Manager SELECT Cardfile: A:\IMPORTS

Autos of Gotﬁenburg

/ Autos of-\

##x TMPORTS CARDFILE #»»

Company

Agent’s Name
Telephone

Next Contact
Street Address
City

Country

Card Last Updated

Specialties

13-2 Working with Individual Cards



Q
=2
o
T
-
]
=
-
w

Updating a Card While you are inspecting the card, you may decide to
change the information within some of the fields. Before
you start modifying a card, you should remember these
general guidelines:

& You may change the information in the fields in any
order.

B If you want to return the original value to a field, you
must move the cursor to that field and retype the
original information. When you want to return the entire
card to its original form, choosing
replaces the modified card with a copy of the original
card. (You must do this, however, before you choose any
other function label.)

@ You cannot change the field labels or the form title as
ECM protects these areas from being overwritten.

If your card form contains an Auto Date or Auto Time field
and you make any changes to the card, ECM updates the
value in these fields.
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Moving the Cursor ECM provides several keys that move the cursor quickly
between Fields from field to field:

B Pressing or advances the cursor to the next
field.

® Holding down and pressing moves the cursor
to the previous field.

8 Pressing the key moves the cursor to the first field
that appears on your display.

® Pressing the key (while the cursor is within the
first field that appears on your display) moves the cursor
to the first field on the form.

® Pressing the key moves the cursor to the last field
that appears on your display.
® Pressing the key (while the cursor is within the last

field that appears on your display) moves the cursor to
the last field on the form.

You may use touch or a mouse to move the cursor to the
appropriate field, if your personal computer supports these
pointing devices.
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Changing the  While a card appears on the Select menu, you may make
information on a Card  whatever changes you want. When you return a card to its
cardfile (by either displaying another card or returning to
the Main menu), ECM replaces the old version of that card
with the information that currently appears on the display.
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To change the information on a card:

1. Move the cursor to the appropriate field.
2. Type your new information over the existing text.

If this response is shorter than the original entry,
press the space bar to erase the remaining text.

You may also use the [ins] key and the key to modify
the entry in a field.

3. Repeat steps 1 and 2 until you have made all the
necessary changes.

4. When you finish updating the card, check that the
information is correct.
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5. If you change your mind, choose to
replace the original information in all the fields.

To return a card to its original condition, you must choose

while you are updating the card and
before you choose any other function label.

6. You may change the information in adjacent cards
without leaving the Select menu. Choosing
gets the next sequential card while

choosing gets the previous card in
your cardfile.

7. When you have no further changes to make, choose
to return to the Main menu.

If you have changed the information in the primary
key field, this change could affect the placement of
the card in the cardfile. For example, if Ms. Jones
marries and takes her husband’s last name (Smith),
ECM refiles her card under the letter “S”.
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Marking Cards

When you are working with a cardfile, you can single out
certain cards. (For example, you might mark the cards of
the clients you were calling on today.) ECM accomplishes
this task by placing an asterisk in front of the entry on the
index tab of the appropriate cards.

To mark individual cards:

1. From the Select menu, choosing marks
the current card.

ECM displays an asterisk () before the entry in the
index tab to show that you have marked this card.

You may also mark groups of cards from the Find menu.
See Chapter 14 for that information.

To unmark individual cards:

Once you have marked a card (these cards show an
asterisk before the entry on their index tab), you may
return the card to its unmarked status.

1. Choose [EEENIEXIE.

ECM removes the asterisk (*) from the index tab.

Notice that choosing [EETYIELESE either marks or
unmarks a card. The result depends upon the current
status of the card. If the card is not presently marked,
choosing marks it. Similarly, if the card is
presently marked, choosing unmarks it.

You may also unmark groups of cards from the Find menu.
Refer to Chapter 14 for this information.
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Printing a Card

Chapter 17 provides information on ECM'’s printing
facilities. As the Select menu uses information stored in
the Printer Setup menu, please refer to that chapter for
details on setting these values. In particular, the entry for
the Lines Per Card field determines how many lines ECM
prints for each card.

The value in the Lines Per Card field sets the upper limit
for the number of lines that ECM prints for any card.
Therefore, if this value is 10, ECM only prints 10 lines,
even though more lines may appear on your display.

To print all the information on a card:

1. Display the card you want to print.

2. Choose |NTEFY

ECM prints all the information on that card. When a
card contains several pages, ECM prints the
information that is visible on the display as well as
any information that is off the display.

The card’s image appears with the card borders, the
form title, the field labels, and field contents. The
fields are underlined, and the card border appears as
a series of dots and dashes rather than a solid line.
(Since a card is 80 columns wide, ECM prints the
card’s full width, regardless of the settings for the Left
and Right Margins in the Printer Setup menu.)
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3. To print adjacent cards, choose to display
the next card or to display the

previous card.

4. Choose after each card appears.
To print several cards quickly:

You may print several cards in rapid succession by
choosing [ Print Caro il Next Cano B
ESEESEEN. and so on, without waiting for ECM to print
each card.

Under these circumstances, the computer stores the
commands in its memory, and ECM carry them out in
sequence.

You can also instruct ECM to print just the information
that appears within certain fields on the card form. Such
printouts resemble lists, not actual cards. (Chapter 17
describes ways to print information in a cardfile.)

To print a portion of a card:

ECM allows cards to be a maximum of 255 lines in length.
When a card’s length exceeds 19 lines, ECM only displays a
portion of the card on your display. When you just want to
print the card information that appears on your display,
hold down and press the key. ECM prints only
the part of the card which appears on the display. You may
then use the or keys to bring another portion

of the card into view.
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Deleting a Card Since a cardfile contains a fixed amount of space, you

should remove extraneous cards.

To delete a card from your cardfile:

1. Display the card you want to delete.

2. Inspect the information on this card and verify that
you have no further use for this information.

3. Choose ESTITXHEN.

As the information on this card will be lost, ECM
asks you to confirm your intentions:

To confirm that you want to delete this
cardi choose "Yes".

4. If you want to delete this card, choose [KIEH.

ECM deletes the card and displays the next card in
the cardfile.

If you change your mind:
If you chose by mistake, or if you decide you

want to keep the card, choose [ffl to cancel this
operation.
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Leaving the 1. Once you have finished all your tasks on the Select

Select Menu menu, choose EGHETN -

ECM displays the Main menu. The last card on which
you were working appears in the open-card position.
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Searching for Specific Cards

At times, you want to inspect specific cards in your
cardfile, rather than viewing the entire cardfile. For
example, suppose you are visiting New Orleans and you
get an insatiable craving for pizza. First, you might search
for Italian restuarants that serve your favorite German beer.
Then, after checking your wallet, you might refine the
search to those restuarants whose dinners average less
than ten dollars.

With a traditional cardfile, this is a tedious task. Using
ECM, however, you can quickly find the desired cards as
ECM uses its computer speed to search the cardfile for
you. Furthermore, after it identifies all the cards that meet
your criteria, ECM displays them for you to view.

You may also use the Find menu to mark all the cards in a
cardfile or only those cards that meet certain criteria. See
the section on Marking a Group of Cards for more
information.

Searching for Specific Cards 14-1
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Prepar il'lg for a The first step in isolating a particular set of cards is calling

Search up the Find menu. As ECM requires disc space to build a
temporary file, be sure sufficient room exists to store this
file in the directory which contains the cardfile.

To display the Find menu:

1. Start from the Main menu.

2. Get the cardfile that you want to search.

Company
Agent’s Name
Telephone

Next Contact
Street Address
City
Country
Card Last Updated

Specialties
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Creating a From the Find menu, ECM will locate all the cards with
Workset fields that match the information you specify. These cards
make up a workset.

To create a workset:

1. Start from the Find menu.

2. Move the cursor to the field you want ECM to use in
its search.

3. Type the search criterion into that field.

For example, you might type Smith into the Last
Name field to find all the Smith entries in your
cardfile.

The concluding sections in this chapter describe the
different types of searches that ECM provides. Refer there
for information on literal searches, numeric searches,
negative searches, and wildcard searches.

4. If you want to further refine the search, repeat steps 2
and 3 for each appropriate field.
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Company
Agent’s Name
Telephone

Next Contact (Yv/MM/DD)

Street Address
City

Country

Card Last Updated

Specialties

5.
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After you fill in the appropriate fields, check each
entry and make any necessary corrections.

Choose
ECM tells you it is:
Searching the cardfile.

ECM then displays the Main Workset menu. The
Workset menu appears identical to the Main menu
except the caption on the first line reads Workset of:
rather than Cardfile:, and the label for reads
rather than |ESTEREl. The workset

includes only those cards that met your criteria.



7.

From the Workset menu, you may simply view the
cards, or you may work with them as you would the
cards from a cardfile.

When you finish working with the workset, choose

Exit Workset |8

As ECM returns the cards to the original cardfile, it
first asks for confirmation:

The current workset will be discarded-
Press "Yes™ to exit workset.

Choosing discards the workset, and the original
cardfile you were using reappears on the Main menu.

Searching for Specific Cards 14-5
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FiIIing in a Field When filling in fields, remember that:

14-6 Searching for Specific Cards

You can fill in the fields in any order.
You can specify only one term in each field.

You can search as many fields as you want. When you
search on several fields, you ask ECM to find those
cards that meet the criteria in all the fields, not just one
or two of them.

You can use a whole word (California), part of a
word (Calx), or a phrase (such as Los Angeles or
reasonable prices).

You can use a complete number (84/01/25) or part of a
number (x/01/x* for all the dates in January).

When you search by part of a word or number (such as
Calx or x/0L/x), the asterisk (x) is a wildcard symbol,
which stands for all possible combinations of characters
that you omitted.

You can search for all the cards before or after a given
number (for example, all the cards with prices lower
than $100).

You can mix types of search categories. For example, you
can search by a wildcard in one field and by a whole
term in another. You can search by numbers in one field
and by letters in another.



Making Long Entries

When you want to enter search characters into a field and
the field does not have sufficient room to hold all the
characters, you may enter the necessary information on the

menu’s input line by using FETCISCICE-

To enter a search string into a short field:

1.
2.
3.

Start from the Find menu.

Move the cursor to the field that you want to search.

Choose [EFTTEISEN.

This keystroke produces a flurry of activity:

@)
=
1Y
hel
-
1]
=
—
E=Y

The function labels go blank except for [Fe], which
now indicates TSN

ECM prompts you to: Edit the information
then press ENTER.

In preparation for your reply, ECM moves the
cursor to the beginning of the input line.

If the field contains information, ECM also displays
this information on the input line

ECM fills the chosen field with backslashes (\) to
show that you must enter the search information
on the input line.
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6.

Type the complete information required for the
search.

If necessary, you may go back and make any
necessary corrections by either retyping the
information or using the keyboard’s editing keys.

If you change your mind, choose TSN .

ECM replaces the original entry in the chosen field
and returns the function labels to their previous
values.

If you want to continue with the search, pressing
completes the entry.

Upon sensing this keystroke, ECM performs the
following tasks:

& It returns the function labels to their previous
values.

B It returns the cursor to the proper field.

B It displays as much of the entry as possible within
that field.

You may now enter additional search terms using either
the normal method or this procedure for another long
entry.
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Making Corrections

Filling in Group Fields

While you are entering your search criteria, you can make
corrections to any of your entries just as you would when
you enter information into a field.

ECM searches the cardfile based upon the information that
currently appears in each field. Therefore, when you
change a field’s contents, be sure to replace the entire
entry, deleting extraneous text when necessary.

If your card form contains grouped fields (see Chapter 9),
you may search for a particular piece of information in all
the combined fields.

v1 Jaideyd

You should conduct a wildcard search for the information
you want to find by enclosing this information between
asterisks (x). For example, if you want to search a cardfile’s
Comment fields for “reasonable” prices, you should enter
xreasonablex.

When you type the search criterion in one of the fields,
ECM displays the same information in the other fields of
that group. Then, once you choose EEFERFEM, ECM
searches all the fields as though they were one continuous
field. This ensures ECM will locate cards which contain
that information, even if the information crosses a line
boundary. For example, if you are searching an On-order
field for Hewlett-Packard equipment and “Hewlett*’ occurs
at the end of one field and “Packard” begins the next field,
ECM identifies this card as containing the required
information.
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Completing the
Search

Once you have typed the search criteria on the Find menu,
choose [ETETRT. (If you decide to abandon your
search, choose to redisplay the Main menu.)

At this point, ECM searches your cardfile for the cards that
meet your criteria. The time required for the search
depends on the size of your cardfile.

Upon completing the search, ECM displays a new rotary
card file that contains the desired cards. For example, if
you searched your Address cardfile for all lllinois cards, the
new card file contains Illinois cards (if any exist) and no
others.

The Illinois card file is a workset, not a cardfile. ECM
informs you of this fact in several ways. Most obviously,
the cardfile’'s name on the first line now reads Workset
of : ADDRESS rather than Cardfile: ADDRESS. Further-
more, on the Main menu, the label for changes from

Exit ECr OGN ExitUorkse: §
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Working with the
Workset Menu

A workset is a group of cards that ECM temporarily pulls
from a cardfile. In most ways, a workset resembles an
ordinary cardfile. You can print an individual card from the
workset, or you can print the entire workset. Furthermore,
you can copy the workset, transfer information into it or
out from it, and even conduct additional searches on that
workset. When you conduct a search on a workset, ECM
displays the results of this search as a workset of a
workset. Any task that you can do with a workset, you
may also do with a workset of a workset.

v1 421deyd

Worksets differ from cardfiles in one, important way;
worksets are temporary while a cardfile is permanent.

Because ECM returns the cards in a workset to the original
cardfile, any changes you made in the workset are
automatically preserved in the cardfile. In other words, if
you create a workset of a cardfile and then delete one of
the cards in the workset, you also delete the card from the
original cardfile. Similarly, adding cards to a workset or
updating a card within the workset makes the
corresponding change to the original cardfile.
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I..eaving the If you want to add cards to a workset, delete cards from it,
original Cardfile or revise cards in it, without affecting the original cardfile,

you must make the workset into a permanent cardfile.
Intact Chapter 18 explains how you can copy a workset to make a
new cardfile.

Once ECM has copied the workset, the copy becomes a
separate, permanent cardfile. You may then change to the
new cardfile and use it without affecting the original
cardfile.
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Narrowing a
Search

If, after searching for a workset of your cardfile, you decide
to further refine the search, ECM makes it easy to search
for a workset of that workset. For example, suppose you
want to know how many of your employees earn between
$25,000 and $50,000 a year. Even though ECM provides a
wide variety of searches, no one search yields that result.
Rather, you must conduct two searches. First you find the
cards for those people who have salaries over $25,000.
Then from this workset, you isolate the cards of those
people who earn $50,000 or less. The resulting workset
(actually, a workset of a workset) contains the cards of all
employees who earn between $25,000 and $50,000.

To narrow the search:

1. Start with the current workset appearing on the
Workset menu.

2. Choose I .
ECM displays the Find menu.

3. Enter the additional search criteria that refine your
seach.

4. Press [Ener].

ECM eliminates all the cards that don’t meet the new
conditions and displays only the cards that do. (The
cardfile name is still preceded by Workset of:.)

Searching for Specific Cards 14-13
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When you finish using a workset of a workset:

1. Choose ESTITINNES.

As the workset will be discarded, ECM asks you to
confirm your intentions:

The current workset will be discarded-
Press "Yes™ to exit workset.

Caution You can’t return to an earlier workset. When you choose
IERTRITE. ECM refiles the cards in the original cardfile
and returns to the Main menu with the original cardfile
showing.

2. If you want to discard the workset, choose [KfER.

ECM returns the cards to their cardfile and displays
the Main menu.

3. If you want to retain the workset, choose to
cancel your request.

Then follow the procedures in Chapter 18 on saving a
workset as a cardfile.

4. Choose to return to the Main menu.
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Marking a Group

of Cards

You may also use the Find menu to mark cards. (Chapter
13 describes how you can use the Select menu to mark
individual cards.)

To mark all the cards in a cardfile:

If you want to mark all the cards in a cardfile, you don't
have to mark each card individually.

1.
2.
3.

vi Jo1deyd

Start from the Main menu.

Get the cardfile that you want to mark.

Choose [EFRELEEN .

ECM displays the Find menu. The middle portion of
the message line displays the number of marked
cards in your cardfile. For example, when no cards are
marked, ECM displays: 0 marked cards.

Choose to mark every card in the cardfile.

After you have marked all the cards, you may
continue with the task you had in mind.
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To unmark all the cards in a cardfile:

If you want to remove the mark from all the cards in a
cardfile, follow these steps:

1.
2.
3.

1416 Searching for Specific Cards

Start from the Main menu.
Get the cardfile that you want to change.

Choose ¥ .

ECM displays the Find menu. The middle portion of
the message line displays the number of marked
cards in the cardfile.

Choose [TEFPUTER to remove the mark from every
card.

ECM requests confirmation:

All cards will be unmarked. Press
"Yes"™ to confirm.

If you change your mind, choosing [[fll retains the
mark.

Choosing [ removes the mark from all the cards.



To mark all the cards in a workset:

Usually you want to choose a group of cards from a
cardfile, then work with that subset of cards.

1. Start from the Main menu.
2. Get the cardfile that you want to search.
3. Choose HEFISIET.

ECM displays the Find menu.

4. If you only want to mark the cards in the workset
you are going to create, choose to remove
any existing marks.

v1 Jardeyd

5. Fill in the appropriate information on the Find menu
to tell ECM how to search the cardfile.

6. Choose to create the workset with the
desired cards.
ECM finds all the cards that meet your criteria and

displays them as a temporary workset on the Main
Workset menu.

Remember, you are working with a workset, not a cardfile.
For visual reminders, the first line reads Wworkset of and
the message for [f8] is EEETIITIN .

7. Choose to return to the Find menu.

8. If you want to mark all the cards in the workset,

choose EHTYFN.
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If you only want to mark some of the cards, you may
use the function label from either the
Main or Select menus.

You may unmark all the cards in a workset by choosing

Unmark All N

10.

1.

By repeating steps 3 to 9, you may define smaller and
smaller subsets of the original workset. Remember, if
you only want to mark some cards, rather than all the
cards in a workset, use the function
label from either the Main or Select menus.

To return to the Main menu, choose [EEEE.

ECM returns you to the Main menu, but the marks
you placed on the cards are retained.

To see a workset of all the marked cards:

When you have marked cards in successive worksets, you
can create a workset that contains all the marked cards:

1.
2.
3.
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Start from the Main menu.

Choose IEETISIEN.
Choose FFTIEITEE.

ECM locates all the cards that contain a mark and
displays these cards, as a workset, on your display.

To return to the Main menu, choose |ETEERN.



Widening a
Search

When you enter search criteria in several fields, you ask
ECM to find those cards that meet all the criteria. When
you narrow a search, you conduct consecutive searches on
the same field to produce a more restrictive workset.
Similarly, you may do consecutive searches on a field and
mark the cards in each workset. Then, if you combine all
the marked cards, you have effectively widen your search.
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For example, suppose you are working for a political party
and you are making a list of the major contributors to last
year’s campaign. From a cardfile for the United States, you
decide to create a series of cardfiles for different regions.
Therefore, to create a NEWENG cardfile, you could search
for contributors in Maine and mark their cards; then search
for contributors from Vermont and mark their cards; and
so on, until you have marked the cards for everyone from
these states. Then choosing builds a workset
that contains all the contributors from New England.
Finally, you could copy this workset to make a permanent
cardfile; unmark the cardfile, and continue with the next
region.
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Searching in
Greater Detail

ECM works with two basic types of searches:

m literal searches (in which ECM compares two items,
character by character)

B numerical searches (in which ECM compares numbers
by their values)

Within each of these categories, you may instruct ECM to
do:

& a normal search (in which ECM matches the information
you enter)

B a negative search (in which ECM matches everything
that differs from the information you entered)

Finally, you may enter information into the fields, in one of
two ways:

8 you can search by a whole word or number

® you can search by part of a word or number

When you search by part of a word or number, you are
conducting a wildcard search.

The following paragraphs provide additional details on the
different types of searches.
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Conducting a Literal
Search

In a literal search, ECM looks for an exact match of
characters. Therefore, always enter your search criteria in
exactly the same manner as it appears in the fields. For
example, if you want to search for doctors, and your card
form uses Dr. in the title field, you must search for br-
(or dr.) and not Doctor (or doctor).

You conduct a literal search by typing the desired
information into the appropriate field. The items may look
like text (such as Fort Collins) or numbers (such as
(312) 555-2531).

t1 193deyd

When you conduct a literal search, you may search for
either the entire entry in a field or for part of an entry
(that is, by wildcard). For example, if you want to find all
the cards for people in San Francisco, type the complete
entry San Francisco. However, to find all the cards for
people in cities that begin with “San”, type San x. In this
case, ECM finds the cards for San Antonio, San
Bernardino, San Francisco, and so on. However, if you
omit the space between San and the asterisk (x), ECM also
finds the cards for cities such as Sandusky and Santa
Barbara.

Because ECM considers all searches to be literal searches
unless you instruct it otherwise, you may enter just the
required information. When you want to qualify the literal
search with a relational operator, however, you must
precede the search string with a combination of symbols
that specifies the type of search. The following list provides
more information.
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You may direct ECM to perform the following literal
searches:

# To find an exact match. For example, typing SMITH or
A=SMITH finds all the cards that contain SMITH in the
designated field.

B To find anything that ends with the given information.
For example, typing *SMITH or A=*SMITH finds all the
cards that end in SMITH (such as BLACKSMITH).

B To find anything that begins with the given information.
For example, typing SMITH* or A=SMITHx finds all the
cards that begin with SMITH (such as SMITHSONIAN).

8 To find anything that contains the given information. For
example, typing *SMITHx or A=xSMITHx finds all the
cards that contain SMITH (such as WORDSMITHS).

8 To find anything that exceeds the given information. For
example, typing A>SMITH finds all last names which
come after SMITH.

8 To find anything that is greater than or equal to the
given information. For example, typing A>=SMITH finds
all last names from SMITH through the end of the
cardfile.

B To find anything that is less than the given information.
For example, typing A<SMITH finds all last names that
precede SMITH.

® To find anything that is less than or equal to the given
information. For example, typing A<=SMITH finds all last
names up to and including SMITH.
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You may conduct a literal search on a field with numbers
when you remember exactly how you entered the numbers
into that field. For example, if all your cards show dates
with slashes between the three elements, typing ?b/07?/04
in a date field finds all the cards with the Bicentennijal date
of July 4, 1976.

You may also use relational operators for literal searches on
numbers. For example, typing A>83/10/27 finds all the
cards with dates after October 27, 1983; while typing
A>=83/10/27 finds all cards with dates on or after October
27, 1983. Similarly, typing A<&3/10/27 finds all the cards
with dates before October 27, 1983; and typing
A<=83/10/27 finds all cards with dates on or before
October 27, 1983.

v1 Ja1deyd

You may also use wildcards in a literal search. For example,
to find all the cards with dates in 1976, you may type
?k/x%. In this case, the asterisk (¥) stands for any month
and day.

Although certain literal searches resemble numeric
searches, ECM considers these searches to be very
different. For example, in a literal search, 120 is less than
60 because 1 is less than 6. However, in a numeric search,
120 is greater than 60 because 120 is twice the value of 60.
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Conductinga In a literal search, ECM considers 2000 to be different from
Numeric Search 2,000 because one number has a comma and the other
does not. But what happens if you forget whether you
entered a number as 2000 or 2,000?

ECM provides an easy way to search for numbers when
you only remember the numbers and are uncertain what
symbols (if any) the number includes. In this case, you ask
ECM to conduct a numeric search.

In a numeric search, ECM compares two numbers by
evaluating their values. That is, ECM only considers the
numbers (such as digits, a decimal point, and a minus
sign) and ignores all other characters. (The minus sign may
come before the first digit or after the last.) Thus with a
numeric comparison, ECM considers the telephone
numbers (313)555-4448 and 313-555-4444 to be
identical. In a literal search, where ECM compares each
character in sequence, these two phone numbers are
distinct.

With a numeric search, you must provide a relational
operator to tell ECM how it should test the values. You
must choose the operator from the following list: =, >, or
<. (You may combine the equal sign (=) with the other two
operators.) You may also include the letter N (or n) for
Numeric before the relational operator as a visual clue that
you may use to distinguish numeric searches from literal
searches.

B When you type = (equals) before a number, ECM finds
only those cards which have that number in the chosen
field. For example, you would type =1000 in the price
field to see all the cards for items that cost exactly
$1,000.
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® When you type < (less than) before a number, ECM
finds all the cards which have a lower number in that
field. For example, you would type <1000 in the price
field to see all the cards for items that cost less than
$1,000.

® When you type > (greater than) before a number, ECM
finds all the cards with a higher number in that field.
For example, you would type >1000 in the price field to
see all the cards of items that cost more than $1,000.

(2}
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You may also use the equal sign in conjunction with the
other two symbols. That is, typing >= finds all the
numbers greater than or equal to the given number.
Likewise, typing <= finds all the numbers that are less
than or equal to the given number.

Whenever you use these symbols in a numeric search, you
must remember:

B You cannot combine the greater than and less than
symbols. For example, you can’t ask for all the salaries
greater than $25,000 but less than $50,000. (See the
section on Narrowing a Search for ways of doing this
task.)

# ECM only reads digits, the first decimal point, and a
minus sign when evaluating a number. Therefore, if you
type =2000, ECM finds all the cards having that value.
For example, you could see cards for $2,000 or 2,000; but
not for $20.00 or -2,000.

® You cannot use a wildcard symbol (x) when you search
by the numeric method.
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Conducting @  Besides the normal search for specific information, you
Negative Search  may also direct ECM to find all the cards that have a
different entry than the information you supply. In
computer terminology, this is the NOT function. That is,
you want ECM to find all the values that are NOT the
given value.

You indicate the NOT function by typing a tilde (~) before
the information you want ECM to use in its comparison.
For example, typing A~=xdonex finds all the cards without
done somewhere in that field.

You must place the tilde (~) first in the field, unless you
are using the letters A or N. In this latter case, the tilde
follows the A (or N) and precedes the relational operator.
For example, you may use either ~*donex or A~=xdonex.

Conductinga You can use an asterisk (x) as a wildcard when conducting
Wildcard Search  a search. ECM assumes the wildcard matches any character
(or any possible combination of characters). For example,
typing SMITHx in the Last Name field produces not only
the SMITH card but also the SMITHFIELD and SMITHY
cards. Typing */04/% in a YY/MM/DD birthday field
produces all the cards with April birthdays.

You may use wildcards in literal searches and negative
searches, but not in numeric searches. For example, typing
A~=x in a field locates those cards where that field is
empty.
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Special Types of
Numerical
Searches

Searching by Times

If you have consistently entered the values for a time field,
date field, or telephone field, you may use literal searches
to find specific cards. However, if the entries use differing
formats, you should use a numeric search to find the
proper value.

You may use either a literal search or a numeric search
when searching by times.

Auto Time fields use an HH:MM:SS format. The following
searches pertain to time fields that use an HH:MM format.

For literal searches:

You may use literal searches to find exact times or parts of
times. Remember to type the time exactly as you wrote it
on your cards.

#@ To find a specific time, type the exact time. For example,
if you entered times in an HH:MM format, type 10:00 to
find all the meetings scheduled for 10:00.

B To find part of a time, type the part of the time you
want (either hour or minutes) and supply an asterisk
(%), the wildcard symbol, for the missing terms. For
example, to find all the meetings between 10:00 and
11:00, type 10:x.
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For numeric searches:

When you search for times by the numeric method, you
must use a whole term, not just part of a term. That is, if
the time includes both hours and minutes (as in the
format: HH:MM), you must enter both elements.

B Because you must use the whole time, you cannot
search by wildcard. For example, you cannot type >x:30
to find all times later than half past the hour.

8 Use < (less than) or > (greater than) to find all times
before or after a given time. For example, to find all
meetings scheduled after 2 p.m., type >1u400 in the
appropriate field. (Remember, when you conduct a
numeric search, ECM ignores the colon.)

Searching by Dates  You may search by dates using either the literal or the
numeric method.

m
o

o

&
e

Auto Date fields use a localized format for the date. The

following searches pertain to date fields that use a
YY/MM/DD format.

e
b
t

&

For literal searches:

Use literal searches to find exact dates or parts of dates.
Remember to use the date, or part of the date, exactly as it
is written on your cards.

B To find a complete date that is shown as YY/MM/DD,
type the date in the same style. For example, type
ay/02/1k.
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# To find all the dates in a certain year, use the first part
of your date (YY/) and include the slash and a wildcard
symbol (x). For example, type 84/x to find all the 1984
cards.

B To find all the dates in a given month, use the second
part of your YY/MM/DD date. Surround the month by
slashes and wildcard symbols to show that you are
searching for the month. For example, type x/04/x* to
find all the April cards.

@ To find all the dates on a given day of the month, use
the third part of the YY/MM/DD date. Include the slash
and wildcard symbol (x). For example, type */13 to find
all the cards with a date on the 13th day of a month.
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For numeric searches:

When you search for dates by the numeric method, you
must use the whole date, including two digits each for
year, month, and day. For example, type 840218. (ECM
ignores the slashes in dates written as YY/MM/DD.)

B Because you must use the whole date when you use the
numeric method, you cannot use a wildcard as part of
your search. For example, you cannot use >k4/x to find
all dates after 1964.

B To find all the dates before or after a given date, use <
(less than) or > (greater than) followed by all the
numerals in the date. For example, to find all the people
with birthdays after 1950, type >501231. To find all the
people with birthdays after July 1950, type >500731.
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Searching by  You may search a telephone number field using either the
Telephone Numbers literal or numeric method.

For literal searches:

Use literal searches to find telephone numbers when you
know what special symbols the numbers include; for
example, (313) 555-3212 as opposed to 313-555-3212.

B You can use wildcard searches to find parts of telephone
numbers. For example, to find all numbers with a 212
area code, type x212* in the Phone field. ECM then
finds all the phone numbers whether they have 212 area
codes written as (212) or 212-.

In a literal search, ECM also finds a card with the phone
number 528-2120, because *212* tells ECM to find the
combination 212 wherever it appears—no matter what
precedes or follows it. On the other hand, typing 212*
fails to find the (212) cards, since no wildcard symbol
tells ECM to look for characters before the 212.

B You can use a similar procedure to find all the phone
numbers with a given exchange.

For numeric searches:

You can type an equal sign (=) before a telephone number
when you don’t remember how you entered the number
on the card. For example, typing =2125558854 finds the
correct card whether you entered the number as (212)
555-8854 or 212-555-8854.
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Rearranging the Cards
= in a Cardfile

If you have filed your cards in one order then decide you
would like to see a different ordering, ECM provides a
convenient way to rearrange the cards in a cardfile. This
chapter provides that procedure.

ECM displays the rearranged cards in a temporary workset.
If you want to retain this ordering, you must copy the
workset to save it as a cardfile.

(@}
=
[
T
-
@
=
-
4]

Preparing to Sort The first step in rearranging a cardfile is displaying the
Your Cardfile Sort menu.

Caution ECM requires disc space to build a temporary file to hold the
newly sorted cards. Be sure that sufficient room exists for this
file in the directory that contains the cardfile.
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To display the Sort menu:

1. Start from the Main menu.

2. Get the cardfile that you want to rearrange.

3. Choose TS .
ECM displays the Sort menu:

/

(VrExecutive Card Manager SORT Cardfile:

A:\IMPORTS

*#% TMPORTS CARDFILE #%»

Company

Next Contact i (YY/MM/DD}
Street Addres
Cit

Countr:

Card Last Updated

Specialtie

~
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Setting the The fields that ECM uses for sorting are called key fields.

Search Terms The following sections describe how you set these fields.
Setting a new key field automatically cancels the
designation of that field anywhere else on the form.

You should also remember these points about key fields:

B You can set a maximum of three key fields.

B If several cards have identical values in all the defined
key fields, ECM files the cards in the order in which
they were created.

® You may assign key fields in any order. For example, you
may set a First Name field as a secondary key field then
set a Last Name field as the primary key field. Further-
more, ECM converts the final listing to a sequential
ordering. So, if you set a primary key field and a tertiary
key field and sort the cardfile on these two fields, ECM
considers the tertiary field to be the secondary field.
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@ When you omit setting a key field, ECM uses the first
field of the form as the primary key field.

@ You may set an Auto Date or an Auto Time field as a
key field.

@ You may designate key fields to be sorted by numeric
value.
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Setting the Primary  The information from the primary key field is shown on
Field the index tab of each card in your cardfile. ECM files your
cards in order, according to this field.

To set the primary key field:

1. Move the cursor to the field that you want to use as
the primary key field.

2. Choose IS .

When you choose this key, the current field becomes
the primary key field. The symbols K1 appear within
the field and an up-arrow indicates that the items will
be sorted in ascending order.

When a field is too small to show all the field type
characters, ECM displays this information on the field
expansion line.

3. Choose again to designate the primary
key field as a numeric key field. The symbols K#1
appear within the field.
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Setting a Secondary
Field

Setting a Tertiary
Field

When you assign a second key field, if multiple cards have
identical information in their primary field, ECM then sorts
the cards by the information in their secondary key field.

To set a secondary key field:

1. Move the cursor to the appropriate field.

2. Choose ISVSIATIEN
The letters K2 appear at the beginning of the field,
and an up-arrow indicates an ascending sort.

3. Choose again to designate the second
key field as a numeric field.

When you assign a third key field and several cards have
identical information in both the primary and secondary
key fields, ECM further orders the cards by the information
in their tertiary key field.

To set a tertiary key field:
1. Move the cursor to the appropriate field.

2. Choose YR .

The letters K3 appear at the beginning of the field,
and an up-arrow indicates an ascending sort.

3. Choose again to designate the third key
field as a numeric field.

Rearranging the Cards in a Cardfile 15-5

O
I
[
o
~
®
=
-
o




Changing the Sort  ECM automatically sorts cards in ascending order (that is,
Order 1" before “2” and “A” before “B”). However, when you
want ECM to use a descending order for sorting your
cards, you must give ECM explicit directions:

1. Move the cursor to the appropriate field.

2. Choose BTt YTl

ECM displays a down-arrow to show that this field
uses a descending sort.

If you decide to change this field back to an ascending sort
field, move the cursor to that field and choose

TSN . This returns the field to its original

ascending sort order.
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Removing a Key Field The function labels that you used to set a key field are the
same labels that remove a key field.

To remove a key field:
1. Move the cursor to the field you want to change.

This field contains the appropriate K value, showing it
is a key field.

2. Choose until the primary field is
cleared, to remove a secondary key
field, or IB to remove a tertiary key field.

ECM removes the K designator from that field.

If removing a key field produces a gap in the numbering of
key fields, ECM automatically closes the gap to give the
proper sequence when sorting the cards.
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Returning to the  After you have changed the key fields on the Sort menu,
Original Key Values you may return the fields to their originalv settings if you
decide to start over.

Choosing only displays the previous
values for the key fields on the Sort menu. It does not re-

sort the cardfile.

To return the key fields to their original values:

1. Choose IS

ECM returns the key fields to their previous values.

and choose TIPS, ECM uses the current values
for the workset you just created as the previous values and not
the cardfile’s original key values.

Caution w If you have chosen ETEEEIE. then return to the Sort menu
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Cr eating a After you have entered the appropriate key values, you can
Workset create a workset that sorts the cards according to their new
values.

To create a newly sorted workset

1. Choose [RIIEXTN
ECM displays the message:
Sorting the cardfile.

After ECM reorders the cards, it displays them as a
workset for you to view.

2. You may now do the task that you had in mind when
you created this workset.
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Caution Since this is a workset and not a permanent cardfile, you must
copy the workset if you want to retain the new ordering.

Rearranging the Cards in a Cardfile 15-9



Retur ning to the After you finish working with the Sort menu and its
Main Menu workset, you may return to the Main menu and the
original cardfile.

To return to the Main menu:

1. Choose TSNS

As the workset will be discarded, ECM asks for
confirmation:

The current workset will be discarded-
Press "Yes"™ to exit workset.

2. If you want to discard the workset, choose [EE .

ECM returns the cards to their original order and
displays the current cardfile on the Main menu.

3. If you want to retain the workset, choose IIl.

ECM cancels the request and returns the function
labels to their previous values so you may choose
another task.
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What Equipment
Do You Need?

Using a Modem

;Using Autodial

Autodialing permits ECM to place telephone calls for you.
As you may make the most of this feature if an Autodial
field appears on your card form, you should read the
section in Chapter 9 on Setting the Autodial Field when
you are creating a new cardfile. Chapter 11 provides details
on filling in the Autodial field.

To use Autodial, your personal computer must have access
to a modem, and you must connect the modem to your
telephone line.

ECM works with a variety of modems. However, if you are
using a modem other than a Hayes compatible modem,
you must supply the necessary information to prepare your
modem to place a call. You accomplish this task through
the Modem menu.
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Before You Pl
a Call

16-2 Using Autodial

Before you place your first call, you must give ECM the
information it needs to accomplish three tasks:

B prepare the modem to dial
B dial the number

B return the modem to its initial state

You specify this information in the Modem menu.
Furthermore, the Modem menu allows you to enter dial
codes which simplify your work when typing telephone
numbers.

To reach the Modem menu:

1. Start from the Main menu.

2. Choose to display the Cardfile Tasks
labels:

/ Robinson-\-

_/ Scientif-\
/ Toys Int-\
/ Wines of-\

/ Wines of-\
/ \

/ American-\

Gustaf Edenaas
041-120910

/ Brazilia-\
/ Ceramics-\

/ Chocolat-\
/ Dallas S-\
/ Hellenic-\_

_/ Irish Im-\
/ Latin Am-\

/ Leather -\

/ Lenses o-\




3. Choose to display the Modem menu.

Executive Card Manager MODEM MENU Cardfile: A:\IMPORTS \

Dial Codes ——

Modem Information —
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Defining Dial Codes

16-4 Using Autodial

A dial code consists of a Code Name and Substitution
Numbers.

The code name identifies a specific number. Using a name
for a series of numbers eases the task of entering
telephone numbers on individual cards and lessens the
chance for error. A good example of how dial codes may
simplify your work is MCI access numbers. Rather than
typing a long MCI access number in several phone fields,
you may give the MCI prefix a name. For example, if you
call the prefix MNCINUM, whenever ECM encounters
/MCINUM/ in an Autodial field, it recognizes MCINUM as a
dial code and substitutes the actual access number for that
name.

When you type telephone numbers onto a card, remember
that you must enclose special characters between slash
symbols ( /). Then, if the characters between the slashes
form the name of a dial code, ECM sends the substitution
number rather than the name. If the characters don't form
a code name, ECM sends the characters to the modem
exactly as you entered them.




The Substitution Numbers field contains the information you
want ECM to send whenever it encounters that dial code’s
name.

You may enter up to 60 characters in this field, but the
number may contain a maximum of 39 dialable characters.
As ECM normally ignores blank characters, you may
include spaces to ease the reading of this information.

If you want to include a dial code or some other special
characters, enclose this information between slashes (/).

Because ECM replaces a code name with its substitution
number, the 39 dialable characters includes the expanded
version of the number; not the abbreviated form.

You may refer to any other dial code only once within a
substitution number. For example, you could define LOG-
ON to be 123-4567 /PASSWORD/ and PASSWORD to be
54321. However, you can't define PASSWORD to be 54321
ILOG-ON/ since LOG-ON refers to PASSWORD.

You may define a maximum of eight dial codes for each
cardfile. These dial codes become part of the cardfile, so
when you copy the cardfile to a disc, ECM stores the dial
codes with the card information. Thus, you can use the
cardfile on another system without making any special
changes.
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Controlling Your
Modem

Caution w

16-6 Using Autodial

Before ECM can place a telephone call, it must know
where to find your modem and how to prepare the
modem to dial the number. You supply this information on
the bottom portion of the Modem menu.

The Modem Name identifies how your modem is connected
to your personal computer and what the baud rate is. The
default setting is COM1-300 Baud. You can change this
setting by choosing the NI or
keys until the appropriate value is displayed in the field.

The Modem Instructions field permits ECM to work with a
variety of modems. Within this field you give the required
instructions:

® to prepare your modem for dialing
® to dial the number

B to return the modem to its initial state

ECM sends this information to the modem for every call
you place using the Autodial facility.

Any part of the characters in the Modem Instruction field
can contain a maximum of 39 dialable characters. This total
does not include spaces (which you may include to faciliate
reading), attention codes, or control characters (such as
[ctrL]-[M] for the carriage return character).

You cannot use dial codes within the Modem Instruction field.




The values that initially appear in this field give the proper
instructions to prepare a Hayes compatible modem for
dialing. The following discussion summarizes the meaning
for these symbols. If you want to change these values, you
should consult your modem manual for further
information.

Symbol Meaning

AT The Attention code. As your instructions to
the modem may contain several commands,
you must begin each command with an
attention code. AT must be in capital letters;
other commands may be in capital letters or
small letters.

o The Transmitter Carrier Signal parameter. A
value of O turns the transmitter off while 1
turns it on.

Ml The Monitor Speaker parameter. A value of 0

always leaves the speaker turned off, a
value of 1 leaves the speaker turned off
until the carrier is detected, and a value of
2 always leaves the speaker turned on.

R1 The Result Codes parameter. Results codes
are the modem’s responses to your
commands. A value of 1 prevents the
sending of codes (Quiet mode), while 0
sends all result codes.

$3=13 The Carriage Return Definition parameter. A
value of 13 defines [M]as the carriage
return character. Upon encountering a
carriage return character, the modem
executes the current command.
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$7=15 The Timing parameter. A value of 15 sets 15
seconds as the time ECM waits after dialing
before it breaks the connection.

T The Touch-Tone Dialing parameter. T specifies
Touch-Tone dialing. A value of P would set
Pulse dialing. (The pulse dialing speed is
fixed at 10 pulses per second.)

D The command to the modem to dial a
number. (Being a new command, you must
precede it with an attention code.)

When the Modem Instructions contain multiple commands,
you must end the first command with a carriage return
character and immediately begin the next command with
an attention code (with no intervening space).

The default setting in the Modem Instruction field contains
no command to return the modem to its initial state. If you
have a Hayes compatible modem, you may use Z as the
Reset command. This command returns the modem to its
initial state by establishing the settings specified by the
modem’s switches. It also clears any commands that
remain on the original command line. When the modem
instructions don’t contain a reset command, the modem
waits for the Timing parameter (S?) to expire before it
hangs up.



Filling in the Modem
Menu

If you are using a Hayes compatible modem, ECM
simplifies your work by supplying values that automatically
prepare your modem for dialing. In most cases, these
values should meet your needs. However, if you are using
a different kind of modem or if you decide to change any
of these values, consult the owner’s manual for your
modem for the necessary information.

If you have previously defined values in a Modem menu
for another cardfile, you may reduce your work by getting
these values. See the following section on To get values
from another cardfile.

To enter a dial code:

1. Start from the Modem menu.
2. Move the cursor to a field under Code Name.
3. Type the name for the number you are about to enter.

The name may contain a maximum of 16 characters,
and you may use any character within the name.

4. Move the cursor to the Substitution Numbers field
on that line.
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5.

Type the actual number you want ECM to use.

If this number contains any special characters, or
references to other dial codes, you must enclose this
information between slash characters.

The substitution number may contain references to other
dial codes as long as the codes don't refer to themselves.

6.

To define another dial code, repeat steps 2 to 5.

To enter special modem information:

1.

(@Y Prcvious Choice RO Next Choice RUSIIENNTREINS
port and baud rate that your modem uses.

The default setting is COM1-300 baud. (See the
owner’s manual for your modem modem if you want
to change this value.)

Type the special instructions that your modem needs
to place a call.

You may include a set-up string that prepares your
modem for dialing, an exclamation point (!) that
represents the number to be called, and a take-down
string that returns the modem to its initial state. Any
one of these parts may contain 40 dialable characters,
but the total length must be 50 characters or less.



To get values from another cardfile:

If you have previously defined values in a Modem menu
for another cardfile, you may reduce your work by reading
these values into the current menu.

1. Start from the Modem menu.

2. Choose XXM

ECM requests the name of the cardfile that contains .
the Modem menu information you want to use.

3. Enter the full cardfile name.

You may switch discs if that cardfile is not presently
on your system. (The original disc must be returned
to the drive when you are finished.)

4. Pressing ends the name and directs ECM to
continue.

If ECM finds the cardfile, it places the values from
the Modem menu of the specified cardfile into the
corresponding fields on your display.

If ECM fails to find the cardfile, it notifies you that:
The cardfile could not be found-

Press to clear the message and then verify that
you are using the correct disc and providing the
proper pathname and cardfile name.

5. You may now modify these values or define
additional values.

6. When you are satisfied with the menu, choose

 Save values |
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If you change your mind:

If you have modified the Modem menu and subsequently
decide against keeping these values, you may return to the
Main menu without saving your changes.

1. Choose [EGEFEN.

As ECM will discard the information you have
entered, it asks for confirmation:

Last changes will be lost. Press "Yes"”
to confirm.

2. If you decide to keep the changes, choose [N

ECM returns to the Modem menu where you may
continue your work or choose another task.

3. Choosing discards the information.
ECM displays the Main menu.

To save the information in the Modem menu:

1. Ensure that the information you have entered is
correct.

2. Choose TN

ECM saves the Modem menu and stores this
information with the current cardfile.
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Placing a Phone
Call

Using the Autodial
Field

You can use the Autodial facility from either the Main
menu or the Select menu.

Before you attempt to dial a number, however, ensure that:

B you have properly connected the modem to your
computer

B you have properly connected the modem to your
telephone line

# you have turned the modem on

You may place a phone call from the Main menu when
your card form contains an Autodial field. However, if you
must read an extension number to complete the call and
the Autodial field does not appear in the open-card
position, you should follow the next procedure to display
the card on the Select menu.
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To use the Autodial field:

1.
2.

Start from the Main menu.

Get the cardfile that contains the number you want to
dial.

Move the appropriate card into the open-card
position.

Choose [ETETIEINIA .

ECM displays the message:
Telephone call in progress. When the
connection is made. press ENTER.

If your modem has a speaker, you should hear ECM
dialing the number. If you hear nothing, check that
the volume on the modem is turned up.

If you use a Hayes-compatible modem that does not have a
speaker, you won't hear the dial tones, dialing, or ringing.

5. If you decide that you don't want to complete the call,

choose [NETIESN.

When the Modem Instructions contain a reset
command, ECM sends this command to the modem.
Otherwise, the time specified in the Timing parameter
is allowed to expire.



6. After ECM has dialed the number, pick up the phone
and wait for an answer.

If you fail to pick up the phone within the specified
time (normally 15 seconds), ECM automatically hangs
up for you.

Caution Be sure to pick up the phone before ECM breaks the
connection. If you want a longer time delay, change the value
for s7 in the Modem menu’s Modem Instructions field.

7. After the connection is made, press [Ener].

If your Modem Instructions contain any commands
after the Dial command, ECM sends this command to
the modem; and you control the phone call from your
telephone receiver.

Using Autodial 16-15



Personally Choosing  Since a card can contain several telephone fields, you
the Phone Field sometimes want to call a number other than the number in
the Autodial field. Or, the card form may contain
telephone fields but no Autodial field. In either event, you
must access the Select menu to dial the number.

To choose a phone field:

1. Start from the Main menu.

2. Get the cardfile that contains the number you want to
dial.

3. Move the appropriate card into the open-card
position.

4. Press the key.
ECM displays this card on the Select menu.

If your personal computer supports HP Touch or a mouse,
you may use these pointing devices to display a card by
choosing that card’s tab.

5. Choose XTI

ECM highlights the Autodial field (if one exists) and
asks you to:

Select the field to dial then choose
"Dial Phone™ again.
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6. Move the cursor to the appropriate telephone field.
ECM highlights this field.
7. If you decide that you don’t wait to place the call,

choose IETHESH.

ECM cancels your request and returns to the Select
menu.

8. Choose to instruct ECM to place the call.
ECM notifies you that the call is in progress.

The remaining options and steps for completing a call are
identical to the steps listed under Using the Autodial
Field.
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Printing Reports, Mailing Labels
and Form Letters

You can print the information in a cardfile in a variety of
ways. You can print an exact replica of each card, just as
ECM displays it, by choosing on the Select
menu. (Refer to Printing a Card in Chapter 13 for these
instructions.) For greater flexibility, you can create a print
format that prints the cardfile information in a specific way.
This chapter tells you how to create and use print formats.

You create a print format from the fields in a particular
cardfile or workset. First you choose the cardfile fields you
want to print. Then you build the print format much as
you built the cardfile’s card form. You can:

& Arrahge the fields in any order, using the fields that are
found on the card form.

B Add text, using your computer’s text-editing keys.

B Choose whether to print a report, mailing labels, or
form letters.

B Choose other options such as printing headings, or
perform certain mathematical calculations such as
computing sums or averages.
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As a print format can be 255 lines long, you may roll the
print format by pressing the key to turn the scrolling
function on. Press the [2]key to roll the print format up,
and the [v]key to roll the print format down. Additionally,
because the print format can be 255 characters wide, you
may roll the print format left by pressing the [2] key or
right by pressing the [v] key. Press again to turn

the scrolling function off and return the screen and cursor
to their normal functions.

If your personal computer supports a mouse, you can roll
the format by holding down the left button and moving
the mouse in the direction you want to go.

Because each print format is based on the specific fields of
a particular cardfile, you normally use a print format with
its cardfile, or with a cardfile that uses the same card form.
But you can create any number of print formats for one
cardfile. For example, you could create three distinct print
formats if you regularly print three different styles of
reports from the same cardfile.

The first three sections in this chapter, Printing Reports,
Printing Mailing Labels, and Printing Form Letters
introduce the specific printing features of ECM. The fourth
section, Basic Steps in Printing, gives an overview of
printing. The fifth section, Printing a Full Listing, gives
the steps to create a print format, either by building a new
format or by getting a format that has already been saved.
Be sure to read this section; it gives the foundation for the
detailed information that follows. The remaining sections
describe ECM’s printing features in detail. You probably
won't need all these features, particularly at first; but later
you can build more sophisticated print formats by adding
features to your existing print formats.
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Printing Reports

Printing a Report
in Sections

You can summarize the information in a cardfile by
printing a report. In Report format, ECM prints the
information from a single card across the printed page.
Thus, when a series of cards are printed, the information
for each field appears as a column.

The first steps in creating a print format are described in
Building a Print Format. If you're planning to create a
columnar report, follow the instructions for placing fields
in Report format in that section. Then read the next
section, Adding Text.

Your report may have headings at the top of each page; see
Printing a Heading for this information. Furthermore, if
you want to include the date or page number, see the
section on Printing the Date and Page Number.

You can break a report into sections by starting a new
section whenever the information in a key field changes.
For example, you could sort the IMPORTS cardfile using
the Country field and then begin a new page when the
entry in the Country field changes to break the report into
sections by country.

Chapter 15 describes sorting a cardfile. The procedure for

printing a report in sections appears in Breaking a Report
into Sections in this chapter.
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Accumulating  You can calculate the sum or average of all the values in a
Statistics  given field and print each value or only print the accumu-
lated sum or average. You may also print a count of how
many cards are in each section. You could also choose to
print values right-justified, which is useful for printing
numbers in columns. Instructions appear in Printing Sums,
Averages, and Counts.

Printing Wide Reports  To print a wide report on a regular-sized printer, ECM first
prints columns 1 through 80 of the entire report, then
columns 81 through 160 of the entire report, and so on.
You can tape together these side pages to produce the full- .
width final report.
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Printing Mailing
Labels

Printing Form
Letters

You can print mailing labels by listing the name and
address fields from different cards. First read Building a
Print Format and Adding Text. Then to properly position
the names and addresses on sheets of mailing labels, read
Positioning Printed Output on the Page.

You can use ECM to produce form letters by typing the
text of the letter and including the appropriate fields where
information from a cardfile is needed. Read Building a
Print Format and Adding Text for these necessary details.
(When you are building the print format, remember to
choose INTTSETIEIA. ) Then to start each letter on a new
page, read Breaking a Report into Sections and treat each
letter as a section. Then print your cardfile. ECM
automatically shifts the text to compensate for any leading
or trailing blanks in a field.
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Basic Steps in
Printing

Choose the Cards
To Print

Sort the Cards

This section summarizes the steps in printing the
information in a cardfile. The next section, Printing a Full
Listing, gives you step-by-step instructions for these tasks.
Remember, you can ignore any options you don’t need.

Begin by displaying the cardfile or workset that you want
to print on the Main menu. When you just want to print a
few consecutive cards, scroll the cardfile until the first card
to print is in the open-card position. When you want to
print cards that are scattered throughout a cardfile, use the
Find menu to mark these cards and create a workset (see
Chapter 14). If you create a print format before you make
the necessary workset, you must save the print format,
return to the Main menu, create the workset, and then
print information from that workset using the saved
format.

When you want to print the cards in a different order than
they appear in the Main menu, use the Sort menu to
create a workset that arranges the cards in that order.
(Instructions for using the Sort menu appear in chapter 9.)
This is most useful for printing reports, where you can
break the report into sections according to the new key
fields.

You should normally resort a cardfile so its key fields
correspond to the key fields of the print format you are
using.
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Choose the Print
Format

You can use an existing print format, adapt an existing
print format, or create an entirely new print format. To use
or adapt an existing print format, you simply specify its file
name. If no changes are necessary, you can proceed
directly to choosing the output device.

To create a print format:

Begin by choosing from the Main

menu.

Use the Get Fields menu to choose fields from the
cardfile and place them on the print format.

Use the Adjust Field menu to arrange the fields as you
want them to appear on the print format.

Add any necessary text to the print format.

Use the Adjust Block menu to adjust the size of the
repeat block. The repeat block is a part of the print format
which is printed for each card. By enlarging the repeat
block, you can precisely define the white space between
printed cards (useful for mailing labels). By excluding
text and fields at the top of the print format from the
repeat block, you can define headings to be printed at
the top of each page (useful for reports).

Use the Break Options menu to identify special fields
(useful for reports). As ECM prints, it can calculate the
sum or average of values in a field, or it can count the
number of cards that have a value in a particular field.
ECM can also right-justify the values in a field when it
prints that information.
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B Use the Set Breaks menu to break a report into sections.
At each new section, you can print sums, averages, and
counts or start a new page.

#® Use the Printer Setup menu to describe how the printed
page should appear. (See the last section in this chapter
for these instructions.) You may also use the Printer
Setup menu to specify whether to print the date and
page number on each page (useful for reports) and
whether to print cards one beside another on the page
(useful for mailing labels).

Choose the Output  Use the Print Options menu to choose where to send the
Device printed output. Normally, you'll send the output to your
printer. However, if you want to test a new print format,
you can send the output to your display. You can also send
the output to a file, and store it on a disc to print later or
to transmit via a modem.

Print!  With all the preparation done, you can now print the
entire cardfile (or workset), or you can print cards one at a
time.

After you've successfully created a new print format, be
sure to save it on a disc.
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Printing a Full
Listing

Creating a New
Print Format

This section describes two procedures that you could use
to print a full listing of a cardfile. The first procedure
creates a new print format and saves it as a disc file; the
second procedure gets a saved format and prints a listing
using that format. While you may never print a cardfile
that uses such a simple format, these procedures show
how easy it is to build a print format and print a cardfile
using that format.

This section assumes that you have a printer connected to
your computer and that the printer is ready to use. If you
need help connecting your printer, refer to the manuals for
your computer and the printer. If you need help
configuring your printer, refer to those manuals and to
Chapter 16 in this manual.

The following procedures give the necessary steps to create
a new print format, print it, and save it.
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To display the Print menu:

1. Start from the Main menu.
2. Get the cardfile that you want to print.

3. If you used the Cardfile Tasks menu to get another
cardfile, choose to return to the Main

menu.
4. Choose

SR to display the Print menu:

Print

(.

xecutive Card Manager

To buiid a print format:
The initial Print menu is mostly blank as you haven't

specified or created a print format. The following steps tell
you how to create a new print format.
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1. Choose

ECM displays the Get Fields menu, which shows the
card form with the fields consecutively numbered:

/ \

##% [MPORTS CARDFILE *w#

Company

Agent’s Name
Telephone

Next Contact (YY/MM/DD)
Street Address
City

Country

Card Last Updated

Specialties

Now you choose which fields in the card form you
want to appear in the print format.
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2. Choose ISTREIEITE.

ECM lists all the fields, in the order they appear on
the form, at the top of the Get Fields menu after
Selected Fields:. If the list contains more fields
than ECM can display at one time, you can press

to turn the scrolling function on, then press
the (2] or [v] keys to bring different parts of the list
into view. Press when you are done to turn the
scrolling function off (the indicator light turns
off).

The asterisk that appears in [[EITTRIISEIAN indicates
that ECM will place the chosen fields in Label format
rather than Report format.

3. Choose to place the print format on the
Print menu:

Executive Card Manager PRINT Cardfile:
‘Het A forma

A:\IMPORTS
6 1
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To print a full listing:

Your print format now includes all the fields in the cardfile,
in the order they appear on the card form. If you want to
rearrange the fields or add text, or add other ECM printing
features to your print format, you would do so now. But
this simple print format is all that’s needed for a full listing
of a cardfile. (Before you save your print format, you
should test it to be sure it is working as you intended.)

1. Choose [EEETETTIR to display the Print Options
menu:

L“ W,

As an asterisk marks the [ EEEEE label, the
output will go to your printer rather than to a file or
to the display.
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2. Choose IS

ECM prints the card that currently appears in the
open-card position. If you're satisfied with the result,
go on to the next step. If you're dissatisfied, you can
return to the Print menu and make the necessary
improvements,

3. Choose EITEYSRIrA -
ECM prints the entire cardfile.

4. Choose IR .
ECM displays the Print menu.
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To save the print format:

Once you are satisfied with the printout of your cardfile,
you should save the print format so you can use it again.

1. Choose [EETATIEEN.
ECM asks you to:
Type file name and press ENTER.

2. Type the name you want to give the new print
format.

Remember to provide the proper pathname.
3. Press [Enter].

ECM saves the print format in a file with that full file
name.

ﬁﬁ Since ECM allows you to specify several print formats for a

%ﬁ% cardfile, you may find it helpful to create a cardfile that has
fields for a cardfile’s name, the names of the files that
contain print formats that apply to that cardfile, and
comment lines that describe the different formats.

4. Choose IHGEFRN.

ECM returns to the Main menu.
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Using an Existing  The following procedure describes using a print format that
Print Format  vou have previously saved as a file. Once you have saved a

print format for a cardfile, you may find it easier to modify

that format rather than creating a new format from scratch.

To display the Print menu:

1. Start from the Main menu.
2. Get the cardfile you want to print.

3. If you used the Cardfile Tasks menu to get another
cardfile, choose to return to the Main
menu.

4. Choose [IITIREIITIICE.
ECM displays the Print menu.

To get a print format:
1. Choose 3TN
ECM asks you to:
Type file name and press ENTER-

2. Type the full name of the file that holds your print
format.

Be sure the file you're getting contains a print format
that corresponds to the current cardfile.
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3.

Press [Enter |.

ECM displays the requested print format. If you want
to modify this format, you would do so now. You
could then save the new version using a new name,
to have a choice of print formats; or you could save
the new version using the same name, to replace the
original version.

If the print format has a different ordering of key
tields than the cardfile you are using, ECM suggests
that you resort the cardfile to match these keys.

Therefore, you should return to the ECM Main menu,
use the Sort menu to create a workset with the
appropriate key fields, then return to the Print menu
to print the cardfile using that format.

To print a full listing:

In this procedure, you simply print a cardfile using an
existing format. Under these conditions, you might print
the cardfile without testing it first.

1.

3.
4,

(@UILEEY print 0ptions
ECM displays the Print Options menu, and an
asterisk appears in the label.

Choose [T TE .

ECM prints the information from the cardfile, using
the instructions in the print format.

If you don’t want to print anything else, you can now
leave the Print Options menu.

Choose to return to the Print menu.
Choose QRN to return to the Main menu.
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Building a Print Building a print format involves two tasks:

Format First, using the Get Fields menu, you choose what fields
will be placed on the print format and in which order. You
then place these fields on the Print menu either in Label
format (where fields from each line on the card form go on
separate lines in the print format) or in Report format
(where as many fields as possible are placed on a line,
which can be 255 characters wide).

Second, after placing the fields on the Print menu, you can
use the Adjust Fields menu to rearrange fields, make fields
larger or smaller, or delete fields. You can also return to the
Get Fields menu and get other fields, including additional
copies of fields that already appear on the print format.

Getting Fields  When you want to print a few fields, or when you want
fields printed in a different order than they appear on the
card form, you can individually choose the fields you want
to print.

The following procedures assume that you are presently
E working with the cardfile that you want to print.
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To select fields one at a time:

1.
2.

Start from the Print menu.

Choose FEEFTSERN-
ECM displays the card form on the Get Fields menu.

Move the cursor to the first field you want to place on
the print format.

Choose B0l .

ECM writes the number for this field as the first of
the Selected Fields.

Repeat steps 3 and 4 for each additional field you
want on the print format, in the order you want them
to appear.

A print format can contain several copies of a single
field, but since you can select a field only once each
time you display the Get Fields menu, you must take
these additional steps:

If you attempt to choose a field that has already been
selected, ECM informs you:

This field has been selected already-
Place these fields. then come back and
select more.

Choose TGS

ECM places the currently selected fields on the Print
menu.
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8. Choose IS .

ECM displays a new version of the Get Fields menu,
where no fields have been selected.

9. Move the cursor to the field you want to include
again on the print format.
10. Choose [NSTEISEN .

ECM lists this field as a selected field. (Then when

you finish choosing fields and place these fields on

the Print menu, the print format has two entries for
the repeated field.)

To remove a field from the list of selected fields:

1. Move the cursor to the field you want to remove.

2. Choose TIINIOT -

ECM removes that field from the list of selected
fields.

3. If you decide you want to start over, choose
Unselect All Flds M

ECM removes all the fields from the list of chosen
fields.
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Choosing between  After you have chosen the appropriate fields on the Get
Label or Report Fields menu, you place the fields on the Print menu.
Format 'hen placing the fields, you can instruct ECM to use
either Label format or Report format.

You would use Label format when you want to print
mailing labels or form letters. Label format resembles the
card form as fields on the same line in the card form are
placed on the same line in the print format, while fields on
different lines in the card form are placed on different lines
in the print format.

You would use Report format when you want to print
columnar reports. For Report format, ECM places as many
tields as possible on a 255 character line, regardless of the
position of the fields on the card form.

Label and Report format also differ in the way information
in a field appears on the printed page:

B When you choose Label format, ECM prints only the
information in a field and any extraneous leading or
trailing spaces in that field are ignored. Fields and text
to the right of the printed field are moved to the left
accordingly. For example, a print format for mailing
labels can have fields for First Name and Last Name
with a single space between them; and ECM will print
the names with a single space between them, regardless
of the number of characters in the First Name field.

B When you choose Report format, ECM prints the
information with enough spaces to fill the field. The
positions of fields and text to the right of a printed field
are unaffected by the length of each entry. This format
generates a columnar report.

Printing Reports, Mailing Labels, and Form Letters 17-21



To place fields in Label format:

1. If no asterisk appears in [[ETSSETIENE, choose
[ Lapel Format B

2. Choose EIITEIITE .

ECM displays the selected fields in Label format on
the Print menu.

To place fields in Report format:

1. If no asterisk appears in TSI, choose
| Report Fornat B

2. Choose [EFTTEISEHE .

ECM displays the selected fields in Report format on
the Print menu.

As you may make several calls to the Get Fields menu
when you are building a print format, you can place some
fields using Label format and then place other fields using
Report format. Either format gives an initial layout to the
fields, which you may then modify as you wish. When
you actually print the information from a cardfile, ECM
uses the format that you selected last.
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Adjusting a Field’s  You can move a field anywhere on the print format. The
Location only restriction is that fields can’t overlap.

You may move a field as part of a text-editing operation by
using your computer’s text-editing keys (see the section on
Adding Text). However, these operations don’t change the
order of the fields on the print format. When you want to
move a field past other fields or text, or move a field
without otherwise altering the print format, use the
following procedure.

To move a field:

1. Display the print format on the Print menu. (See
Building a Print Format for these steps.)

2. Move the cursor to the field you want to relocate.
3. Choose to display the Adjust Field

menu:
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L

4. Use the cursor-control keys to move the field to its
new location.

__J

When that location doesn’t appear on the display,
pressing and the appropriate cursor-control
key, or the [P Up | and [Py Dn | keys, exposes different
parts of the print format.

If your personal computer supports a mouse, you may
move a field to a new location by placing the pointer in
that field, holding down the left button and moving the
field to its new location, and then releasing the left button.

5. Choose EIRTERN.

ECM saves the changes and returns to the Print
menu.
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Adjusting the Size of
a Field

When you create a card form, you set aside enough space
to accommodate the largest entry that a field might
contain. Before you print the information from a field, you
might want to change the size of that field.

To change the size of a field:

1.
2.
3.

Display the print format on the Print menu.

Move the cursor to the appropriate field.

Choose EFFIETIIEN.
ECM displays the Adjust Field menu.

Choose the appropriate key:

&8 To shorten the field without affecting the rest of
the line, choose [ NSETGTE.

# To shorten the field and move the rest of the line
to the left, press the key.

® To widen the field without affecting the rest of the
line, choose [MEREEIICE.

8 To widen the field and move the rest of the line to
the right, press the key and then choose
FREXENPE. After you set aside the necessary
space, press the key to take your computer
out of Insert Character mode.

Choose FIHTEINI.

ECM saves your changes and returns to the Print

menu.
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Removing a Field If you have chosen a field on the Get Fields menu and
included that field as part of the print format, you may
remove the field if you decide you don’t want to print this
information after all.

Jo remove a field:

1. Display the print format on the Print menu.
2. Move the cursor to the appropriate field.

3. Choose IXFIERICN.
ECM displays the Adjust Field menu.

4. Choose BT

ECM removes that field and returns to the Print
menu.
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Adding Text

You can add text anywhere on the print format. The only
restriction is that you can’t place text over a field. If you
want to move fields to make room for text, you can:

# Use + [Jto push a field (and the rest of the print
format) down one line.

# Use Insert Character mode to push a field (and the rest
of the line) to the right as you type characters.

To add text:

1. Display the print format on the Print menu.
(See Building a Print Format for these steps.)
2. Move the cursor to where you want the text to begin.

3. Press the + [ keys or the [ins] key, if necessary,
to create room for the text.
4. Type the text.
While typing text, you may use your computer’s other

text-editing keys, such as [DeL], + [L], and
+ [o].

The + [L]keys only delete text from a line while the
+ [o] keys only work when no fields occur on that
line.
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Printing Headings

The simplest heading you can print includes just the date.
ECM can print such a heading automatically, as described
in Printing the Date and Page Number. For custom
headings, you can add text and fields at the top of a print
format. ECM then prints this heading at the top of every

page.

Each print format contains a repeat block. The repeat block
is the part of the print format which is printed for each
card. The text and fields above the repeat block will be
printed only at the top of a page, not for every card.
(When you're printing cards side-by-side across the page,
the heading is printed for every card that is printed at the
top of the page.)

You can direct ECM to begin a new page and print a
heading whenever the value of a key field changes. For
instructions, refer to Breaking a Report into Sections.

17-28 Printing Reports, Mailing Labels, and Form Letters



To print text in the heading:

1. Display the print format on the Print menu.
(See Building a Print Format for these steps.)
2. Move the cursor to the top of the print format.

3. Press the + [1] keys to create space to the top
of the print format.

Add as many blank lines as you want for the
heading.

4. Type the text you want to appear in the heading.

You can use your computer’s text-editing keys, such as

[ ], [oEC], [at] + [L], and [at] + [o].

When you add text at the top of a print format, this text is
automatically above the repeat block and will be printed as
a heading. However, when you add fields at the top of a
print format, ECM automatically includes these fields in
the repeat block. You must therefore change the size of the
repeat block to exclude these fields if you want the fields
to appear in the heading.

The following procedure describes how you can move the
top edge for the repeat block to include fields in a
heading. Also see the section Changing the Size of the
Repeat Block for more information on adjusting the size of
the repeat block.
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To print fields in the heading:

1. Display the print format on the Print menu.
(See Building a Print Format for these steps.)
2. Make sure there’s room at the top of the print format.

If you haven't already created a heading area at the
top (see the previous procedure), use + [[to
add blank lines at the top of the print format.

Now you can exclude fields from the repeat block.
3. Choose

ECM displays the current repeat block for your print
format.

Adiust Rpt Elk

Cardfile: A: \IHPQRTS
fess "Hafiod Bigek R B Cth
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4, Choose until the top edge of the
repeat block is below the text and fields you want to
appear in the heading.

5. If you overshoot your mark, choose to
position the top edge correctly.

6. Choose B Changes R

ECM incorporates the new repeat block size into the
print format and returns to the Print menu.
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Printing Sums,
Averages, and
Counts

ECM provides several features that facilitate the printing of
numeric reports. For example, you can print the sum or
average of values in a numeric field, print only the
accumulated statistics, print a count of the number of cards
printed, and print information right-justified.

You can direct ECM to print sums, averages, and counts
whenever the value of a key field changes. For instructions,
refer to Breaking a Report into Sections. When ECM prints
these statistics, it indicates whether the statistics are
subtotals (at the end of a section) or grand totals (at the
end of the cardfile), and it labels each type of statistic.

To identify a break option field:

1. Display the print format on the Print menu. (See
Building a Print Format for these steps.)

2. Choose to display the Break Options
menu:
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Executive Card Manager

PRINT: BREAK OPTIONS Cardfile: A:\IMPORTS\
s

Move the cursor to a field that you want to designate
as a special break field.

Choose the appropriate function label:

B To accumulate the sum of individual entries for the

field, choose INEJEISEN- The letter S appears in
that field.

B To accumulate a count of the number of cards with

an entry in that field, choose JHIETZSCE. The
letter € appears in that field.

® To accumulate the average of individual entries for

the field, choose INTEFTERIER. The letter A
appears in that field.

& If you want the column of values to be right-

justified, choose TTIRINIEERTE. The letter R
appears in that field.
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® If you want to print only the accumulated values,

choose [FEMEIEIEN. The letter H appears in that
field.

If you change your mind, you may move the cursor tc
the appropriate field and choose that option again.
That is, these function labels act like on/off switches.
When a field doesn't have that particular attribute,
choosing the appropriate label selects it. However, if a
field does have that attribute, choosing that label
cancels it.

You may choose any combination of break options for each
field. For example, you may choose and

if you just want to print the accumulated
total for that field when a break occurs.

5. Repeat steps 3 and 4 for any other fields you want to
define.

6. Choose TSI

ECM sets these break options and returns to the Print
menu. Note that the letters indicating the special
fields (S, ¢, A, R, or H) now appear in the print
format.

Caution When you perform mathematical calculations, be sure that the
w designated field can hold the calculated value. If a field is too
small to hold this value, ECM truncates the least significant
digits.

17-34 Printing Reports, Mailing Labels, and Form Letters



Breaking a
Report into
Sections

You can print a report in sections; for example, you can
print subtotals when a section ends, or you can start a
section at the top of a new page. You break a report into
sections by identifying key fields that correspond to the
sections you want. (Remember, key fields determine the
order in which cards appear in a cardfile.) In addition, you
can identify a key field as a break field. As ECM prints a
cardfile, it remembers the information in a break field from
one card to the next. When the information in a break field
changes, ECM ends the old section with the previous card
and begins the new section with the current card.

You can set one, two, or all three of a cardfile’s key fields
to be break fields. For each break field you specify what
happens during that break: that is, should ECM print
subtotals, start a new page, or both. While break fields
determine when a break occurs, you may designate any of
the fields on the print format to be break action fields. (The
break action fields are the fields that you assigned special
attributes, such as Sum or Count fields, in the Break
Options menu.) The subtotals for each break action field
are independent of the subtotals for other break action
fields. The different combinations of break fields and break
actions allow you to design several types of reports.

As an example, suppose that a parent company has a
cardfile of the orders and sales of individual sales persons
within their subsidiary companies. The cardfile might use
the Company field as the primary key field (K1), the Sales
Person field as the secondary key field (k2), and the
Month as the tertiary key field (K3).
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To print a sales report, you could identify break fields and
break actions as follows:

® Identify the primary key field (Company), the secondary
key field (Sales Person), and the tertiary key field
(Month) as break fields to print subtotals.

® Identify the Orders and Sales fields as Sum and Right-
justified break action fields.

The last page of the report, which automatically contains a
grand total of the sum fields, might look like this:

= w = SALES LISTING » = & &

SalesPerson Month Orders Sales
A, Broun fFebruary 456 15,550.00
A. Brown February 34 2,345.00
Subtotals for: February

Sum: 490.0 17,895.00
A. Brown March 345 12,346.00
Subtotals for: March

Sum: 345.0 12,346.00

Subtotals far: A. 8rown

Sum: 835.0 30,241.00
B. Jones February 345 6,760.00
B. Jones February 123 3,567.00
Subtotals for: february

Sum: 46B8.0 10,327.00
B. Jones March 456 12,000.00
Subtotals fer: March

Sum: 456.0  12,000.00

Subtotals for: B. Jones
Sum: 924.0 22,327.00

Subtotals for: Hewlett-Packard
Sum: 1,759 52,568.00

Grand Totals:
Sum: 1,759  52,568.00
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Because a cardfile’s key fields determine what fields may
be break fields, if your cardfile isn't sorted in the order you
want to print the cards, use the Sort menu to create the

necessary workset. You can then use the new key fields as
break fields.

For example, suppose you want to print the IMPORTS
cardfile in sections by country. You would use the Sort
menu to identify the Country field as the primary key
tield. Then, in the print format, you would identify the
Country field as a break field to start a new page. (By
placing a copy of the Country field in the heading, you can
print the section title at the top of each page. Refer to
Defining Page Headings for these instructions.)
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Setting Break Fields  You set break fields by using the Set Breaks menu to direct
ECM what action it should take when a key field changes.

1. Display the print format on the Print menu. (See
Building a Print Format for these steps.)

2. Choose to display the Break Options
menu.
3. Choose to display the Set Breaks menu:

PRINT: SET

__Cardfile

: \IMPORTS

Field Print Start a

Number Subtotals? New Page?
Ist Key Field LoNg
2nd Key Field NO NO
3rd Key Field NO NO

\ >

There are three rows, one row for each possible key field
(Ist, 2nd, and 3rd). The first column, Field Number,
shows which field on the print format corresponds to that
key field. An entry of 0 indicates that no key field with the
corresponding value appears on the card form. The second
and third columns specify which break actions you want to
take for that key field.
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To print subtotals:

Take these steps if you want to print a subtotal when the
value of a key field changes.

1. Move the cursor to the proper row under Print
Subtotals? for the key field you want to use.

2. Choose to direct ECM to print subtotals when
the value in that key field changes.

3. Repeat steps 1 and 2 for any other values in this
column that you want to change.

To start a new page:

Take these steps if you want ECM to start a new page
when the value of a key field changes.

1. Move the cursor to the proper row under Start a
New Page? for the key field you want to use.

2. Choose to direct ECM to start a new page when
the value in that key field changes.

3. Repeat steps 1 and 2 for any other values in this
column that you want to change.
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To return to the Print menu:

After you have given ECM the necessary break
instructions, you can return to the Print menu.

1. Choose [EIEITTEINN.
ECM displays the Break Options menu.

2. Choose EXHTEIEM.

ECM returns to the Print menu.

Printing the Date ECM can automatically print the date at the top of each
and Page page and the page number at the bottom. You can choose

either or both options by changing values in the Printer
Number Setup menu. Note that these options are distinct from the
headings you define yourself, which were described in
Printing Headings. The following procedure shows how to
get to the Printer Setup menu and change the values for
the Print Date and Print Page Number fields.

To print the date and page number on each page:

1. Display the print format on the Print menu. (See
Building a Print Format for these steps.)

2. Choose to display the Printer Setup
menu:
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Executive Card Manager PRINT: PRINTER SETUP Cardfile: A:\IMPORTS

Top Margi
Bottom Margi

Left Margin
Right Margin

Printer ¥

Auto Feed
Compress Print

Print Width

Lines Per Page Lines Per Inch

Printer Setup String

Print Blocks Across Page
Print Date
Print Page Numbers

Lines Per Card (Select Screen Only)

3. Move the cursor to the field for Print Date.

4. Choose IEEEIM if necessary, to change the value
of the field from N0 to YES.

5. Move the cursor to the field for Print Page Number.

6. Choose , if necessary, to change the value
of the field from N0 to YES.

7. Choose

These values are now your standard values when you
work with ECM.

8. Choose to display the Print Options
menu.

9. Choose to display the Print menu.

Next Value
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Positioning
Printed Output
on the Page

Adjusting the Size of
the Repeat Block

Each print format has a repeat block, which is the part of
the print format that is printed for each card. By enlarging
the repeat block beyond the fields and text you've already
placed on the print format, you can add white space
between printed cards to position the printed information
precisely on a page.

For example, you might want to print an 8.5 by 11 sheet of
mailing labels. Suppose that the overall size of each
mailing label is 21 characters by 6 lines. (The usable part of
each mailing label may be smaller.) By matching the print
format’s repeat block to the overall size of the mailing
label, you can correctly position the name and address on
each mailing label.

The following procedure allows you to change both the
width and depth of the repeat block. Changing the depth
of the repeat block is all that’s required to control vertical
spacing between printed cards. However, to print cards
across the page, as in the example of mailing labels, you
must change not only the width of the repeat block but
also the value of the Print Blocks Across Page field in
the Printer Setup menu. (Refer to the next section on
Printing Blocks Across the Page).
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To change the size of the repeat block:

1.

Display the print format on the Print menu.
(See Building a Print Format for these steps.)

Choose IS .

ECM displays the currently defined repeat block for
your print format.

Choose | ITTICITD

ECM moves the cursor to the last column in the print
format that contains a field or any text.

Move the cursor to where you want the right edge of
the repeat block.

Choose | TN

ECM moves the cursor to the last row in the print
format that contains a field or any text.

Move the cursor to where you want the lower edge of
the repeat block.

The above steps position the cursor at the lower-right
corner of the required repeat block.

Choose [ISFITERIM .
ECM adjusts the repeat block to that size.

Choose |YE Changes P

ECM incorporates the new repeat block size into the
print format and returns to the Print menu.
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Printing Blocks  You can print small print formats, such as mailing labels,
Across the Page  side by side across the page. The width of the repeat
block, multiplied by the number of print formats, cannot
exceed the value of Print Width in the Printer Setup
menu.

You cannot print side pages when you're printing multiple
blocks across a page.

To print blocks across the page:

1. Display the print format on the Print menu.
2. Choose to display the Print Options

menu.
3. Choose to display the Printer Setup
menu:
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Print Blocks Across Page

Executive Card Mana
A oiielensin

Printer

Top Margin
Bottom Margin
Left Margin
Right Margin

Auto Feed
Compress Print

Print Width

Lines Per Page Lines Per Inch

Printer Setup String

Print Date
Print Page Numbers

Lines Per Card {Select Screen Only)

Move the cursor to the field for Print Blocks
Across Page.

Choose repeatedly, until the field shows
the correct number of cards to be printed across the

page.
If you overshoot the number you want, choose

These values are now your standard values when you
work with ECM.

Choose [ZEENTTRIEM to display the Print Options
menu.

Choose [ to display the Print menu.
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Using the Printer The previous sections described some special uses of the
Printer Setup menu. This menu contains other fields that

Setup Menu also determine how ECM formats a document. By knowing
what features the different fields govern, you may change
the values in certain fields to produce a specific format. To
change these values requires your accessing the Printer
Setup menu.

To display the Printer Setup menu:

1. Start from the Main menu.

2. Choose SIS .
3. Choose [EIEE Options M
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4. Choose
menu:

to display the Printer Setup

Cardfile: A:\IMPORTS

Top Margin
Bottom Margin
Left Margin
Right Margin .

Printer [aserdesyLpry

Auto Feed | YES

Compress Print @ WO

Print Width

Lines Per Page Lines Per Inch

Printer Setup String |

Print Blocks Across Page
Print Date | KO

Print Page Numbers

Lines Per Card a8 (Select Screen Only)

L . a als = k"J

This figure shows the values that ECM normally uses for
each field.
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Making Changes t0  ECM establishes values for each of the fields in the Printer
the Printer Setup  Setup menu. Except for the Printer Setup String field,
Menu  €ach of the remaining fields has a list of permissible
values. You may cycle through these values by choosing

ST or IENIEETIA. (For the Printer Setup

String, you must type the appropriate information into

this field.)

The following list summarizes the fields in the Printer
Setup menu and gives your available choices. Consult this
list when you want to change one of these values.

Parameter

Top Margin

Bottom Margin

Left Margin

Right Margin

Print Width

Meaning

The number of blank lines at the top
of each page. Initially this value is set
to 0, leaving no blank lines at the top
of the page.

The number of blank lines at the
bottom of each page. Initially this
value is set to 0, leaving no blank
lines at the bottom of the page.

The number of spaces to indent from
the left edge of the page. Initially this
value is set to 0, leaving no
indentation from the left edge of the

page.

The number of spaces to indent from
the right edge of the page. Initially
this value is set to 0, leaving no
indentation from the right edge of the

page.

The width of the page (as given in
characters or columns). Initially, this
value is set to 80, but it may range
from 1 to 255. The value for this field
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Lines Per Page

Printer Setup
String

Printer

Auto Feed

Compress Print

determines the upper limits for the
left and right margins.

The total number of lines on each
page. Initially, this value is set to bk,
but it may range from 1 to 255. The
value for this field determines the
upper limits for the top and bottom
margins.

An ASCII string that ECM sends to
the printer to prepare it for printing.
For example, you may use this field to
direct your printer to print bold
characters or underline text. (This
setting remains in effect until you
enter another printer setup string or
reset your printer.) As the exact form
of this string varies depending on
which printer you are using, see the
owner’s manual for your printer for
this information.

This field presents you with a list of
all the printers installed on your
system. If the printer you want to use
does not appear in the list, refer to
the instructions for installing a printer
in the booklet Setting Up Executive Card
Manager.

YES for continuous-fed paper; NO for
single-sheet paper. Initially, this value
is set to YES.

This field only applies to HP printers
that support Compress Print. (Other
printers may use the Printer Setup
String field to obtain similar results.)
YES compresses 132 columns of text to
fit into 80 columns while N0 prints 80
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Lines Per Inch

Print Blocks
Across Page

Print Date

Print Page
Numbers

Lines Per Card

columns of text in 80 columns. Initially,
this value is set to N0 to generate normal
print. If you select Compress Print, after
each print operation finishes, ECM
returns the printer to normal print then
reestablishes compress print when the
next print operation is requested.

This field only applies to HP printers
that let you set the vertical pitch.
(Other printers may use the Printer
Setup String field to obtain similar
results.) A value of & prints six lines of
text in a vertical inch while a value of
8 prints eight lines of text in a vertical
inch. Initially, this value is set to b to
generate normal print. If you set this
value to 8, after each print operation
finishes, ECM returns the printer to
normal print then reestablishes the
vertical pitch when the next print
operation is requested.

The number of print blocks to place
on the page. Initially, this value is set
to 1, but it may range to 255.

YES prints the date on each page; No
omits it. Initially, this value is set to
NO.

YES prints a page number on each
page; NO omits them. Initially, this
value is set to NO.

The value in this field is only used in
the Select menu, and it determines
how many lines are printed for each
card. Initially, this value is set to bk,
but it may range from 1 to 255.
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Saving Your Setup
Values

Returning to ECM’s
Standard Values

If you make any changes to the Printer Setup menu, you
should save your values by choosing if you
want to use these values again. When you don't save these
values, the settings remain in effect for the duration of the
current session. Then, the next time you use ECM, ECM
returns to the values that were saved last.

To restore your saved values:

When you save values from the Printer Setup menu, these
values become your standard values. If you make other
changes to the Printer Setup menu and then decide to
return to your previous values before you save the new
values, you may return the menu to your standard values

by choosing [[TTSETITEN.

In this case, ECM sets the values in each field to those
values that you have last stored away.

After you have set new values for the Printer Setup menu,
you may return to ECM’s standard values by choosing

Default Values B

In this case, ECM changes each field in the Printer Setup
menu to a standard value that it provides.
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Copying Techniques

ECM provides three general operations for copying
information. These operations are:

@ Save
B Merge

& Transfer

The first section in this chapter describes the Save and
Merge operations. Chapter 19 describes how to modify a
cardfile which contains information, by transferring the
information to a new card form. Appendix D describes the
more common use of the Transfer operation, which is to
integrate information between ECM and other application
programs.

You may save a cardfile to produce a duplicate copy of that
cardfile, to replace an old cardfile, or to append two
cardfiles to each other. When you replace a cardfile, you
overwrite an existing cardfile with new information. You
may also overwrite the current cardfile with a workset of
that cardfile. (For example, if you used the Sort menu to
rearrange the cards in your cardfile, you may replace the
original cardfile with this workset.) When you append one
cardfile to another, ECM combines the cards from both
cardfiles and places each card in its proper order.

When you merge two cardfiles, you update the information

in one cardfile with changes that were made in another
cardfile.
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Getting to the
Copy Menu

18-2 Copying Techniques

You can copy, replace, combine, or update cardfiles
whether they are on the same disc or on different discs.
This section explains copying operations using one disc.

The second section in this chapter, Copying Cardfiles
Between Discs, gives the procedure for copying cardfiles
between two discs. The techniques in this section provide
ways to back up a cardfile and move a cardfile from a
crowded disc.

If you are using flexible discs, you may eventually fill a
disc with so much information that ECM cannot complete
an operation. The remaining section, Copying Tricks When
Disc Space is Limited, tells you how to copy, transfer, and
combine cardfiles if ECM cannot complete an operation
that takes additional disc space.

Your first step in copying a cardfile is to display the Copy
menu:

1. Start from the Main menu.

2. Get the cardfile that you want to copy.

3. Choose to display the Cardfile Tasks
labels if these labels don’t appear:




4. Choose to display the Copy menu:

Copy Type: Quick Save

Source (car

.

Working with the  Notice that ECM expects you to take three actions:

Copy Menu @ Choose the appropriate copy operation.

@ Provide a file or cardfile name.

@ Choose “Copy” to initiate the copy operation.
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18-4 Copying Techniques

To choose the copy operation:

When the Copy menu appears, the function labels assume
these values:

Five labels provide your choices for the type of copy. These
labels are:

B Quick Save

B Compact Save
® Merge

& Transfer In

& Transfer Out

Quick Save gives an exact file-to-file copy of your cardfile.
It is a faster operation than Compact Save, but it may
waste disc space if you are copying a cardfile that has been
greatly modified.

Compact Save conserves disc space by compacting the
cardfile as much as possible.

Merge updates a master cardfile with new information
from another cardfile that has a similar card form.



Transfer In copies information into an ECM cardfile. (See
Chapter 19 for this procedure.)

Transfer Out copies information from an ECM cardfile (see
Chapter 19).

You may choose the specific copy operation that meets
your needs. After you make your choice, ECM marks that
label with an asterisk. Furthermore, ECM displays the type
of copy operation after the entry for Copy Type:. You may
always refer to this field on the Copy menu to see what
copy operation is in effect.

To provide the file name:
The prompt line also requests a file name.

Notice that on the Copy menu, ECM provides two groups
of lines: one for a Source (card)file; the other for a
Destination (card)file.

All five copy operations use the current cardfile for either
the source or destination cardfile. The actual assignment
depends upon which copy operation you choose. On each
version of the Copy menu, ECM underlines the entry that
contains the current cardfile. You may not change this
value. ECM highlights the other entry with a bright box.
Then, when you enter your response for the file’s name,
ECM displays the name within this box.

For the Quick Save version of the Copy menu, ECM sets
Source (card)file to the current cardfile and underlines
this entry. A box appears under Destination
(card)file. Thus, for the Quick Save screen, ECM
supplies the source cardfile and expects you to enter the
destination cardfile.
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Copying a
Cardfile

Making a Duplicate
Copy

18-6 Copying Techniques

When copying information from a cardfile, you determine
how the copy operation proceeds by your choice of the
name for the cardfile you are creating. If the full cardfile
name you supply is distinct from all other cardfile names,
ECM creates a new cardfile. If the full cardfile name
matches an existing cardfile’s name, ECM allows you to
replace the existing cardfile or to append new cards to it.

You normally duplicate a cardfile as a safeguard against
inadvertently damaging the original copy. If you copy the
cardfile to the same disc, you ensure a copy of the cardfile
as long as that disc remains intact. By copying to another
disc, you ensure the integrity of the cardfile even if
something happens to the original disc. (See Copying
Cardfiles Between Discs in this chapter for the procedure.)

Duplicating a cardfile on the same disc is a straightforward
task. Your major decision is choosing between Quick Save
and Compact Save.



To make a duplicate copy:

1. Start from the Copy menu.

2. Choose if you want a file-to-file copy of
the cardfile or if you want to produce
the most space-efficient version of the cardfile.

ECM marks that label with an asterisk and displays
Quick Save or Compact Save for the Copy Type.

3. Type a name for the cardfile you are creating.

ECM displays the cardfile’s name in the box under
Destination (card)file:.

4. Verify that the name is correct.

When you are creating a duplicate cardfile, the full
cardfile name must be distinct from all other cardfile
names. Therefore, provide a distinct cardfile name, or
give a different pathname if you want to use the same
cardfile name in another directory.

If you are uncertain which cardfiles appear in a directory,
you may choose for help.
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The next step begins the copy operation. If ECM discovers
that the name you supplied already exists, it updates the
function labels so you may append to the current cardfile,
replace the current cardfile, or cancel the operation. If this
happens, choose and provide a distinct name for
the new cardfile.

5. Choose to initiate the copy procedure.
ECM informs you it is:
Copying current cardfile to disc.

6. If you decide to cancel the operation at this time,
choose 1T

ECM cancels the operation and deletes the partial
cardfile. The original cardfile remains intact.

7. If you allow the operation to continue, after ECM
copies the cardfile, it displays the message COPY
COMPLETE and returns control to the Copy menu.

8. Choose to return to the Main menu.
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Replacing a Cardfile  Replacing a cardfile is identical to creating a duplicate copy
except for this important difference:

W Specifying a distinct cardfile name for Destination
(card)file creates a new cardfile for the duplicate
copy.

® Specifying an existing cardfile name for Destination

(card) file overwrites the existing cardfile with the
current cardfile.

To replace a cardfile:

1. Start from the Copy menu.

2. Choose to condense each file while
copying the cardfile.

ECM marks this label with an asterisk.

You may also choose to make a file-to-file copy
of the cardfile.

3. Type the full name for the cardfile you want to
replace.

ECM displays this information in the box under
Destination (card)file:.

4. Verify that the name is correct.

If the other cardfile is in a different directory, provide
the proper pathname.
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Caution w

18-10 Copying Techniques

Choose to initiate the copy procedure.

Once ECM discovers that a cardfile exists with the
name you supplied, it requests additional
information. In particular, it asks if you want to
append to the existing cardfile, replace the existing
cardfile, or cancel the operation in case you have
changed your mind.

If you enter the wrong cardfile name, you may choose

to cancel the operation and preserve the old cardfile.
Once you choose [EITTEIN, however, ECM deletes the old
cardfile.

Choose IS
ECM deletes the existing cardfile. While it creates the
new cardfile, ECM informs you it is:

Copying current cardfile to disc-

If you decide to cancel the operation at this time,
choose T

ECM cancels the operation and deletes the partial
cardfile. The cardfile you were replacing has also been
deleted.

If you allow the operation to continue, after ECM
copies the cardfile, it displays the message COPY
COMPLETE and returns control to the Copy menu.

Choose to return to the Main menu.



Combining
Cardfiles

Caution W

Preparing to Combine
Two Cardfiles

When copying a cardfile, if you provide a cardfile name for
the new cardfile and that cardfile already exists, ECM
allows you to choose between appending to the existing
cardfile, replacing it, or canceling the operation. When you
choose to append, ECM combines the cards from both
cardfiles and places the cards in order according to their
key fields. Since the expanded cardfile contains cards from
both cardfiles, the cardfiles must have similar card forms.

When appending cardfiles, ECM automatically produces a
condensed version of the cardfile.

Do not attempt to combine cardfiles that do not satisfy
these requirements. You can combine cardfiles if

@ they have the same key fields,

B the same number of fields,

m same order for the fields,

® and the same length for the fields.

Other features of the card may vary. For example, one card
could have five comment lines which were grouped
together, while the other card had five comment lines
which were not considered to be a group.
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Choosing the Current
Cardfile

18-12 Copying Techniques

An easy way to meet the requirements for combining
cardfiles is to have identical card forms for both cardfiles.
(You can create identical card forms by choosing

under the Create menu; see Chapter 9.)

When you choose a copy operation, ECM assigns the
current cardfile to be either the source cardfile or the
destination cardfile. With the “Save” versions of the Copy
menu, ECM makes the current cardfile the source cardfile.
Therefore, you should remember these implications before
you get the current cardfile.

You combine cardfiles by copying one cardfile into another.
The cardfile that supplies the cards is the source cardfile. It
remains unchanged during the copy operation. For
example, if you make the cardfile called WASHDC the
current cardfile and combine it with another cardfile
named CALIF, the original WASHDC cardfile remains
intact.

The cardfile that receives the cards is the destination
cardfile. Its composition changes during the copy
operation. For example, if you copy your WASHDC cardfile
into your CALIF cardfile, the CALIF cardfile now contains
cards from both cardfiles.

When combining cardfiles, ECM places copies of the cards
from the source cardfile, in their proper sequence, into the
destination cardfile. For example, if the WASHDC cardfile
contains an Able card and a Charlie card, and the CALIF
cardfile contains a Baker card, the expanded CALIF cardfile
contains Able before Baker and Baker before Charlie.

If you want to preserve the destination cardfile in its
original form, make a duplicate copy first. Using the above
example, you might name the new cardfile CALIFDC.
Then, make WASHDC the current cardfile and combine it
with the new CALIFDC cardfile. Afterwards, you have



both original cardfiles (WASHDC and CALIF), plus the
CALIFDC cardfile, which now contains cards from both
cardfiles.

To append two cardfiles together:

1.
2.

Start from the Main menu.

Get the cardfile that you want to use as the source
cardfile. (This cardfile remains unchanged.)

Choose to display the Cardfile Tasks
labels if these labels don't appear:

Choose ISTTESIEIII
Type the name of the destination cardfile.

ECM displays the name in the box under
Destination (card)file:

Verify that the name is correct.

If the cardfile is in another directory, provide the full
cardfile name.

Choosing initiates the copy operation.

Because a cardfile exists with the name you supplied,
ECM asks if you want to append to the existing
cardfile, replace the existing cardfile, or cancel the
operation.
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If you entered the wrong cardfile name, choose to
cancel the operation.

8. Choose I Y.

ECM combines the current cardfile with the existing
cardfile and informs you it is:

Copying current cardfile to disc.
9. If you decide to stop the operation, choose
[ Stop Copying

ECM stops the copy operation, but as some
information may have already been added to the
destihation cardfile, you should inspect that cardfile
and delete any cards you don’t want.

10. If you allow the operation to continue, after ECM
copies the cardfile, it displays the message CoPY
COMPLETE and returns control to the Copy menu.

11. Choose to return to the Main menu.
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Copying a
Workset

Creating a New
Cardfile

Because worksets are temporary, you must copy a workset
if you want to preserve it as a permanent cardfile. When
you supply a distinct cardfile name, ECM creates a new
cardfile. However, if you supply a name for an existing
cardfile, ECM requests if you want to append the workset
to the existing cardfile, replace the cardfile, or cancel the
operation. In this regard, copying a workset is identical to
copying a cardfile.

You may also replace the current cardfile with its current
workset (see the discussion on Replacing a Cardfile with
Its Workset).

Copying a workset is similar to copying a cardfile. For
example, you may choose between and
KIS, but normally the workset’s size determines
your choice.

1. Create a workset. (See Chapter 14 or 15 for this
procedure.)

When you finish this task, ECM displays the workset
on the Main Workset menu.

2. Choose to display the Cardfile Tasks
labels:

Delets”  TraliNdnes EeN

b Cardfile & Count
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18-16 Copying Techniques

3.

Choose Copy Cardfile B

When the Copy menu appears, an asterisk marks the
label, and ECM asks you to:

Select the type of copy~ the file name- then
choose "Copy"-

Choose to compress the cardfile while
copying it.

ECM marks the label with an asterisk to show it is
your current choice. This is a logical choice when the
cards you are saving are a small subset of the entire
cardfile. (You may also choose to make a
file-to-file copy of your cardfile. This choice makes
sense when the number of cards in the workset

approximates the total number of cards in the
cardfile.)

Type a name for the cardfile you are creating.

ECM displays this name in the box under
Destination (card)file:

Verify that the name is correct.

If you want to put the cardfile in another directory,
give the full cardfile name.

When you are uncertain which cardfiles appear in a
directory, you may choose for help.




The next step begins the copy operation. If ECM discovers
that the name you supplied already exists, it updates the
function labels so you may append to the current cardfile,
replace the current cardfile, or cancel the operation. If
those labels appear, choose JEITS3W, then provide a
distinct name for the new cardfile.

7. Choose to initiate the copy procedure.
ECM tells you it is:
Copying current cardfile to disc-

8. If you decide to cancel the operation at this time,
choose TN

ECM cancels the operation and deletes the partial
cardfile. The workset remains intact.

9. If you allow the operation to continue, after ECM
copies the cardfile, it displays the message CoPY
COMPLETE and returns control to the Copy menu.
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Replacing a Cardfile At times you may want to replace a cardfile with a workset
with Hs Workset you have just created. For example, if you have used the
Sort menu to rearrange the cards in your cardfile, you may
decide to replace the cardfile with this workset.

To replace a cardfile:
1. Create the workset you want to save. (See Chapter 14
or 15 for this procedure.)

When you finish this task, ECM displays the workset
on the Main Workset menu.

2. Choose to display the Cardfile Tasks
labels:

3. Choose IETNEEHIEN -
When the Copy menu appears, an asterisk marks the

label, and ECM asks you to:

Select the type of copy- the file name-~ then
choose "Copy".
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Caution w

4. Choose to compress the cardfile while
copying it.
(You may also choose to make a file-to-
file copy of your cardfile.)

5. Type the current cardfile’s name.
ECM displays the name in the box under
Destination (card)file:.

6. Verify that the names for the Source (card)file
and the Destination (card)file are the same.

7. Choose to initiate the copy procedure.

When ECM discovers the cardfile exists, it asks if you
want to append to the existing cardfile, replace the
existing cardfile, or cancel the operation.

If you change your mind about replacing the current cardfile,
choose to cancel the operation. Once you choose
I ECM completes the requested task. You cannot
cancel or stop the operation during this time.

8. Choose BT Y

ECM overwrites the existing cardfile with the current
workset and informs you it is:

Copying current cardfile to disc-

After ECM copies the cardfile, it displays the
message COPY COMPLETE and returns to the Copy
menu.

9. Choose to return to the Main menu.
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Using Merge to
Update a Cardfile

18-20 Copying Techniques

Merge allows you to work with a small portion of a cardfile
then incorporate any changes from that cardfile back into
the original cardfile. For example, suppose you are visiting
your sales office in Hawaii and you want to carry
information from several cardfiles with you on a flexible
disc. Since the flexible disc can’t hold the complete
cardfiles, you create worksets of the specific cards you'll
need and then save each of these worksets as a cardfile.
During your trip, you change several cards in different
cardfiles, as well as adding new cards to some of the
cardfiles. Now, when you return to the main office, you
can merge this new information into the “master” cardfiles.

You can merge any cardfiles that have similar card forms.
(The rules that apply to combining cardfiles also apply to
merging cardfiles. See the discussion under Preparing to
Combine Two Cardfiles.)

When merging cardfiles, ECM places all the cards from the
source cardfile (which contains the new information) into
the destination cardfile by comparing the next card to be
inserted with the sorted cards in the destination cardfile.
When the key fields differ, ECM considers the card to be a
new card, so it adds that card to the cardfile. When the
key fields match, ECM compares a special number that it

- assigned to each card when it created that card. If the

special numbers also match, ECM considers the cards to be
identical, so it replaces the card in the master cardfile with
the card from the source cardfile.



To update a cardfile:

1. Start from the Main menu.

2. Get the cardfile that you want to update.
3. Choose to display the Cardfile Tasks
labels if they don't appear.

4. Choose to display the Copy menu:

Copy Type: Quick Save

Source (card)file
i 1

Destination (card)file:

J

Since you want to update the cardfile by merging in new
information, choose the merge operation.
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5. Choose EST.

ECM marks this label with an asterisk and displays
the Merge version of the Copy menu.

f Executive Card Manager copyY Cardfil

: A'\IMPORTS\

Copy Type: Merge

6. Type the name of the cardfile that contains the new
information.

ECM enters this name for the source cardfile.
7. Verity that the name is correct.

If the cardfile is in another directory, provide the
proper pathname.

8. Choose to initiate the merge operation.
ECM informs you it is:

Copying current cardfile to disc-



9.

10.

11.

If you decide to stop the operation, choose

[ Stop Copying B

ECM stops the copy operation, but as some
information may have already been added to the
master cardfile, you should inspect that cardfile and
delete any cards that you don't want.

If you allow the operation to continue, after ECM
merges the two cardfiles, it displays the message CoPY
COMPLETE and returns control to the Copy menu.

Choose REEITN to return to the Main menu.
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Copying This section gives the procedure for copying cardfiles
Cardfiles between two discs. Additionally, the techniques provide

. ways to:
Between Discs _
B back up a cardfile

® move a cardfile from a crowded disc

Both of these concepts will be discussed, however, the
procedure for copying a cardfile between discs is identical,
regardless of the reason for doing it.

Backing Up a The first section in this chapter showed how to make a

Cardfile duplicate of a Card.file on the same C'ﬁSC. This procedure
protects the integrity of the cardfile if you inadvertently
delete cards or perform some other unwanted operation. It
offers no protection, however, if the disc itself is damaged
or lost. Therefore, it is a good practice to back up your
cardfile by placing the duplicate copy on another disc. This
safeguards the cardfile even if the original disc is damaged
or lost.
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Moving a Cardfile when a work disc becomes full, you may decide to move
from a Crowded one or more cardfiles to another disc.

Disc The amount of information that a disc can hold depends
on two things:

B the size or capacity of disc you are using

® how much information is stored on the disc
Let’s look at each of these factors in greater detail.

Your personal computer supports a wide range of disc
drives: from fixed discs (with extremely high storage
capacity) to flexible discs (with lesser amounts of storage).
Furthermore, flexible discs may store information on
double sided or high capacity discs. All these factors affect
the amount of information that a disc can hold. (Consult
the owner’s manual for your disc drive for further
information.)

You decide what information is stored on a disc. For
example, when building your cardfile library, you may put
each cardfile on a separate disc or you may store several
cardfiles on one disc. You may also put different
application programs on one disc or separate discs. If you
place a large spreadsheet and several cardfiles on one disc,
this limits the size of the cardfiles on that disc.

When you try adding cards to a disc that has reached its
capacity, ECM informs you:

DISC ERROR-unable to save the card data-
The following procedure explains how you can copy

cardfiles to another work disc so you may delete the
originals from the crowded disc.
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Copying to
Another Disc
Drive

18-26 Copying Techniques

This section describes the copying procedure when you
have a dual, flexible disc drive. This is a typical
configuration for many systems. See Appendix C if your
system has a fixed disc.

Copying to a disc in another drive involves these steps:

® copying the cardfile from drive B to a temporary location
in drive A

B getting this copy as the current cardfile and replacing
the old work disc with another disc

® recopying the cardfile from drive A to the new disc in
drive B

The following instructions work when the disc in drive A
has sufficient room to hold a temporary copy of the
cardfile. If you attempt this procedure and ECM discovers
that not enough room exists, it informs you:

DISC ERROR~unable to save the card data-

If this happens, refer to the last section in this chapter
Copying Tricks When Disc Space is Limited for details on
copying cardfiles when insufficient space remains on the
disc to use these procedures.



To display the Copy menu:
1. Start from the Main menu.

2. Get the cardfile that you wish to copy.

3. Choose to display the Cardfile Tasks
labels if they don't appear.

4. Choose to display the Copy menu.

( Executive Card Manager COPY Cardfile: A'\IMPORTSW

Copy Type: Quick Save

e \(ca’rd)’fil
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Copying from Drive B Your first task is copying the cardfile from the crowded
work disc in drive B to a temporary cardfile on a disc in
drive A. (Normally, drive A holds your working copy of
the ECM program and any other information that you have
stored on that disc.)

Remember, the cardfile you place on the ECM Application
disc is temporary only if you subsequently delete it.

1. Start from the Copy Menu.
2. Choose KIITRITETIEY .

ECM marks this label with an asterisk. Then, when
you initiate the copy procedure, ECM produces the
most space-efficient version of the cardfile.

You may also choose [FFIESEMN; but under most
circumstances, is the more logical choice.

3. Type a name for the temporary cardfile.

ECM displays the cardfile’s name in the highlighted
box under Destination (card)file.
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4. Verify that the name is correct.

Since you are copying from drive B to another
directory in drive A, be sure to include the proper
pathname. For example, typing A:\KARLIE\IMPORTS
places the IMPORTS cardfile in the KARLIE
subdirectory under the root directory in drive A.

5. Choose to initiate the copy procedure.
ECM tells you it is:
Copying current cardfile to disc-

After ECM copies the cardfile, it returns control to the
Copy menu.

6. Choose to return to the Main menu.
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Getting a New  Before you switch discs in drive B, you must make the
Current Cardfile copy that you just put in drive A the current cardfile.

Caution Do not switch discs until ECM tells you it is safe to do so. (See
the third step in the following procedure.)

To get the copy in drive A:

1. Start from the Main menu.

2. Choose IENTROETS

3. Choose JIEEEIIIY.
ECM displays the default pathname and asks you to:

Type a cardfile name and press ENTER. (You
can switch discs now.)

At this time, ECM is not accessing drive B so you
may also switch discs in that drive.

The next step directs you to insert another disc in drive B.
If you are inserting a brand new disc, remember to format
it first.

4. Remove the disc that is currently in drive B and insert
another disc.
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5. Type the name of the cardfile that you temporarily
stored in drive A.

Be sure to provide the proper pathname.

6. Pressing ends the cardfile’s name and directs
ECM to continue.

ECM informs you it is:

Getting cardfile.

After it locates the cardfile, ECM displays it as the current
cardfile.

Recopying to Drive B You may now copy the current cardfile to your new disc in
drive B.

1. Start from the Main menu.

2. Choose to display the Cardfile Tasks
labels:

TR INames
& Count

3. Choose to display the Copy menu.
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4.

5.

Choose to make an identical copy of the
three files that make up your cardfile.

This suffices because you previously used

to make the most efficient files for this
cardfile.

Type the cardfile’s name.

Remember to provide the proper pathname. Using
our previous example, you would type
B:\KARLIENIMPORTS if the new disc has a KARLIE
subdirectory and you want the cardfile to retain its
current name,

ECM enters this information in the highlighted box
under Destination (card)file.

Verify that the full cardfile name is correct.
Choose to initiate the copy procedure.

After ECM copies the cardfile, it returns control to the
Copy menu.

Choose to return to the Main menu.



Copying to an Many personal computers offer an electronic disc. An

Electronic Disc electronic disc is a section of Random Access Memory
(RAM) that the computer sets aside for temporary storage.
Since RAM storage is temporary, it is also called volatile
memory because information is lost upon power failure to
the memory chip.

Since your personal computer treats the electronic disc as it
does any other disc, you follow the same procedure to
copy a cardfile to an electronic disc. Just remember to
provide the proper name that designates this disc when
you enter the pathname.
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Deleting the Old

Cardfiles
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Once you follow the procedure in this section to copy a
cardfile between discs, you have three copies of that
cardfile:

B the original cardfile on the first disc in drive B

B the duplicate cardfile on the second disc you put in
drive B

# the temporary cardfile on the disc in drive A

You no longer need the copy in drive A, so you should
delete that cardfile now. You may also delete the cardfile
from the disc that was initially in drive B unless you want
copies on separate discs as a back up. Chapter 10 explains
the procedure for deleting a cardfile.



Copying Tricks
When Disc Space

Is Limited

One of the major advantages of a fixed disc is its large
storage capacity. For most users, a fixed disc should easily
store all the cardfiles you might create. If you are using
flexible discs, however, you may eventually fill a disc with
so much information that ECM cannot complete an
operation that takes additional disc space.

This section tells you how to copy, transfer, and combine
cardfiles if ECM runs out of room when you attempt one
of these operations.

A simple solution, which may solve many of your
problems, is using to reduce the amount of
space each cardfile takes. However, if you know your files
are space efficient and you still cannot complete a copy
operation, then try the tricks in this chapter.
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Why Copying
Tricks Are
Necessary
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It is always safe to try copying, transferring, or printing a
cardfile. However, if ECM discovers that a disc has
insufficient space to complete an operation, it displays one
of these messages:

Can't finish copying to the disc file
Can't open temporary printout file

DISC ERROR-unable to create the cardfile
DISC ERROR-unable to save card data

The data for the card cannot be created

The form cannot be saved

When insufficient room exists to complete a copy, transfer,
or print operation, ECM deletes the incomplete copy.
Therefore, you could try again with another destination
disc that contains more available space. Or, you can use
one of the tricks described in this section.

You may need these tricks because you cannot remove
your personal work disc while you are using that disc as a
source for copying, printing, or transferring information.
As an alternative method, you may remove the ECM
Application disc. However, you may only remove the
application disc while you are using File Manager.



Estimating a
Cardfile’s Size

You may use File Manager to estimate a cardfile’s size.
Remember, however, that this is an estimate since a cardfile
may occupy more space than it actually needs. (This
happens, for example, when you delete several cards.)
When you use to replace each cardfile with
its condensed version, the figures represent the smallest

. Start from the Main menu.

- Choose IITTITRFITN.

Set Direc'ry

. Choose to display the File Manager
Main menu.

Return File:

Return Dir:

Dir to Disp:

Displayed Dir: #&Y

104192 bytes available.

Press PgDn/PgUp to see more files.
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A box on the right of the menu (before bytes available)
tells how much memory remains in that directory. If you
plan to copy a cardfile to this location, this number sets
the upper limit to the size that the three files (which
constitute a cardfile) can have.

If the cardfile you want to copy is on another disc, see the
following discussion on To check another directory, then
continue with step 5.

If this disc contains the cardfile you want to copy,

NIGELY Croose dic §
Choose Expanded Dir §

In the expanded directory, the first number to the
right of the file name tells how many units of
memory (in bytes) that file contains.

Find the names for the three files in your cardfile.
If they aren't visible, press the [Pgonlkey until you
display them.

Add the number of bytes in each of these files and
compare that total with the amount of available space
in the directory where you want to copy the cardfile.

Choose IEITIFEFRHSE to remove this option.

Choose to return to the File Manager
Main menu.



To check another directory:

If you want to check another directory, take these steps.

1.
2.
3.

Start from the File Manager Main menu.

Choose RIS

Type the pathname of the directory you want to
inspect.

Press to end your response.

File Manager displays that directory. You may see how
much space exists by inspecting the value for bytes
available.
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Copying Tricks to
Overcome Space
Limitations
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If a message tells you that ECM ran out of room when it
tried to copy, print, or transfer a cardfile, the following
sections give you alternate methods for copying that
cardfile. The section tells you how to copy cardfiles using
File Manager rather than ECM’s copy facilities. The last
four sections tell you how to combine cardfiles when disc
space becomes progressively tighter.

Since the File Manager does a file-to-file copy, you should
replace the appropriate cardfiles with their condensed
version by using before continuing with
these procedures.

The following procedures involve switching discs between
drives and changing the current cardfile. To help clarify
these tasks, the examples use specific names for each
cardfile. In particular, the examples assume that a person
named Terry has a personal subdirectory on a disc where
he stores his financial information. His TERRY subdirectory
contains a cardfile called INCOME. He also has another
cardfile called BUDGET. Although these names may
simplify the examples, it is important that you remember
which cardfile is your source cardfile and which cardfile is
the destination cardfile.



Copying from Drive B
to Drive A

In this example, the INCOME cardfile (the source cardfile
that you want to copy) is on a disc in drive B and your
working copy of the ECM program is on a disc in drive A.
Because the ECM Application program also takes space,
the disc in drive A may not have enough room for the
copy. The strategy, therefore, is to access File Manager and
put another disc in drive A.

When you use File Manager, you work with the three files
that make up a cardfile rather than the composite cardfile.
Thus, copying a cardfile implies copying all three files.

In the following steps, you enter File Manager from the
ECM program, but you can also enter File Manager from
PAM. When you enter from PAM, you go directly to the
File Function menu. When you enter from ECM, you first

see the File Manager Main menu. Choosing
accesses the File Functions menu.

To display the File Manager Copy menu:

1. Start from the Main menu.

2. Choose IEISTINVEFITTN .
3. Choose INTERTINE
4. Choose to display the File Manager

Main menu.

If you don'’t see the three files that make up your
cardfile, they may be on the next screen or in another
subdirectory. Press the key to view the next
screen-full of information. (If you want to inspect
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another directory, see the previous discussion on To
check another directory.) After you find the files,
remember to return to the File Manager Main menu
so you can continue this procedure.)

Choose to display the File Functions

menu.

Remove the ECM Application disc from drive A and
insert a disc with more available space.

Choose to display the File Manager Copy

menu.

Displayed Dir: A§X "
/4104192 bytes available.

Press PgDn/PgUp to see more files.




To copy a file using File Manager:

1.

Move the pointer to the file you want to copy.

2. Press the key to choose this file.

You may also use touch to choose a file, if your personal
computer supports this feature.

File Manager displays the full name of that file as the
Copy File. For example, if you selected
INCOME.EDT from Terry’s subdirectory on the disc in
drive B, the full cardfile name is
B:\TERRY\INCOME.EDT. (If you want to select
another file, you may choose and repeat
this step.)

Next, File Manager asks you to:
Select or type the file name to copy to-

Type the full name for the new file you want to
create. (This is the To File).

Because you are copying to drive A, include the
proper pathname and the appropriate three-letter
extension (.EDT, .EFM, or .EIX). For example, to put
INCOME.EDT in Patrick’s subdirectory in the disc in
drive A, you would type:

A:\PATRICKNINCOME-EDT

(If you omit the file’s name, File Manager gives the
copy the same name as the original file.)
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4,

5.

Press to end the file's name.

File Manager displays the name you just entered as
the To File and asks you to:

Press Start Copy if selection is correct.
When you are satisfied with your instructions, choose
[ start Copy B
File Manager informs you it is:

Copying the selected file.

Repeat steps 1 through 5 to copy the remaining two
files for the cardfile you are copying.

To return to ECM:

1.

Once you have copied all three files, remove the work
disc that you put in drive A and replace it with the
ECM Application disc.

Choose to return to the File Functions
menu.

Choose IITERNESTd to return to the File Manager
Main menu.

Choose to leave File Manager and return
to the ECM program.



Combining Cardfiles
Using File Manager

You can use File Manager to combine two cardfiles if both
cardfiles can fit on one disc and enough room remains to
hold the combined cardfile. (If your cardfile is too large for
this method, proceed to the next section.)

In this example, you start with two cardfiles, a source
cardfile named INCOME and a destination cardfile called
BUDGET. (When you adapt this procedure for your needs,
supply the appropriate names for the source and
destination cardfiles.)

1. Place the disc containing the source cardfile
(INCOME) in drive B.

When you enter File Manager from ECM, you start with
the File Manager Main menu so you must choose

to continue this procedure. (If you enter
File Manager from PAM, you go directly to the File
Functions menu.)

2. Follow the steps in the preceding section to copy the
source cardfile INCOME) from drive B to drive A.

At step 6, be sure to replace the ECM Application disc
with the disc that contains the destination cardfile
(BUDGET). The subsequent steps place a copy of the
INCOME cardfile on this disc.
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Be sure you complete the entire procedure for copying
from drive B to drive A using File Manager. In
particular, remember to replace the work disc in drive
A with the ECM Application disc and choose

when you complete the procedure to
return to the ECM program.

ECM returns you to the Cardfile Tasks menu (the
point from which you entered File Manager).

Choose ITIXEITTESTN so you may change the current
cardfile.

ECM tells you to:
Type a cardfile name and press ENTER.

. Remove the disc (which contains the original

INCOME cardfile) from drive B and replace it with
the disc that now contains both the BUDGET and
INCOME cardfiles.

. Type the name for the source cardfile (in this

example, INCOME).

Be sure to provide the proper pathname.

. Press to end the cardfile’s name.

ECM displays INCOME as the current cardfile.

. Now use the procedure at the beginning of this

chapter (under Combining Two Cardfiles) to combine
INCOME and BUDGET into a single cardfile.



Using Transfer In and
Transfer Out to
Combine Cardfiles

The preceding method requires that your work disc has
sufficient room to store three cardfiles: the source cardfile,
the destination cardfile, and the combined cardfile. If you
don’t have enough room on one disc to use this method,
you can still use File Manager to combine cardfiles if:

® you have room on one disc for the combined cardfile

® you have room on the ECM Application disc for the
transfer file

In this method you transfer out the field information from
the source cardfile (INCOME) to the ECM Application disc
in drive A. Then you combine this information with a copy
of the destination cardfile (BUDGET) on a disc in drive B.

To transfer from the source cardfile:

1. Use File Manager to copy the source cardfile
(INCOME) to another disc. (This procedure is given
in the first part of this appendix.)

When you finish, the ECM Application disc should be
in drive A, the original copy of the source file
(INCOME) should be in drive B, and your new copy
of the source cardfile should be on top of your desk.
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From the Main menu, choose to
reach the Cardfile Tasks menu.

If INCOME is not the current cardfile, use
to make it the current cardfile.

Choose [[TYREIEIENEN.
ECM displays the Copy menu and asks you to:

Select the type of copy- the file name, then
"Copy"-

Choose (KT

Type the name for the destination holding file.

Because you are transferring to the ECM Application
disc, provide the full pathname. You may also include
a three-letter extension, such as .BXF for “BASIC
Transfer File”. For example, if you are transferring the
INCOME cardfile to Patrick’s subdirectory on the disc
in drive A, you would type:

A:\PATRICKNINCOME.BXF

Choose & .

Once the copy operation finishes, ECM returns to the
Copy menu.



Caution w

To transfer in to the destination cardfile:

Before you transfer the information to the destination
cardfile, you must place the appropriate discs in the proper
drives and make the destination cardfile the current
cardfile.

When you get another cardfile, ECM closes the current cardfile
before it opens the new cardfile. Because you take advantage
of this two-step process to switch discs, rather than
anticipating steps, you should follow each step explicitly. In
particular, switch discs after you type the name for the new
cardfile but before you press [Enter ].

1. Choose to display the Main menu.

2. Choose to display the Cardfile Task
menu.

3. Choose IT3ETTETEECN .
ECM closes the current cardfile.

4. Type the name of the destination cardfile (in this
example, BUDGET).

5. Remove the disc, which contains the INCOME
cardfile that you just closed and replace it with the
disc that contains the destination cardfile (BUDGET).

6. Press to end your response for getting the
destination cardfile.

ECM displays the BUDGET cardfile.
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Using File Manager
and Transfer In and
Out to Combine
Cardfiles
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10.

11.

Choose to display the Copy menu.
Choose FIETBITNN -

As the Transfer In version of the Copy screen sets the
current cardfile to be the destination cardfile, you
specify the holding file as the source file.

Type the full name for the file you temporarily stored
on the ECM Application disc in drive A.

For our example, you would type:
A\PATRICKNINCOME.BXF

Choose 8T .

Once ECM copies the transfer file into BUDGET, it
returns to the Copy menu.

Choose R4EEHN to return to the Main menu.

Since the ECM program occupies space on your working
copy of the ECM Application disc, this disc may not have
enough room to hold the transfer file. In this case, you can
still combine the cardfiles using File Manager and the
transfer labels if:

B The destination disc (which contains BUDGET in our

example) has sufficient room for the combined cardfile
and a transfer file of INCOME.

@ The disc containing the INCOME cardfile has room for a

transfer file of itself.



To transfer from the source cardfile:

1. Use File Manager to make a copy of BUDGET on
another disc.

Follow the procedure under Copying from Drive B to
Drive A Using File Manager in the first part of this
appendix. When you finish, the ECM Application disc
should be in drive A, the original version of BUDGET
on a disc in drive B, and the new copy of BUDGET
should be on top of your desk. (This copy of
BUDGET is your destination cardfile.)

If you entered File Manager from a point other than the
Cardfile Tasks menu, take step 2 to display this menu.

2. From the Main menu, choose to
reach the Cardfile Tasks menu.

3. Choose [ISXSETETN.
ECM closes the current cardfile.

4. Remove the disc that contains the original BUDGET
cardfile from drive B and replace it with the disc that
contains the source cardfile (INCOME).

5. Type the name for the source cardfile (INCOME)
which you just placed in drive B.

Remember to provide the proper pathname. For
example, you might type:

B:\TERRY\INCOME
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6. DPress to end the cardfile’s name.
ECM makes INCOME the current cardfile.
7. Choose [TV
ECM displays the Copy menu and asks you to:

Select the type of copy~ the file name-
then "Copy™.

8. Choose XS .

For the Transfer Out version of the Copy screen, ECM
sets the current cardfile to be the source cardfile.

9. Type the name for the holding file.

Remember to provide the proper pathname and a
cardfile name to distinguish this file from all other
files. For example, if you are placing the holding file
in the same directory, you could type:

B:\TERRY\INCOME.BXF

10. Choose &Y.

Once the copy operation finishes, ECM returns to the
Copy menu.
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To copy the holding file using File Manager:

1. From the Copy menu, choose FITTINITHA .

2. Remove the ECM Application disc from drive A and
replace it with the copy of the destination cardfile
(BUDGET).

3. Copy the holding file from the disc in drive B to the
disc you just placed in drive A.

4. Choose to return to the File Functions
menu.

5. Remove the disc in drive A and return the ECM
Application disc to this drive.

6. Choose to return to the File Manager
Main menu.

7. Choose to return to the Cardfile Tasks
menu.
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To transfer in to the destination cardfile:

Before you transfer the information to the destination
cardfile, you must place the appropriate discs in the proper
drives and make the destination cardfile the current
cardfile.

Caution When you get another cardfile, ECM closes the current cardfile
w before it opens the new cardfile. Because you take advantage
of this two-step process to switch discs, rather than
anticipating steps, you should follow each step explicitly. In
particular, switch discs after you type the name for the new
cardfile but before you press [Enter |.

1. Choose IEEETIN

ECM closes the current cardfile.
2. Type the name of the destination cardfile.

3. Remove the disc in drive B and replace it with the
disc that contains copies of the INCOME holding file
and the BUDGET cardfile.

4. Press [Emer]to end your response for getting the
destination cardfile.

ECM displays BUDGET as the current cardfile.

18-54 Copying Techniques



Choose to display the Copy menu.

(@WERY Transfer 1n B
Type the full name for the holding file.

Remember that in this case the INCOME transfer file
is on the same disc as the BUDGET cardfile.

Choose 8T8

Once ECM copies the transfer file into BUDGET, it
returns to the Copy menu.

Choose BIGEN to return to the Main menu.

Since ECM has transferred the INCOME holding file
to the BUDGET cardfile, it displays the combined
BUDGET cardfile on the Cardfile Tasks menu.
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Combining Cardfiles
Using Worksets
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When you don’t have enough room on a disc to copy the
whole transfer file from drive B to drive A, you can split
the cardfile into worksets then transfer the worksets one at
a time. (Chapter 14 tells you how to create a workset.)

The following steps summarize this procedure:

1. Create a workset from the source INCOME) cardfile.
2. Using EIISEXMA. copy the contents of the

workset from drive B to drive A.

3. Then use to copy the workset’s transfer
file into the destination cardfile (BUDGET).

4. Delete the copy of the transfer file you just appended
to make room for the next transfer file.

5. Repeat steps 1 through 4 until you transfer all the
information from the source cardfile (INCOME) into
the destination cardfile (BUDGET).

When the ECM Application disc lacks sufficient room to
store the transfer file, you must create the transfer file on
the source disc (the one containing INCOME in our
example) then use File Manager to copy it directly to the
destination disc (the one containing BUDGET).




When Printing or

Transferring a
Cardfile Fails

If you are creating a print file or transferring a data file into
a cardfile, the destination disc may fill up before all the
information has been received from the source cardfile. If
this happens, ECM stops the operation, deletes the
incomplete file, and displays a message to alert you that it
couldn’t complete the task. Therefore, you should take
these steps:

1. Create additional space on the destination disc.

You can create additional space by either deleting
other files from the destination disc or copying the
destination cardfile to a fresh disc.

2. Try the operation again.
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Changing a Cardfile
Once It Contains Cards

This chapter explains how you can change a cardfile that
contains information. The mechanics for modifying the
design of the card form is identical to that presented in
Chapter 9. Now, however, you must not only change the
card design but also transfer information from the old
cardfile to a temporary holding file, and then to the new
card form. This chapter explains the transfer procedure.

-

Changing a When you change the design of a cardfile with cards in it,
Cardfile you take these steps:
® Move the existing field information to a holding file.

& Call up the old card form, make the necessary changes,
then save the card form as a new cardfile.

8 Move the field information from the holding file to the
new cardfile, which uses the modified card form.

Caution Do not use Merge or Quick Save or Compact Save with
Append because the card form is going to change.
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Let’s look at each step in greater detail.

When you move information to a holding file, you transfer
out a copy of that information. Therefore, the original
cardfile remains intact. For example, if you want to change
the layout of your Address Book cardfile, you first copy the
information stored in that cardfile to a holding file.

Next, you call up a copy of the original card form and
modify it. Again, your changes have no effect on the
original card form. For example, you might change the card
form of your Address Book cardfile so the open-card area
displays fields for a Work Phone and Home Phone rather
than the Street Address.

After you modify the old form and save it as a new
cardfile, you then transfer in the information that you
stored in the holding file. You now have two cardfiles: the
original cardfile as you created it and a new cardfile, which
holds the same information but in a different layout. You
may now delete the original cardfile and the holding file if
you have no further need for this information.
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Getting Ready to

Transfer

Since transferring out is a copy operation, your first task is
accessing the Copy menu.

To display the Copy menu:

1. Start from the Main menu.

2. Get the cardfile whose card form you want to change.

3. Choose to display the Cardfile Tasks
labels if these labels don't appear:

4. Choose EETTRSIEITITY.

When the Copy menu appears, an asterisk marks the
label, and ECM asks you to:

Select the type of copy- the file name. then
choose "Copy" .-

Since you want to transfer out information to a
holding file, you must choose this label.

5. Choose EIEISITENE .
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USiI'Ig the When you choose [EEIETIN. ECM marks this label

Transfer Out with an asterisk and displays the “Transfer Out” version of
the Transfer Options menu.

2

Copy Type: Transfer Out
BASIC Format

Source (card)file:

\_ Y,

On the “Transfer Out” menu, ECM supplies the name of
the current cardfile for the Source (card)file. You
cannot change this entry. ECM expects you to name the
holding file, so it highlights the area under Destination
(card)file. Also, the entry for Copy Type shows both
the type of copy (in this case Transfer Out) and the type
of format (in this case BASIC Format).
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Let'’s take a quick look at the labels on the Transfer Option
menu:

initiates the copy procedure.

When you copy a cardfile using Quick Save, Compact
Save, or Merge, ECM copies the fields as they appear on
that card form. For the transfer operations, you may
specify the order in which ECM transfers fields by using
to display the Reorder Fields menu.

accesses the File Manager program.

and determine how ECM writes
the information to the holding file. The important fact to
remember is that you must use the same format to transfer
information out and in. Unless you direct it otherwise,
ECM uses BASIC format. (Appendix D, which describes
using ECM with other programs, provides further
information on BASIC and DIF format.)

BASIC format passes information as quoted strings. Hence,
you should avoid putting quotation marks ( ™ )} within
fields that you plan to transfer to another cardfile. (If any
fields have quotation marks in them, you should change
this symbol to a single quote ( ' ) or two single quotes

("))

returns control to the Copy menu.
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TraNSferring Out When you want to transfer all the information in a cardfile

the Information as it currently appears, your next step is to name the
transfer file. However, if you want to change the order in
which ECM will transfer the fields, see the concluding
section in this chapter on Setting Fields in Order.

1. Type a file name for the holding file.

You may put the holding file on a different disc. If
you decide to do this, supply the proper pathname.
You may also use a file extension to identify this file
as a transfer file. For example, you might type the
cardfile name followed by the extension .BXF for a
BASIC transfer file or .DXF for a DIF transfer file.

The next step begins the transfer procedure. If ECM
discovers that the name you supplied already exists, it
updates the function labels so you may append to the
current file, replace the current file, or cancel the
operation. If these labels appear, choose |JEIS3H, then
provide a distinct name for the holding file.

2. Choose ¥R

ECM informs you it is:

Copying current cardfile to disc-
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3. If you decide at this time that you don’t want to
continue, choose [[ENSN.

ECM cancels the operation and deletes the partial
holding file.

4. If you allow the transfer to continue, after ECM
copies the cardfile, it displays the message COPY
COMPLETE and returns control to the Copy menu.

5. Choose to return to the Main menu.
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Changing the Old
Card Form

After you have transferred the field information to a
holding file, your next step is changing the old card form.
Chapter 9 describes this procedure.

As you are transferring information into the new form in a
specific order, you should plan for the necessary changes:

B Wherever you changed the sequence of fields, move the
affected fields to their new positions.

B Wherever you incremented the transfer-order number to
leave room for a blank field, create this new field on the
card form.

# Wherever you omitted assigning a number to a field (so
ECM didn't transfer its contents), delete that field from
the card form.

You may also make other changes to the card form, such
as changing the title or labels, or adjusting the length of

different fields. However, be sure you include at least as

many fields in the new form as you are transferring from
the original cardfile. Also, avoid shortening a field to the
extent that it no longer holds its original information.

Once you have modified the card form, you must give it a
name and save it to disc. Avoid names that already exist in
the directory you plan to use. For example, if your old
cardfile is named IMPORTS and you want to store the new
cardfile in the same directory, you could name the new
cardfile IMPORTS2.

Once you save the card form, ECM returns to the Main
menu, and the new cardfile is now the current cardfile.
Thus, you are ready to transfer in the information from the
holding file.
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Transferr ing into After creating the new card form, your next task is putting

the Modified
Form

the information from the holding file into this form. ECM
calls this operation transferring in.

1. Start from the Main menu.
2. Choose IETITETSTFITY .
3. Choose ITYIEIETRTE .
ECM displays the Copy menu and asks you to:

Select the type of copy- the file name. then
choose "Copy".

4. Choose EEPIETY.

Executive Card Manager COPY: TRANSFER OPTNS Cardfile: A:\IMPORTS“W

Copy Type: Transfer In
BASIC Format

Source
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5. If the new card form has additional fields between

the fields in the holding file, choose
and skip over the additional fields. (See the
concluding section on Setting Fields in Order.)

6. Type the name for the holding file.

Remember to supply the proper pathname, if this file
is in a different directory.

7. Choose M.

ECM informs you it is:
Copying current cardfile to disc.

8. If you decide at this time to cancel the operation,
choose IKTTR.

ECM stops the transfer operation; but as some
information may have been transferred to the new
cardfile, you should inspect that cardfile and delete
any cards, or the entire cardfile, if you don’t want this
information.

9. If you allow the transfer to continue, after ECM
copies the cardfile, it displays the message Copy
COMPLETE and returns control to the Copy menu.
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Returning to the
Main Menu

After you transfer the information from the holding file
into your new cardfile, you may do additional copy
operations, or you may return to the Main menu to begin
other tasks.

1. Choose to return to the Main menu.

ECM displays the Main menu with your new cardfile
showing. If you have changed the primary key field,
your cards are sorted accordingly. If you have
modified the placement of the fields on the first three
lines of the card form, the open-card area reflects this
change.

2. If you have no further need for the information in the
holding file or the original cardfile, you should delete
these files.
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Setting Fields in

Order

The simpliest way to transfer information from a cardfile is
to copy all the fields in their current order. At other times,
though, you want the ability to change the order in which
ECM transfers the information. When you are working
with either of the Transfer Option menus, choosing
displays the Reorder Fields menu:

Executive Card Manager REQRDER FIELDS Cardfile:

A:\IMPORTS \

! \

##% TMPORTS CARDFILE w##

Next Contac . (YY/MM/DD)

Street Address §
City é
Country %

Card Last Updated

Specialtie

- _ J

The Reorder Fields menu contains a copy of the original
card form for the current cardfile. ECM has numbered the
fields in sequential order, beginning from the top left
corner of the form and progressing to the bottom right
corner. Because these numbers give the order in which
ECM will transfer the fields, you may change the numbers
to transfer all or some of the fields in a different order.
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When the Reorder Fields menu appears, ECM asks you to:

Set the fields in the order they are to be
transferred.

When you want to transfer all the fields in their current
order, simply leave the menu as it is.

However, you must set a new transfer order when you
want to:

® Switch the position of fields on the form.
® Create space to add new fields.

B Remove unwanted fields.

ECM uses the transfer order numbers that presently
appear on the menu. (For example, if you leave the menu
blank, ECM transfers nothing.) Therefore, when you
change the Reorder Fields menu, you should ensure that
the numbers appear as you intended.

The following sections on Rearranging Fields, Adding
Fields, and Removing Fields explain how to reorder fields
when you have a specific task in mind. But, as three
function labels may help you with any of these tasks, their
use is presented first.
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To start with a clean slate:

When you want to rearrange several fields, you may
shorten your work by chooseing [ISTII¥Rl. When you
choose this label, ECM erases the numbers from all the
fields and uses 1 for the first field number. Therefore, move
the cursor to the first field you want to transfer, choose
ESTHEIT. and begin numbering from there.

To edit the value in a field:

When you move the cursor to a field, ECM displays the
transfer-order number for that field on the input line. Field
expansion is in effect. (For example, if you have a state
abbreviation field that contains two characters and this field
is the 100th field you plan to transfer, ECM displays 100 on
the input line.)

Field expansion also assists you in changing a field’s
transfer-order number when the field’s size is so small that
it prevents you from modifying the number in place.

1. Move the cursor to the field you want to change.

ECM displays the field’s transfer-order number on the
input line.

2. Choose IO
ECM asks you to:

Type the order number for the field then
press ENTER.

ECM also fills the current field with slashes and moves the
cursor to the input line.
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3. You may now modify the number by overtyping
characters or by using your keyboard’s editing keys.

4. If you change your mind, you may return the original
value to its field by choosing [[ETEIN

5. When you finish making your changes, press [Enter].

ECM returns the cursor to the field and displays as
much of the transfer-order number, as possible,
within that field. (The entire number appears on the
input line.)

To start over:
If you change your mind, you may choose
IETEVRYEMYM . This numbers the field from the top left

to the bottom right, starting from one and incrementing by
one for each field.
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Rearranging Fields  ECM transfers fields in the order specified by the numbers
on the Reorder Fields menu. Therefore, if you want to
change the order in which fields appear on the new card
form, you must supply the proper sequence to produce
this transfer order. You may change the order in which
ECM transfers fields, either manually or with ECM
automatic numbering facilities.

To rearrange fields manually:

If you want to reorder a few fields, follow these simple
steps:

1. Move the cursor to a field whose number you want to
change.

2. Type the appropriate number into this field.
ECM also displays the number on the input line.

3. Repeat steps 1 and 2 until you specify the exact
sequence you want ECM to follow.

For example, you may change:

Work Phone Home Phone
to:

Work Phone 'l Home Phone

by overtyping the numbers in the first listing.
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To rearrange fields automatically:

When you are resequencing fields and you want to include
several consecutive fields from the old form, follow this
procedure:

1.

Choose to start automatic numbering.
ECM sets the next field order number to a value
one greater than the current high value on the menu.

If you want to set another value for the next field

order number, choose IO NE-

When ECM requests a value, enter the appropriate
number and press to continue.

If you change your mind, choose to retain
the old number.

Move the cursor to the first field you want to include
in the new sequence.

Choose BT INNY.

ECM assigns the next field order number to the
cursor’s current field, increments the next field
order number by one, and moves the cursor to the
next field.

Repeat step 4 until you have included all the fields
which occur in this sequence.

Choose to end automatic numbering.
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Adding Fields  While setting transfer-order numbers, you should follow a
form that shows the design of the new cardfile. Whenever
the design shows a new field, you can instruct ECM to
leave room for this field by skipping the next number. That
is, you produce a gap when you transfer the information to
a holding file, then you create a field on the new card form
that corresponds to this gap. You may produce the gap
manually or with ECM’s automatic numbering facility.

To create room manually for a new field:

When numbering fields manually, simply skip the next
number in the sequence of transfer-order numbers. For
example, if you want to include three new fields between
the sixth and seventh fields on the old form, type & in the
sixth field, then mentally skip numbers 7, 8, and 9 to allow
space for the new fields, and type 10 in the seventh field
on the old form.

If you want to include several fields from this point, you

may choose to rearrange the subsequent fields using the
automatic numbering facility.
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To create room automatically for a new field:

1.

2.

Enter the transfer-order numbers for the fields that
precede the new field that you plan to create.

Move the cursor to the field that immediately follows
the proposed field.

That is, you want to create a gap between the last
numbered field and this field.
Choose to start automatic numbering.

Choose IBSTEED.

ECM increments the next field order number by
one.

If you want to add several consecutive fields, repeat
step 4 until you have set aside enough space for all
the new fields.

Once you have created the appropriate number of
blank fields, choose T NITTENE.

ECM assigns the next field order number to the
cursor’s current field, increments the next field
order number by one, and moves the cursor to the
next field.

Choose to end automatic numbering.
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Removing Fields  When transferring information to a holding file, ECM omits
all fields with no transfer-order number. Therefore, if you
plan to delete a field on the new card form, you should
omit placing this information in the holding file.

1. Move the cursor to the beginning of the unwanted
field.

2. Press the + [L]keys to erase any number which
currently appears in that field.

3. If you also want to delete the next field, move the
cursor to that field and repeat steps 2 and 3.

L

If you plan to delete a majority of the fields, you may
choose to erase the numbers from all of the
fields. Then, just enter numbers for the fields you want to
transfer.

S
F7ed
i

&

4. If you want to include several fields sequentially from
where you deleted the last field, choose
and follow the procedure for rearranging fields
automatically.

Leaving the Reorder  After you finish setting the transfer-order numbers in the

Fields Menu Reorder Fields menu, you must choose to
return to the Transfer Options menu you were using.
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Reference Guide to
the Function Labels

This chapter gives an alphabetical listing of the ECM
function labels. Each entry supplies:

B the menu heading under which the function label
appears
B the corresponding function key ((F1] through [Fs ])

B the task it performs

Adapt on the Create menu. Choose

0ld Form I RICIEIe M when you want to create a
new card form by modifying an existing form.

When you choose IFETEICISE, ECM
requests a cardfile’s name, then displays that

card form as your model. (See Chapter 9.)

Add on the Main menu. When you choose
Cards EFEREEEE, ECM displays the Add menu with
a blank form for you to complete. (See
Chapter 11.)

Add This on the Add menu. After entering your
information on the blank card form, choose
to place the new card in your
cardfile. (See Chapter 11.)
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Adjust on the Print menu. Choosing

Field accesses another group of
function labels that you may use to change a
tield’s position or to widen, shorten, or
remove that field. (See Chapter 17.)

Adiust on the Print menu. Choosing
Rpt Blk RPN AIIAITE accesses another group of
function labels where you specify a block of

text which you want to repeat when printing
a cardfile. (See Chapter 17.)

assumes this value when you attempt to
copy a cardfile and a cardfile already exists
with the name you supplied. Under these
circumstances, choosing adds the

new cardfile to the existing cardfile. (See
Chapter 18.)

Auto on the Reorder Fields menu under the

Transfer Options menu. When you choose
one of the Transfer operations on the Copy
menu, ECM provides S0 you
may specify the order in which ECM should
transfer the information on the card form.
lets you choose whether you
want to enter the transfer order manually or
with ECM's assistance. Automatic numbering
is active when an asterisk appears in the

label. (See Chapter 19.)

Average on the Break Options menu under the
Print menu. Choosing includes
the current field when computing an average.
(See Chapter 17.)
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BASIC on the Transfer Options menu. When you

Format choose one of the Transfer operations on the
Copy menu, ECM provides two labels so you
may specify how ECM should transfer the
information on the card form. Choosing
transfers the information as
quoted strings. (See Appendix D.)

Break on the Print menu. Choosing

Options accesses another group of
function labels where you tell ECM which
fields it should use for special formatting

considerations. (See Chapter 17.)

BreakOpt on the Set Breaks menu. Choosing
Menu returns ECM to the Break
Options menu. (See Chapter 17.)

Cancel on the Set Directory menu. Additionally,
this label appears during copying and printing
operations. Choosing stops the
current task, and ECM returns the function
labels to their previous values.

Cardfile on the Main menu. Choose
Tasks if you want to create a
cardfile, display a different cardfile, copy a
cardfile, delete a cardfile, find out how many
cards are in the current cardfile, or access the
Modem menu.

Clear on the Reorder Fields menu under the
A1l Transfer Options menu. When you choose

one of the Transfer operations on the Copy
menu, ECM provides 50 you
may specify in which order ECM should
transfer the information on the card form.
Then, if you choose FSTTIESI, ECM
removes the transfer numbers that it
automatically provides for you. Now you may
enter the necessary numbers in the blank
tields. (See Chapter 19.)
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Compact

Save

Illiiﬁilll
Copy
Cardfile

Copy
Main

Count
Field
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on the Copy menu. When you copy a
cardfile using [[EIITISETE, ECM creates the
most space-efficient version of the cardfile.
The extra work required to make this copy
takes time. (See Chapter 18.)

on the main Copy menu and also on the
Transfer Options menu. After you tell ECM
how it should copy a cardfile, choosing
initiates the copy operation. (See Chapter 18.)

on the Cardfile Tasks menu. When you
choose FEITREILTEITN, ECM displays the
Copy menu. From here, you may give ECM
explicit directions on how it should copy a
cardfile. (See Chapter 18.)

on the Transfer Options menu and also
under the Reorder Fields menu. Since ECM
provides several options for copying a cardfile,
you may traverse to different levels from the
Copy menu. Choosing returns the
function labels to the values they have when
the Copy menu first appeared and cancels the
operation that you were doing. (5ee Chapter
18.)

on the Break Options menu under the
Print menu. Choosing includes
the current field in a running tally. (See
Chapter 17.)



Create
Cardfile

Create
Menu

Default
Values

Define
Block

Delete
Card

on the Cardfile Tasks menu. Choosing
displays the Create menu
and changes the function labels to values that
assist you in designing a new card form or
adapting an old form. (See Chapter 9.)

This message appears as the label for on
the Make/Adjust, Field Types, and Group
Fields menus. For the Field Types and Group
Fields menus, choosing
completes your work with that menu and
returns control to the Create menu. With the
Make/Adjust menu, choosing
returns control to the Create Menu WITHOUT
incorporating your changes. (See Chapter 9.)

on the Printer Setup menu under the
Print menu. From the Print menu, you may

choose [FINTITIRITIE to display a menu

where you specify characteristics for your

printer. Choosing sets the
value in each field to the standard values

ECM uses. (See Chapter 17.)

on the Adjust Block menu under the Print
menu. The Adjust Block menu creates a block
of text that ECM repeats across the page or
down the page when printing the cardfile. As
ECM allows you to modify the repeat block,

choosing sets the size of the
block to your specifications. (See Chapter 17.)

F5 on the Select menu. Choosing

(with confirmation) deletes the

card that currently appears on the Select
menu. (See Chapter 13.) If you want to delete

an entire cardfile, see TN IEITE .
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Delete
Cardfile

Dial
Phone
DIF

Format

ECH

Main

Edit
Field
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on the Cardfile Tasks menu. Choosing
(with confirmation) deletes
an entire cardfile. (See Chapter 10.) If you
want to delete individual cards, see

Delete Card B

on the Main and Select menus. From the
Main menu, choosing dials the
number in the Autodial field of the card with
the highlighted tab. From the Select menu,
you may choose any phone field on the card
form, then choose to call that
number. (See Chapters 13 and 16.)

on the Transfer Options menu. When you
choose one of the Transfer operations on the
Copy menu, ECM provides two labels so you
may specify how ECM should transfer the
information. Choosing transfers
the information in a special format that is

recognized by many software houses. (See
Appendix D.)

This message appears as the label for on
the following menus: Cardfile Tasks, Create,
Select, Add, Find, Sort, Copy, Print, and the
Modem menu. Choosing returns
ECM to the Main menu, WITHOUT com-
pleting the task that you began. The only
exception to this rule is the Select screen,
where any changes you make are incorporated
into the cardfile.

on the Find menu and on the Reorder
Fields menu which is under the Transfer
Options menu. If you want to modify the
contents of a field and the field is too small to
display all the symbols, you may choose

then make changes to the field’s
contents on the Input Line. (See Chapters 14
and 19.)



Exclude
Field

Exit

Exit
Borkset

Field
Types

File
Manager

on the Group Fields menu under the
Create menu. From the Create menu, you
may choose to tell ECM if it
should consider an individual field to be part
of a larger grouping. After establishing such a
group, you may remove a field from the active

group by choosing [EXSTTTEIIEN. (See
Chapter 19.)

on the Main menu. When you choose
BT, ECM asks for confirmation that
you want to leave the ECM program.
Choosing ends your current session.
(See Chapter 6.)

When you create a workset from a cardfile,
ECM updates the message for to read
T When you finish using the
workset, choosing returns ECM
to the Main menu with the current cardfile
showing. In this process, ECM discards the
workset; so if you want to retain the workset,
you must copy it before you choose

T . (See Chapter 10.)

on the Create menu. Choosing

displays another group of
function labels where you specify if a field
should be a Key field, Autodial field, Auto
Date field, or Auto Time field. (See Chapter
19.)

on the Directory, Copy, and Transfer
Options menu. Choosing brings
up the File Manager program. From here, you
may set another pathname as the default; find
files in any directory; return files to ECM; or
rename, delete, and browse files. (See
Appendix E.)
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Find
Cards
Find &
Vieuw
FullName
g Count
Get
Cardfile

Get
Fields

Get

Format
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on the Main menu. When you choose
EETFEEPE . ECM displays the Find menu.
You use this menu to search for cards that
meet particular criteria or to mark (or unmark)
a cardfile or workset. (See Chapter 14.)

on the Find menu. Use after
you have told ECM which cards you want to
isolate. When you choose ISIFTXHRM, ECM
searches the current cardfile and finds all the
cards that meet your criteria. (See Chapter 14.)

on the Cardfile Tasks menu. Choosing
displays the complete
pathname for the current cardfile and the
number of cards it contains. (See Chapter 12.)

on the Cardfile Tasks menu. Choose
when you want to view a
different cardfile or when no cardfile appears
as the current cardfile. (See Chapter 12.)

on the Print menu. Choosing
displays another group of function labels
where you specify how ECM should format
your cardfile and what fields it should print.
(See Chapter 17.)

on the Print menu. Choosing
recalls a previously defined set of instructions
for printing a cardfile. (See Chapter 17.)



Get

Values

Group
Fields

Hidden
Field

Include
Field

Label
Faormat

on the Modem menu and the Printer
Setup menu which is under the Print menu.
From the Print menu, you may choose

to display a menu that tells
ECM how your printer works. Choosing
sets the fields to values that you
have previously defined for another cardfile.
In a similar fashion, when you are filling in
the Modem menu, pressing [F1]loads values
that you have previously saved to configure
your modem. (See Chapters 16 and 17.)

on the Create menu. Choosing

accesses another group of
function labels where you may tell ECM to
consider individual fields as though they were
part of a larger grouping. (See Chapter 17))

on the Break Options menu under the
Print menu. When you choose [T ISTITE,
ECM only prints the contents of the current
field if it also appears in a sum, count, or
average field. (See Chapter 17.)

on the Group Fields menu under the
Create menu. From the Create menu, you
may choose to tell ECM which
tields it should group together. Choosing
adds the field in which the
cursor appears to the currently active group.

(See Chapter 17.)

on the Get Fields menu under the Print
menu. Choosing instructs ECM
to print the cardfile as mailing labels. (See
Chapter 17.)

Reference Guide to the Function Labels 20-9



Make/Adj
Field

Mark
All

Mark /
Unmark

Modem
Menu
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on the Create menu. Choosing

accesses another group of
function labels which you use to change a
field’s position or to widen, shorten, or
remove that field. (See Chapter 17))

on the Find menu. Choosing
marks every card in the cardfile or workset
you are using. An asterisk, which serves as
the mark, appears on the card’s index tab
when the cards are returned to their cardfile.
(See Chapter 13.)

on the Main and Select menus. Choosing
this label marks the card that appears on the
Select menu or whose index tab is highlighted
on the Main menu. (An asterisk appears in
the label to draw attention to this card.)
Subsequently, if you want to remove the
asterisk from the tab, choosing
returns the card to its unmarked condition.
(See Chapter 13.)

on the Copy menu. You normally merge
two files when you want to update one
cardfile with information from a subset of that
cardfile. However, you may also choose

to join two cardfiles together. (See
Chapter 18.)

on the Cardfile Tasks menu. Choosing
displays the Modem menu,
where you set special instructions for using
your modem and define Dial Codes to ease
your using the Autodial feature. (See Chapter
16.)



New
Group

Next
Auto Num

Next
Card

Next
Group

on the Group Fields menu under the
Create menu. From the Create menu, you
may choose to tell ECM
whether it should consider an individual field
to be part of a larger grouping. Choosing
updates the active group number
to the next available value between 1 and 10.
(See Chapter 9.)

on the Reorder Fields menu under the
Transfer Options menu. When you choose
one of the Transfer operations on the Copy
menu, ECM provides the
label so you may specify in which order ECM
should transfer the information on the card
form. Then, choosing updates
the value of to [FETEMTEME. Choosing
skips the next sequential

number n the transfer sequence. This creates
a phantom field, where you may insert a new
field on the new card form. (See Chapter 19.)

on the Select menu. Choosing
displays the next sequential card in the
cardfile. This action also saves any changes
that were made to the card on which you
were working. When ECM is displaying the
last card in the cardfile, choosing
brings up the first card. (See Chapter 13.)

on the Group Fields menu under the
Create menu. From the Create menu, you

may choose to tell ECM

whether it should consider an individual field
to be part of a larger grouping. Choosing
displays the next sequential

number for the active group number. (See
Chapter 9.)
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Next on the Printer Setup menu under the

value Print menu. From the Print menu, you may
choose to display a menu that
tells ECM how your printer works. All but
one of these fields have a predefined set of
values. Choosing displays the
next permissible choice for the current field.
(See Chapter 17.)

No on the Set Breaks menu under the Print
- menu. Choose [l when you don’t want
ECM to start a new page when the value in
the designated field changes. (See Chapter 17.)

This label also appears under certain tasks to
allow you to cancel a request.

Place on the Reorder Fields menu under the

Transfer Options menu. When you choose
one of the Transfer operations on the Copy
menu, ECM provides the
label so you may specify in which order ECM
should transfer the information on the card
form. Choosing updates the
value of to ETEYTYIITEMEN. Choosing
places the number that

appears on the Status Line in the current
field. Additionally, ECM increments the count
on the Status Line by one in preparation for
your entering the next number. (See Chapter
19))

Place on the Get Fields menu under the Print

menu. When designing a report, you use the
Get Fields menu to tell ECM which fields it
should print and how it should format these
fields. After you make these decisions,
choosing returns control to the
Print menu, where ECM paints the screen
with the design you requested. (See Chapter
17.)
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Previous
Card

Previous
Group

Previous
Value

Print
All Crds

on the Select menu. Choosing

displays the card that comes
before the card that currently appears on the
Select menu. (This action also saves any
changes you made to the card on which you
were working.) When ECM is displaying the
first card in the cardfile, choosing

brings up the last card. (See
Chapter 13.)

on the Group Fields menu under the
Create menu. From the Create menu, you
may choose to tell ECM
whether it should consider an individual field
to be part of a larger grouping. Choose

to display the previous

number for the active group number. (See
Chapter 9.)

on the Printer Setup menu under the
Print menu. From the Print menu, you may
choose to display a menu that
tells ECM how your printer works. All but
one of these fields have a predefined set of

values. Choosing displays the

previous choice for the current field. (See
Chapter 17.)

on the Print Options menu under the
Print menu. After you have fully specified
how you want ECM to print your cardlfile,

choosing prints the entire
cardfile. (See Chapter 17.)
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Print on the Select menu. Choose

Card to print individual cards. When you choose
ISP ECM prints the card that
currently appears on the Select menu
complete with its card borders, title, and field
labels. (See Chapter 13.)

Print on the Cardfile Tasks menu. Choosing
Cardfile displays the Print menu.
From here, you may use other labels to print

all or some of the information from the cards
in the current cardfile. (See Chapter 17.)

Print This message appears as the label for on
the following menus: Get Fields, Adjust Field,

Break Options, Adjust Block, and Print
Options. For the Break Options and Print
Options menus, choosing
completes the task of setting options and
returns control to the Print menu. For the
remaining menus, choosing
returns ECM to the Print menu, WITHOUT
completing the task which you began. (See
Chapter 17))

Print on the Print Options menu under the
IRl  Print menu. Choosing prints
the first card in the cardfile so you may verify

that everything is working properly before you
print the entire cardfile. (See Chapter 17.)

Print on the Print menu. Choosing
accesses another group of
unction labels where you tell ECM how much
information it should print and to what

device. It also provides access to the Printer
Setup menu. (See Chapter 17.)
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PrintOpt

Menu
Printer
Setup

Auick

Save

Redraw
Border

Remove
Field

Reorder
Fields

on the Printer Setup menu. Choosing
returns ECM to the Print
ption menu, WITHOUT saving the values you
have entered. (See Chapter 17.)

on the Print Options menu under the
Print menu. Choosing displays
he Printer Setup menu, where you may set
special characteristics for your printer. (See
Chapter 17.)

on the Copy menu. Choosing
makes a file-to-file copy of the three files that
constitute a cardfile. Although this procedure
is fast, it may be wasteful of disc space. (See

Chapter 18.)

on the Create menu. Choosing

displays other labels that allow
ou to redraw the card’s borders. (See Chapter

9.

on the Make/Adjust Field menu under the
Create menu, and the Adjust Field menu
under the Print menu. Choosing

deletes the field in which the
cursor appears. {(See Chapters 9 and 11.)

on the Transfer Options menu. When you
choose one of the Transfer operations on the
Copy menu, ECM provides this label so you
may specify the order in which ECM should
transfer the information. (See Chapter 19.)
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Replace assumes this value when you attempt to
copy a cardfile and a cardfile already exists
with the name you supplied. Choosing
overwrites the old cardfile with the
new cardfile. (See Chapter 18.)

Report on the Get Fields menu under the Print

menu. When designing a report, you use the
Get Fields menu to tell ECM which fields it
should print and how it should format these
fields. Choosing prints a
cardfile as a series of columns in report
format. (Additionally, ECM provides several
features so you may customize the report to
your specific needs.) (5ee Chapter 17.)

Reset on the Reorder Fields menu under the

Transfer Options menu. When you choose
one of the Transfer operations on the Copy
menu, ECM provides the
label so you may specify in which order ECM
should transfer the information. Choosing
updates the value of to
IXEIWMPEMA . Choosing

resumes numbering the fields automatically,
beginning with the number that currently
appears on the Status Line. (See Chapter 19.)

Restore on the Select and Sort menus. Use
Original IS N when you want to return
the card to its original form. You must take

this action, however, before you choose any
other function label. (See Chapters 13 and 15.)

Save on the Create menu. After you have
EILIEIPN  designed a card form, choosing
IIRELIEE saves the card form as a

permanent cardfile. (See Chapter 9.)
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Save
Changes
Save
Format
Save
Values

Select
All Flds

Select
Field

on the the Adjust Block menu. After you
complete your task, choosing

preserves the changes you made.

on the Print menu. After you fully specify
how ECM should print a cardfile, choosing
saves this information so you
may use it again. (See Chapter 17.)

on the Modem menu and the Printer
Setup menu which is under the Print menu.
From the Print menu, choose

then choose to display a menu
that tells ECM how your printer works.

Choosing stores the values so
you may subsequently recall them. In a
similar fashion, if you are filling in the
Modem menu, choosing stores
the information in this menu for future use.
(See Chapters 17 and 18.)

on the Get Fields menu under the Print
menu. When designing a report, you use the
Get Fields menu to tell ECM which fields it
should print and how it should format these
tields. Choosing includes all
the fields in the card form. You may
subsequently modify how the fields appear by
using the Adjust Field menu. (See Chapter
17.)

on the Get Fields menu under the Print
menu. When designing a report, you use the
Get Fields menu to tell ECM which fields it
should print and how it should format these
fields. Choosing this label includes the
cursor’s current field in the design for the
layout of the printed document. (See Chapter
17.)
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Set All
OneByOne

Set

Breaks

Set

Direc’'ry

Set/Clr
Autodial

on the Reorder Fields menu under the
Transfer Options menu. When you choose
one of the Transfer operations on the Copy
menu, ECM provides the
label so you may specify in which order ECV.
should transfer the information. When the
Reorder Fields menu appears, ECM
automatically numbers all the fields on the
card form. If you change this initial order
then decide to retain it, choosing

returns the number in the
fields to their original sequence. (See Chapter
19.)

on the Break Options menu. Choosing
accesses another group of
function labels where you can tell ECM
whether it should start a new page if the
value in a Break Option field changes. (See
Chapter 17.)

on the Cardfile Tasks menu. Choosing
allows you to set a new default
directory without accessing the File Manager
program. (See Chapter 19.)

on the Field Types menu under the Create
menu. Choosing marks the
cursor’s current field as the default Autodial
field. To clear this setting, move the cursor to
the Autodial field and choose

TSI . This clears the field of its
Autodial setting. (See Chapter 9.)
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Set/Clr
ERA]

Set/Clr
Descend

Set/(Clr
Keyl

on the Field Types menu under the Create
menu. Choosing marks the
cursor’s current field as an Auto Date field.
(ECM automatically stamps this field with the
date when you change any information on the
card form.) To clear this setting, move the
cursor to the Auto Date field and choose
ST This clears the field of its Auto
Date setting. A card form can contain one
Auto Date field. (See Chapter 9.)

on the Field Types menu under the Create
menu and on the Sort menu. This label tells
ECM whether it should sort key fields in
ascending or descending order. Normally,
ECM sorts cards in ascending order, so if you
want cards sorted in descending order, choose
to set this feature.
Subsequently, if you change your mind,
choose while the cursor is
within that field to revert to an ascending sort
order. (See Chapters 9 and 15.)

on the Field Types menu under the Create
menu and on the Sort menu. Choosing
marks the cursor’s current field
as the primary key field. Choosing it again
marks the primary key field as a numeric
field. To clear a primary key field, move the
cursor to the primary key field and choose
again. This clears the field of its
primary key setting. (See Chapters 9 and 15.)
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Set/Clr on the Field Types menu under the Create
Key? menu and on the Sort menu. Choosing

marks the cursor’s current field
as the secondary key field. Choosing it again
marks the secondary key field as a numeric
field. To clear a secondary key field, move the
cursor to the secondary key field and choose
again. This clears the field of its
secondary key setting. (See Chapters 9 and
15.)

on the Field Types menu under the Create
Key3

menu and on the Sort menu. Choosing
marks the cursor’s current field
as the tertiary key field. Choosing it again
marks the tertiary key field as a numeric field.
To clear this setting from a field, move the
cursor to that field and choose
again. This clears the field of its tertiary key
field setting. (See Chapters 9 and 15.)

Set/Clr on the Field Types menu under the Create
Time menu. Choosing marks the

cursor’s current field as an Auto Time field.
(ECM automatically stamps this field with the
time when you change any information on the
card form.) To clear this setting, move the
cursor to the Auto Time field and choose
ISR . This clears the field of its Auto
Time setting. A card form can contain one
Auto Time field. (See Chapter 9.)

Shorten on the Make/Adjust Field menu under the
Field Create menu and the Adjust Field menu
under the Print menu. Choosing

TSRSl deletes one character position

from the field in which the cursor appears.

Use if you want to delete the
entire field. (See Chapters 9 and 19.)
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Smallest
Depth

Smallest
Width

Sort
Cards
Sort &
View
Stop
Copying
Stop
Printing

on the Adjust Block menu under the Print
menu. The Adjust Block menu creates a block
of text that ECM repeats across the page or
down the page when printing the cardfile.
Choosing set the vertical
length of the repeat block to the smallest size
that will hold the given information. (See
Chapter 17.)

on the Adjust Block menu under the Print
menu. The Adjust Block menu creates a block
of text that ECM repeats across the page or
down the page when printing the cardfile.
Choosing set the horizontal
length of the repeat block to the smallest size
that will hold the given information. (See
Chapter 17.)

on the Main menu. Choosing I IRRCIEH

displays the Sort menu where you may resort
the cards in a cardfile. (See Chapter 15.)

on the Sort menu. When you choose
XYM ECM reorganizes the current
cardfile according to the new key fields which
you have specified. ECM displays the results
as a workset of the current cardfile. (See
Chapter 15.)

when appending, merging, or transferring
in information from the Copy menu. When

you choose IRTIXTITIUEE. ECM stops the
operation at that point. (See Chapter 18.)

when a printing operation is in progress.

When you choose BT EISUII0rE ECM stops
the operation at that point. (See Chapter 17.)
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Sum on the Break Options menu under the
Print menu. Choosing includes the
value of the current field in an accumulating
sum. (See Chapter 17.)

T on the Print Options menu under the
File Print menu. Choosing prints the
cardfile to a disc file for storage. (See Chapter
17.)
T

on the Print Options menu under the
Print menu. Choosing, prints the

cardfile to the printer that you have specified

in the Printer Setup menu. (See Chapter 17.)

o]
[e]

To on the Print Options menu under the
Print menu. Choosing prints the
cardfile to your computer’s display. You may
choose this option so you may verify that
everything is working properly before printing
the cardfile to paper or to a disc. (See Chapter
17.)

on the Adjust Block menu under the Print
Down

menu. The Adjust Block menu creates a block
of text that ECM repeats across the page or
down the page when printing the cardfile.
Choosing shifts the border of
the repeat block down one line. The
information above the repeat block is repeated
at the beginning of each page, while the
information within the repeat block is
repeated down the page or across the page.
(See Chapter 17.)
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Top Edge on the Adjust Block menu under the Print
menu. When creating a repeat block of text,
you may include titles or headings by
choosing to include this text
within the repeat block. (See Chapter 17.)

Transfer on the Copy menu. Choose
In to bring in information from other programs
to ECM or to move information from a
holding file into a modified ECM card form.
(See Chapter 19.)

Transfer on the Copy menu. Choose
out to transfer the information from a cardfile for
use with other programs or to be stored in a
holding file while you change a ECM card
form. (See Chapter 19.)

on the Find menu. Choosing [N
ALl

(with confirmation) removes the asterisk from
the tab of every card in the current cardfile or
workset. (See Chapter 14.)

Unselect on the Get Fields menu under the Print
menu. When specifying which fields ECM
should include in the printed document, you
may change your mind. In this case, choosing

SRR LE removes all the field

numbers from the current list of chosen fields.
(See Chapter 17.)
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Unselect on the Get Fields menu under the Print
Field menu. When designing a report, you use the
Get Fields menu to tell ECM which fields it
should print and how it should format these
fields. If you initially included a field in the
printed document then changed your mind,
you may move the cursor to the appropriate
field and choose to remove
this field from the list of chosen fields. (See
Chapter 17.)

View on the Find menu. Choosing [T
Marked

creates a workset that contains all the marked
cards in a cardfile. (See Chapter 14.)

Widen on the Make/Adjust Field menu under the
Create menu and the Adjust Field menu
under the Print menu. Choosing
adds one character position to the field that
contains the cursor. (See Chapters 9 and 19.)

Yes on the Set Breaks menu under the Print
menu. Choosing directs ECM to start a
new page when printing the report if the
value in the indicated field changes. (See
Chapter 17.) This label also appears under
certain tasks to confirm that you want to
complete the current operation.
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ECM Specifications

Cardfile features ® Number of cardfiles limited by disc capacity
@ Up to 64,000 cards per cardfile

B Free-form cardfile creation by “drawing” the form on the
screen or by using an existing form

& Up to three key fields

Card features ® Up to 11 screens (255 lines) of information per card

B Automatic date and time stamping

Sorting features Reassignable key fields

Temporary or permanent sorts

v xipuaddy

Ascending or descending order

Numeric sort
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Searching features

Telephone features*

Merge features

Report features

A-2 ECM Specifications

Search criteria include: <, >, <=, >=, =, NOT, and
logical combinations of them

Literal or numeric searches
Wildcard searches
Multiple-field searches
Group-field searches

Mark resulting subsets

Multiple number of autodial fields

@ Up to 8 pre-definable phone macros

®m Pulse and tone compatibility

Merges cardfiles with automatic card update

User-definable report format and content
Report width of up to 255 characters
Retrievable report format

Unlimited report length

Performs totals, sub-totals, counts, averages, and page
breaks

Access to escape sequences

| Prints to screen, printer, or a file

*requires modem



Mailing label features User-definable label format and content

Multiple labels across

u
u
m Limited form-letter generation capability
® Retrievable label format

u

Prints to screen, printer, or a file

Integration features = Runs with HP Access

m Conversion utility for Personal Card File cardfiles

Data compatibility with Lotus 1-2-3™, Executive
Spreadsheet, WordStar, MailMerge, dBASE, BASIC,
and Condor

v xipuaddy
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Converting PCF Cardfiles and
HP 150 ECM Cardfiles

Both Executive Card Manager and Hewlett-Packard’s
Personal Card File (PCF) use the image of a cardfile to
store information. If you attempt to use a PCF cardfile with
ECM, however, ECM informs you:

Improper cardfile version-not an ECM cardfile-

The first section in this appendix describes the necessary
procedures to convert your PCF cardfiles, so their
information is available to ECM. (While the procedures
assume you have a dual, flexible disc drive, you can easily
modify the procedures if you are using a fixed disc.)

The second section in this appendix describes the
procedures to convert an HP 150 ECM cardfile to an ECM
cardfile for your personal computer.

Converting a Your Setting Up Executive Card Manager manual describes
PCF Cardfile how you install and authorize the ECM program. Since the
conversion utility is an easy-to-use tool that assists you in
converting your cardfiles, you needn't follow those
instructions to install the conversion disc. Instead,
you only have to follow these simple steps to load
the conversion utility into your computer’s memory and
then follow the explanatory instructions on your display.

g xipuaddy
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To load the conversion utility:

1. Start from the PAM menu.

2. Insert the disc that contains the conversion utility into
one of your drives.

3. Choose [TTITTITEEY.

A box for the conversion utility appears on the PAM
menu.

4. Choose |EXCETEETN.
5. Choose to display the conversion
utility’s Main menu:

6. After the menu appears, you may remove the utility
disc from its drive.

You are now ready to convert your PCF cardfiles. The next
procedure describes converting cardfiles from a PCF work
disc and placing them on another work disc. If you are
placing the converted cardfiles on a brand new disc,
remember to format the disc before you begin.

To create a new cardfile:

1. Insert the disc with your PCF cardfile into a drive.

2. Insert a disc to hold the new ECM cardfiles into the
other drive.
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If you are using a fixed disc, you should place your PCF
cardfile disc in the flexible drive and store the new ECM
cardfiles in the proper directory on your fixed disc.

Enter the name for the PCF cardfile you want to
convert. (Remember to provide the proper pathname.)

Press to move the cursor to the Destination
field.

Enter the full cardfile name for the new ECM cardfile.
Choose IO
ECM informs you it is:

Converting cardfile-

If you decide to cancel the operation, choose

[ Cancel B

Only choose once. ECM detects the keystroke and
puts your file system in order before it comes back to you
for further instructions.

After ECM restores your directory, it displays the
message:

CONVERSION CANCELLED.

You may now enter different names or leave the
program.

If you allow the operation to finish, the message
CONVERSION COMPLETE appears, and control returns

Converting PCF Cardfiles and HP150 ECM Cardfiles B-3
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to the conversion Main menu. You may now convert
another cardfile or leave the program.

After you finish converting your PCF cardfiles, choose
L exic B
The PAM menu appears on your display.

To replace an old cardfile:

When you are converting a PCF cardfile, you may also
supply the name of an existing ECM cardfile and replace
that cardfile with the PCF cardfile.

1.
2.
3.

Start from the conversion Main menu.
Insert the disc that contains your PCF cardfiles.

Enter the full cardfile name (including pathname) of
the PCF cardfile.

Press [Ener | to move the cursor to the Destinatian
field.

Enter the full cardfile name of the ECM cardfile you
want to replace.

Choose TS SIRN .

Because an ECM cardfile exists with this name, the
conversion utility requests additional information.

Caution If you decide against replacing the PCF cardfile, you should
press to cancel the operation now.

7.

Choose [IXTTEES.
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Once the operation is over, the message CONVERSION
COMPLETE appears and control returns to the
conversion Main menu.

If problems arise:

The conversion utility should convert your PCF cardfiles
without any problems. However, if you see any of the
following messages on your display, you should follow
these instructions to isolate the problem.

If you see the message:

Can't open or read the file CONVERT.MNU. Check
your disc

the operating system failed to locate the necessary files to
load the convert utility. This may happen if the file was
accidentally deleted or trashed. In any event, insert the
conversion utility master disc into a drive and follow the
procedure to load the conversion utility.

If you see the message:
The cardfile could not be found

the conversion utility failed to locate a PCF cardfile with
the name you supplied. In this case, exit the conversion
utility. When the PAM menu appears, choose

and verify that the PCF cardfile is on that
disc. (You can identify a PCF cardfile as being the base
name before the .PDT, -PFM, and .PIX extensions.) If the
cardfile does exists, follow the procedure in Appendix F on
When a disc error occurs.

>
S
S
@
3
2
x
o}
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Converting an When you use an HP 150 ECM cardfile on your personal

HP 150 ECM computer, you'll notice that the border is displayed as a
. thick bold line. You can use the cardfile as is or, you can
cardflle convert the HP 150 ECM cardfile into a new cardfile with

the proper border on your personal computer.

To convert an HP 150 ECM cardfile, you must follow these
procedures to redraw your cardform, then transfer the
information from the HP 150 ECM cardfile into your new
cardfile.

To convert an HP 150 ECM cardfile:

1. Start from the ECM Main menu.

2. Choose XTI

3. Choose |-
The Create menu appears.

4. Choose IFTTDEETE
ECM asks you to:

Type a cardfile name and press ENTER.

5. Enter the full cardfile name (including pathname) of
the HP 150 ECM cardfile and press [Enter].

ECM informs you it is:
xxxGetting 01d Formxxx

6. When the cardform is displayed on your screen,

choose EERTS.
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10.

Move the cursor onto the row for the bottom border.

Choose again. The thick bold line is
replaced with the proper border form.

Choose HTIXEIFTIGE -
ECM asks you to:
Type a cardfile name and press ENTER.

Enter a new name for the cardfile (remember to
provide the proper pathname), and press [Enter].

You are returned to the ECM Main menu.

To merge information from an HP 150 ECM cardfile:

Now you are going to merge the information from the HP
150 ECM cardfile into the new cardfile on your personal
computer.

1.

Choose TS .

2. Choose [T The Copy menu appears.
3. Choose on the Copy menu.

When you choose |EEETN, the following menu is
displayed.

>
B
°

®

=]

a
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o
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Executive Card Manager copPy Cardfile: C:\ADRES“\
Select the type of copy, the file namd, then press "Copyly S :

Copy Type: Merge
Source (qgrd)file: )
RNABBRUEDT e

Destination (card)file:

S XADDRESS

8 % S File cYransfer TTransfers ECH
Manager  In Out Matn

L

4. In the Source (card)file field, enter the name of your
HP 150 ECM cardfile (remember to include the proper
pathname).

5. Choose TR
ECM tells you it is:

xxxMerging from cardfile on discxxx

When ECM is finished copying, it displays the message:
xxxCopy completexxx
6. Choose to return to the Main menu.
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For Fixed Disc Users

This manual describes using ECM with a dual, flexible disc
drive (a typical situation for most users). If you have a

fixed disc, however, this appendix explains how you should
interpret portions of the manual to account for your needs.

Since a fixed disc can store more information than a
flexible disc, you may create several large cardfiles and put
them in subdirectories on your fixed disc (which may also
hold your computer’s operating system and the ECM
Application program). Thus, when working with a fixed
disc, you must be aware of the pathname for your cardfiles
and be ready to take special steps if you want to copy a
large cardfile from your fixed disc to a flexible disc. The
next sections give the necessary details.

For Fixed Disc Users C-1
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Working with

ECM on a Fixed
Disc

C-2 For Fixed Disc Users

When you first connect your hard disc to your personal
computer and configure your system, the operating system
recognizes the flexible disc drive as drive A. (This happens
because, without any additional instructions, the computer
must load its operating system. Hence, it looks to drive A
for this information.) Therefore, to use your hard disc, you
first load the operating system from the flexible disc in
drive A. After you have done this, you may then copy the
operating system to your hard disc. The operating system
recognizes the hard disc as drive C. See the owner’s
manual for your personal computer for complete
instructions on setting up your hard disc and for installing
application programs (such as ECM) on a hard disc.

After you install ECM on your hard disc, a box for ECM
appears as one of the choices on the PAM menu. Simply

highlight this box, then choose or press
to start the ECM program.

You can put your cardfiles on your fixed disc, or you may
put them on a flexible disc in drive A. Remember,
however, to include the drive designator (A:) to identify
the flexible disc drive when you want to store cardfiles on
a disc in drive A.



You may also run ECM from the flexible disc drive, by
inserting a work disc with the ECM Application program
in drive A. Furthermore, if your computer has several disc
drives, you can install ECM in any of the drives. Just
remember to supply the correct pathname when you are
naming your cardfiles.

The rules concerning the setting of a default pathname for
fixed discs and flexible discs are the same. That is, unless
you change the default settings, the drive that contains the
program you are running is the default drive. For example,
if you are running ECM from a flexible disc in drive A,
drive A is the default drive (unless you start ECM from a
different drive or until you change the default).

9 xipuaddy
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Copying a Large
Cardfile to a
Flexible Disc

C-4 For Fixed Disc Users

Because a fixed disc stores more information than a flexible
disc, you can create a cardfile on a fixed disc that is larger
than a single, flexible disc can hold. To copy such a cardfile
to a tlexible disc, you must divide the cardfile then copy
the parts onto two or more flexible discs. For example,
assume that your Address Book cardfile is too large to copy
to one flexible disc, but it easily fits on two discs.
Therefore, if your cardfile is arranged alphabetically by last
name, you could take these steps to copy the cardfile to
two flexible discs:

1. Divide the cardfile into two parts (see Chapter 14).

For example, you could create one cardtfile for people
whose last names begin with the letters A through M,
and another cardfile for those names from N through
Z. When you finish this task, you have three cardfiles
on your fixed disc: your original Address Book
cardfile, and two smaller cardfiles that contain a
portion of the Address Book.

2. Copy the first cardfile (names A through M) to the
first flexible disc. (See Chapter 18.)

3. Now copy the other cardfile (names N through Z) to
another flexible disc.

Once you have finished copying both cardfiles, you can
delete the cardfiles on the fixed disc if you have no further
use for them. (Chapter 10 explains how you delete
cardfiles.)

When a fixed disc contains a cardfile that is too large to fit
on two flexible discs, just modify this procedure to divide
the original cardfile into three, four, or more pieces. Then
copy each piece to a separate flexible disc.



Using ECM with Other Programs

Because ECM recognizes files written in either BASIC or
DIF format, you may use your ECM cardfiles with a wide
variety of programs.

For example, using BASIC format, you can:

® Send the information recorded in ECM cardfiles to
CONDOR or dBASEII to make your files more widely
available.

B Send ECM information to MailMerge and use it with
form letters and other documents prepared on WordStar.

® Put ECM information in a BASIC program and use it in
computations or for other program manipulations.

Using DIF format, you can:

B Send information from ECM cardfiles to LOTUS 1-2-3
databases or VisiCalc spreadsheets.

B Move information to an ECM cardfile from a LOTUS
1-2-3 or VisiCalc spreadsheet.

This appendix gives general guidelines about using ECM
with different application programs. If you desire further
information about a particular program, see the manual
that describes that application.
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Differences in

Terminology

Here are some terms that you should know before you use
ECM with other programs.

When you send information from a cardfile to another
program, ECM calls this task transferring out. When you
bring information into one of your cardfiles, ECM calls this
task transferring in. Furthermore, other programs use a
different terminology to describe objects that resemble
ECM cardfiles. In particular:

® a card form in ECM is a form in other programs

B a cardfile in ECM is a database in other programs

Remember that a file differs from a ECM cardfile. That is,
three files constitute one ECM cardfile:

B an .EDT file holds the information
B an .£FM file holds the card form
B an .EIX file tells how to sort the cards

Chapter 7 provides more information about ECM cardfile
names.
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Character Sets This section applies only to those that use other than the
U.S. characters.
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The following table shows that certain characters typed
from the Standard (IBM8) or Norwegian/Danish keyboard
will appear on your screen as a Roman8 equivalent

character.
Numeric Value Graphic Description Roman8 Equivalent
Standard (IBMS)
158 Pt Spanish currency symbol P
Norway/Denmark
158 L: Albanian letter L
159 L: lowercase L: 1
171 / script 1 Y
172 n Afrikaans letter n
174 3 cube 3
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Choosing the

Proper Format

ECM allows you to transfer information to and from other
application programs by choosing between BASIC and DIF
format. Once you choose the proper format for
communicating between ECM and the other program, ECM
automatically converts your cardfile information to that
format when it transfers the information.

Since transferring information is a copy operation, you tell
ECM how to transfer information from the Copy menu.

When the Copy menu appears, the function labels have
the following values:

If you choose either or IUENENE, ECM

displays the following function labels:

ECM normally uses BASIC format, but you may explicitly
choose DIF format if the program you are transferring
information to or from uses this format. (Consult the
reference manual for your application program to see what
format it uses.)
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Using BASIC Format

In BASIC format, ECM writes the information in a cardfile
as an ASCII file of quoted strings, where double quotation
marks appear around each string and a carriage return
character separates each record.
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Since BASIC format depends so heavily on double
quotation marks, you should avoid using quotation marks
within the text of a field. (If you want to quote information
within a field, use an apostrophe as a single quotation
mark.)

Each string represents the contents of one field on your
card form. If ECM encounters a blank field, it sends an
empty string (“ ) for this field.

For example, suppose you have a card form with the
following fields:

a title field

a first name field

a last name field

a street address field
an apartment field

a city field

a state field

a zipcode field
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Then, two BASIC records (where each record contains the
information in one card form) might appear as:

“Mr”, “Artie”, “Shaw”, “189 Broadway”, “Apt. 6C", “New
York”, “NY”, “10036"

“Mr”, “Louis”, “Armstrong”, “1789 Bourbon St.”, ”, “New
Orleans”, “LA", “70130”

BASIC format uses a carriage return character to separate
each record in the resulting ASCII file.

Notice that Louis Armstrong’s card has no apartment
number. Hence, a blank field (shown as “ ) reserves space
for this field. It is mandatory that this empty field appear;
otherwise, ECM becomes confused and interprets “"New
Orleans” as the apartment number, “LA” as the city, and
“70130” as the state.
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Other application programs may distinguish between
character fields (those containing words) and numeric
fields and not put quotation marks around these fields. In
fact, certain application programs only use quotation marks
to avoid confusion when a comma appears within a field.
For example, in a CONDOR record, the ZIP code field may
be separated from the state field by a comma, rather than
quotes, as in “NY”, 10036.

ECM treats each field as if it were a character field; thus it
places double quotes around the contents of every field.
Considering the same example used above, ECM would
send the state and ZIP code fields as “NY”, “10036".
Nevertheless, ECM correctly interprets the CONDOR file
because of the way ECM determines the limits of a field.
ECM reads a record one character at a time. It opens a
field at the beginning of a record or when it encounters a
double quotation mark. When a field opens with a double
quotation mark, ECM closes the field at the next double
quotation mark that is followed by a comma or (if the field
is the last field in that record) by a carriage return. When a
field begins without a double quotation mark, ECM closes
the field at the next comma or carriage return character.

Other application programs can read ECM’s all-quoted

format, since they also determine where a field begins and
ends in essentially the same manner.
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Using DIF Format  If you are transferring information with ECM, choosing
selects DIF format. (ECM removes the asterisk
for the label and places it in the
label.)

The DIF format is another standard file format that permits
different application programs to share information. When
you save a file using DIF format, it becomes a text file that
other DIF-supporting programs can read.

To ease the transfer of information between programs, DIF
format uses several simplifying techniques:

& The first part of the file gives the file's size.

® Records are kept as short as possible.

@ The format explicitly declares whether a piece of
information is a character string or a number.

B Character strings are stored one per line.

B Strings that contain special characters are enclosed in
quotation marks.

B The file ends with an explicit End-Of-Data record.

Since ECM automatically constructs the DIF file for you,
you needn’t concern yourself with these details unless you
are writing your own programs to read a DIF file. If you
want additional information on using DIF, you may write
to:

DIF Clearinghouse
PO. Box 527
Cambridge, MA 02139
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Transferring
information to
Another Program

Caution w

When you transfer information to another application
program, ECM first makes a copy of the information
contained in your original cardfile so the information in
that cardfile remains unchanged. Then, during the copying
process, ECM translates the information using a specific
format that the target program can understand. When you
are specifying how ECM should copy a file, unless you
explicitly tell ECM to translate the cardfile in DIF format,
ECM passes the information in BASIC format.
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You can send all the information in your cardfile to another
program, or only a portion of it. Furthermore, you may
rearrange the order in which ECM transfers the
information. (Refer to Chapter 19 for details on the Transfer
copy operation.) Please refer to this chapter for full details.
In general, though, transferring information to another
program involves two operations:

® First you enter ECM and transfer out the information to
a holding file.

® Then you enter the other application program and read
in the information so you can use it.

For some programs, the holding file becomes a permanent file.
For others, you can delete the holding file after you finish the
transfer. The following sections provide the necessary
information for each application program.
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Remember these points when you plan to transfer
information to another program.

8 You must transfer the information from your ECM card
form so it corresponds to the fields in the file where you
are transferring them.

# Make sure that the fields in the destination file are the
same length (or longer) than the corresponding fields in
your ECM card form. Otherwise, any information that
doesn't fit in the destination fields is lost.

B Applications vary in the way they treat information
when the card form contains a different number of
fields. Most transfer operations work if the destination
form has at least as many fields as the ECM card form.
Some applications, however, allow the destination file to
have fewer fields. Consult the manual for the program
you are using to see what stipulations apply.

The following text places angled brackets (< >) around
parameters within a command line. You should supply the
appropriate name for the descriptive term that appears
within these brackets.
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Transferring
Information to
CONDOR

Follow this procedure to transfer information from an ECM
cardfile to a CONDOR program.

1.
2.

Enter ECM and get the cardfile you want to transfer.

Follow the instructions in Chapter 19 to transfer the
necessary information, using BASIC format, to a
holding file.

Enter the CONDOR program.

When you are transferring dates from fields where
you used a YY/MM/DD format, type the command:

SET DATE YY/MM/DD

This step is necessary because CONDOR normally
reads dates in a MM/DD/YY format.
Then, to direct CONDOR to transfer the information,
type:

READ <database> <holding file>
For example, assume that you transferred the
information from a cardfile called CLIENTS into a
holding file named CLIENTS.BXF and that you are

now ready to transfer it to a CONDOR database
named CONTACTS. In this case, you would type:

READ CONTACTS CLIENTS.BXF

After you finish transferring the information, you can
delete the holding file (CLIENTS.BXF) if you wish.
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Transferring  Follow this procedure to transfer information from an ECM
Information to cardfile to a dBASEII program.

dBASEHN 1. Enter ECM and get the cardfile you want to transfer.

2. Follow the instructions in Chapter 19 to transfer the
necessary information, using BASIC format, to a
holding file.

3. Enter the dBASEl program.
4. To direct dBASEII to transfer the information, type:
APPEND FROM <holding file> DELIMITED

For example, assume you transferred the information
from a cardfile called CLIENTS to a holding file
named CLIENTS.BXE and you are now ready to
transfer it to your dBASEII database. In this case, you
would type:

APPEND FROM CLIENTS.BXF DELIMITED

After you finish transferring the information, you may
delete the holding file if you wish.
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Transferring
Information to
MailMerge

Follow this procedure to transfer information from an ECM
cardfile to a WordStar program.

1.
2.
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Enter ECM and get the cardfile you want to transfer.

Follow the instructions in Chapter 19 to transfer the
necessary information, using BASIC format, to a
holding file. (This becomes your permanent WordStar
datafile.)

Enter the MailMerge program.

Insert this command in your master WordStar
document:

-DF <filename>
For example, assume you transferred the information
from a cardfile called CLIENTS to a holding file
named CLIENTS.BXE. The holding file becomes a

permanent Wordstar datafile named CLIENTS.BXE,, so
you should insert:

.DF CLIENTS.BXF
Now insert this command:

.RV <variableA>. <variableB>-
<variable(>. ... <variableZ>

Each variable is a field that you transferred to
MailMerge. For example, if you transferred five fields
for a person’s name and address from your cardfile,
<variableA > is the first field (for example, Name),
<variableB > is the second field (Street), and so
forth. That is, for this example, you could enter:

-RV NAME- STREET. CITY. STATE. ZIPCODE
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6.

Then, in the master document, include
g&<variableA>8. &<variableB>&, and so on,
wherever you want the information in those fields to
appear.

For example, you would refer to the five fields that
you transferred by entering: 8NAMES. & STREET&-
8CITY&+ &STATER~ or 8ZIPCODER at the appropriate
place.

See your WordStar/MailMerge manual for information on
setting up your master document.

D-14 Using ECM with Other Programs



Transferring
Information to a
BASIC Program

Follow this procedure to transfer information from an ECM
cardfile to a BASIC program.

1.
2.

Enter ECM and get the cardfile you want to transfer.

Follow the instructions in Chapter 19 to transfer the
necessary information, using BASIC format, to a
holding file. This becomes your permanent BASIC
data file.

Enter the BASIC program.

Because BASIC treats the data file from step 2 as a
sequential access file, you may use it as such in your
BASIC programs. (Consult your BASIC manual for
more information.)
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Transferring  LOTUS 1-2-3 allows you to specify a task by typing a series
Information to  of commands (where each command determines what
LOTUS 1-2-3  additional commands are appropriate). The following
procedure describes one possible sequence. See your
LOTUS 1-2-3 owner’s manual for more information.

1. Enter ECM and get the cardfile you want to transfer.

2. Follow the instructions in Chapter 19 to transfer the

necessary information, using DIF format, to a holding
file.

3. Enter the LOTUS 1-2-3 program.

4. To direct LOTUS to transfer the information, enter the
following sequence of commands:

File Import
Numbers
then enter the file's name

The Numbers format looks for the quoted strings that the
BASIC format supplies.

You may also use the Translate utility to create a worksheet
from a DIF file by specifying DIF to WKS. (See your
LOTUS 1-2-3 manual for further information.)
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Transferring
Information to
VisiCalc

Follow this procedure to transfer information from an ECM
cardfile to a VisiCalc program.

1.
2.

Enter ECM and get the cardfile you want to transfer.

>
k]
°
o
3
=
x
@)

Follow the instructions in Chapter 19 to transfer the
necessary information, using DIF format, to a holding
file.

Enter the VisiCalc program.

To direct VisiCalc to transfer the information, enter
the following sequence of commands:

STORE

# (to indicate DIF format)

LOAD
then type the file’s name
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TranSferring Reading information into an ECM cardfile from another
information from program is also a two-part procedure:
Another Program ® First you use the application program to place the

information in a holding file.

# Then you use ECM to transfer in the information to the
cardfile where you want to use it.

You should remember these points when you are
transferring information from another program to a ECM
cardfile:

B After transferring the information to a holding file, you
can specify the sequence in which ECM should transfer
the fields so they correspond to the fields in your card
form.

B When a field in the source file is longer than the
corresponding field in your card form, ECM only copies
that information which fits. Thus, you must ensure that
the fields are long enough to hold the information you
are transferring. When the source field is shorter, ECM
pads the remaining room in the card’s field with blanks.
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B When the source file contains more fields than your card
form, ECM ignores the information from the extra fields.
That is, if the source file has seven fields while the ECM
card form has only five, ECM uses the information from
the first five fields and ignores the information in the
last two.
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# When the source file contains fewer fields than your
card form, ECM copies the information from the source
fields then leaves the remaining fields blank. That is, if
the source file has five fields while the ECM card form
has seven fields, ECM transfers information into the first
five fields then leaves the last two fields blank.

& To simplify sorting and searching, you may have entered
dates in your ECM cardfiles as year, month, day
(YY/MM/DD). Even though other programs may give
dates in the order of month, day, and year
(MM/DD/YY), you can still transfer in dates from such
programs. However, you must later reenter the dates if
you plan to use the dates for sorting and searching.

@ Remember that a very large database may contain more
information than can fit in your cardfile or on a flexible
disc. See the manual for the particular program you are
using for more information on dividing a large database
into two or more smaller files.
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Transferring  Follow this procedure to transfer information from a
Information from CONDOR database to an ECM cardfile.

CONDOR 1. Using CONDOR, enter this command:
WRITE <database> <holding file> B

For example, assume you want to transfer information
from a CONDOR database named INVOICES to a
holding file called DEBTS.NEW for transfer to ECM.
You would enter:

WRITE INVOICES DEBTS.NEW B
(The B instructs CONDOR to transfer the information
in BASIC format.)
2. Enter ECM.

3. Follow the instructions in Chapter 19 to transfer the
information, using BASIC format, into your ECM
cardfile. (Remember to reorder the fields, if
necessary).
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Transferring
Information from
dBASEH

Take these steps to transfer information from a dBASEII
database to an ECM cardfile.

1. Using dBASEII, enter this command:
COPY TO <transferfile> DELIMITED WITH"

For example, suppose you want to put information
from a dBASEII database you are using in a holding
file named RECEIPTS.NEW so you may transfer the
information to an ECM cardfile. You would enter:

COPY TO RECEIPTS-NEW DELIMITED WITH "

(DELIMITED WITH ™ instructs dBASEII to transfer the
information as quoted strings in BASIC format.)

2. Enter ECM.

3. Follow the instructions in Chapter 19 to transfer the
information, using BASIC format, to your ECM
cardfile.

Remember to give ECM the order in which it should
transfer the fields, if the sequence numbers of fields
in the holding file differs from the order of fields on
the ECM card form.
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Transferring  Follow this procedure to transfer information from a BASIC
Information from program to an ECM cardfile.

a BASIC Program 1. Using BASIC, with the information you want to
transfer stored in memory, enter this command:

SAVE "<datafile>". A

For example, if you want to put information from a
BASIC data file called STATS in a holding file called
RESULTS.NEW, you would enter:

SAVE "RESULTS.NEW™~ A
(The letter A instructs BASIC to transfer the

information as ASCII strings rather than using a
compressed binary format.)

2. Enter ECM.

3. Follow the instructions in Chapter 19 to transfer the
information, using BASIC format, to your ECM
cardfile.

Remember to give ECM the order in which it should
transfer the fields, if the sequence numbers of fields
in the holding file differs from the order of fields on
the ECM card form.
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Transferring
information from
LOTUS 1-2-3

Follow this procedure to transfer information from a
LOTUS 1-2-3 database to an ECM cardfile.

1.

Using the LOTUS 1-2-3 Translate Ultility, create a DIF
file by using the command WKS to DIF.

Enter ECM.

Follow the instructions in Chapter 19 to transfer the
information, using DIF format, to your ECM cardfile.

Remember to give ECM the order in which it should
transfer the fields, if the sequence numbers of fields
in the holding file differs from the order of fields on
the ECM card form.
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Transferring  Follow this procedure to transfer information from a
Information from  VisiCalc spreadsheet to an ECM cardfile.

VisiCalc 1. Enter the VisiCalc program and create a DIF file by
entering the following sequence of commands:

STORE

# (to indicate DIF format)
SAVE

then type the file’s name

2. Enter ECM,
3. Follow the instructions in Chapter 19 to transfer the
information, using DIF format, to your ECM cardfile.

Remember to give ECM the order in which it should
transfer the fields, if the sequence numbers of fields
in the holding file differs from the order of fields on
the ECM card form.
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Using File Manager

As its name implies, File Manager manages the three files
that make up your ECM cardfile (as well as the files you
create with other application programs).
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You may use File Manager in the following ways:

® to look at a list of files under a different pathname
B to change the default pathname

& to set up subdirectories

& to delete a file or directory

& to copy a file

B to rename a file

This appendix describes how you may use File Manager to
set a ditferent pathname, to rename a cardfile, and to
locate a cardfile. Appendix G explains how you use File
Manager to copy the files in a cardfile. See the owner’s
manual for your personal computer for information on the
other tasks that File Manager performs.

You may enter File Manager from the PAM menu or from
the label on some ECM menus. When you
enter File Manager from PAM, the File Functions menu
appears directly. However, when you enter from ECM,
ECM first displays the File Manager Main menu. From
here, you choose to reach the File
Functions menu.
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How File
Manager Stores
Your Files

E-2 Using File Manager

ECM breaks a cardfile into three disc files and gives each
file a name that consists of the cardfile name, a period (. ),
and a three-letter extension. For example, if you named a
cardfile IMPORTS, ECM creates three files:

B IMPORTS.EDT
B TMPORTS.EFM
B IMPORTS.EIX

Then, if you use File Manager to display the names of
your files, you see the names for these three files; not your
cardfile’'s name: IMPORTS.

Each of these files also has a pathname that tells where it
is stored. (See Chapter 7 for more information.) Remember
that the form of the pathname may vary depending on
your personal computer’s operating system. For example,
with the DOS operating system, a pathname consists of a
drive name and a series of directory names.

File Manager displays the drive name as a letter, followed
by a colon, then a backslash (for example, A:\ or B:\).
The backslash (\) indicates the Main directory for the disc
in that drive. For example, when you are using drive A
and the disc contains no subdirectories, the File Manager
Main menu lists: Displayed Dir: A:z\.

File Manager identifies the Main directory with a single
backslash. One or more subdirectories can follow the Main
directory, and each subdirectory is followed by another
backslash. For example, A:\JEFF\BUSINESS\ identifies
Jeff’'s business subdirectory on the disc in drive A.



Working with
Pathnames

Floating the
Default Drive

ECM always assumes you want to store your cardtiles
under a particular pathname. With an DOS operating
system, ECM breaks the pathname into a default drive and a
default directory. Unless you tell ECM otherwise, ECM
always searches for or stores your cardfiles in this location.

When you start ECM, the default drive is the one that
contains the ECM Application disc. Furthermore, the
directory in which you have installed ECM becomes the
default directory. For example, if you put your working
copy of the ECM Application disc in drive A (and ECM is
installed in the Main directory of your disc), then A is the
default drive and the Main directory is the default
directory. If you later put the ECM Application disc in
drive B, then B becomes the default drive. That is, the
default drive floats with the ECM Application disc.
However, the Main directory remains the default directory
until you change it.
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When working with ECM, if you call File Manager to set a
different default drive or directory, ECM remembers this
change even after you exit the program. Therefore, the
default drive no longer floats with the Application disc;
rather when you enter ECM again, ECM sets the default
drive and directory to the last values you used.

If you want to return to the floating default drive, simply

enter ECM again and change the default drive to the one
that currently holds the ECM Application disc.
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Changing the
Pathname

E-4 Using File Manager

When you want to access several cardfiles with another
pathname, you may use File Manager to change the default
settings. In situations where you are required to enter a
cardfile name, a function label appears for [[ESPKIITHE .
However, if you want to change the default pathname and
this label does not appear, you may access this label by
choosing the label on the Cardfile Tasks

menu.

To set a new default drive or directory:

1. Choose ESEGEEENE .

The File Manager Main menu appears, with a list of
the files that are found under the pathname you are
currently using.

Furthermore, the function labels assume these values:

2. Choose IRTEFHNA .

File Manager displays the Return Directory menu and
asks you to:

Select the directory name to return.

If you want to change both drive and directory, skip
steps 3 and 4.



If you want to change only the drive, type the new
drive name.

For example, to change from drive B to drive A, type:
A:

If you want to change just the directory’s name, type
the old drive name then the new directory name.

For example, to keep B as the default drive while
choosing a different default directory, you might type:

>
T
©
[
=
o
x
m

B:\BOP\

To change both the drive and directory settings, type
the appropriate new name for each.

For example, to change from drive B to drive A and
enter a new subdirectory, you might type:

A:\LULA

Pressing ends the pathname and directs File
Manager to continue.

File Manager asks for verification:

Press F1l (Return Dir) if selectionis
correct.

Choose [ETIETE.

At this point, the pathname you returned becomes
the default pathname until the next time you change
it. Even if you leave the ECM program and turn off
your computer, ECM remembers the pathname you
are using.

Choose to return to the ECM Main
menu.
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Renaming a
Cardfile

E-6 Using File Manager

Using File Manager to rename a cardfile requires renaming
each of the three disc files which comprise that cardfile.
For example, to rename an IMPORTS cardfile to EXPORTS,
you must:

B change IMPORTS-EDT to EXPORTS-EDT
# change IMPORTS.EFM to EXPORTS-EFM
@ change IMPORTS.EIX to EXPORTS-EIX

To call up File Manager:

1. Start from the Main menu.

2. Choose to display the Cardfile Tasks
labels:

3. Choose ISEHIIN.



4. Choose [ISEEETIE.

This displays the File Manager Main menu.

urn X B
Return Dir:
Dir to Disp:
Displayed Dir
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Looking for
File Names

E-8 Using File Manager

The File Manager Main menu consists of a series of names
with a listing of the files that appear under the pathname
you are currently using. Remember, however, File Manager
works with file names; not cardfile names.

Since you want to change the file names for a particular
cardfile, your first task is finding the appropriate file
names.

If you can see the three files for your cardfile, you may
proceed directly to the section on Changing the File
Name.

If you don't see the names, one of two situations has
occurred:

@ If your disc contains more files than File Manager can
display at one time, you must cycle through the list until
the names appear.

@ If your disc contains several subdirectories, the files may
be in another subdirectory.

To display other files:

1. Press the key.

File Manager updates the display with the next
screen-full of names.

2. Pressing the key returns the display to the
previous screen-full of names.



To look for your files in another subdirectory:

When the File Manager Main menu appears, the function
labels assume these values:

7 8Back Ta
Ecm

Choose [TFTETSHE-

File Manager displays the Choose Directory menu and
asks you to:

Select the directory name to display-
Type the pathname for the directory you want to see.
Pressing ends the pathname and directs File
Manager to continue.

File Manager displays the requested directory. (If you
want to see the contents of another directory, repeat
steps 2 and 3.)

Choose to return to the File Manager
Main menu after you have found the proper files.
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Changing the  After displaying the necessary files, you must change the
File Name  name for each of these files.
To change a file’s name:

1. Start from the File Manager Main menu.

The function labels have these values:

2. Choose IEEPEIIISEEY.

The function labels assume these values:
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3. Choose to display the Rename File

menu.

( z

Rename file:
To file:

Displayed Dir: #i}

076520 bytes available.

J

4. Move the pointer to one of the three file names that
make up your cardfile.

For example, you could position the pointer to

L 1neorTs ep7
5. Press the key to choose this file.

You may use touch to choose the appropriate file, if your
personal computer supports this feature.

Computer
Museum

Using File Manager E-11

3 xipuaddy



Caution w

E-12 Using File Manager

Type the new cardfile name, followed by a period (.),
and the same three-letter extension.

For example, if you are renaming IMPORTS.EDT, you
would type EXPORTS.EDT.

Type the different parts of the file’s name (that is, the cardfile
name, the period, and the extension) with no intervening
spaces.

8.

9.

10.

Press to end the name.
File Manager displays the new name and asks you to:

Press FlL (Start Rename) if selectionis
correct.

If you change your mind, choosing
allows you to enter a different name.

When you are satisfied with the name, choose

[ Start Renane B
File Manager informs you it is:
Renaming the selected file.

Repeat steps 4 through 9 to rename the other two
files that make up this cardfile. Remember to use the
appropriate extension in each case.



To return to ECM:

After you finish renaming all three files, you must unravel
yourself from the Rename File menu.

1. Choose [EETETIFIA

The File Functions menu appears, and the function
labels assume these values:

7 Reramé 8 Exiy
. File  EileFetr

2. Choose to display the File Manager
menu:

3. Choose ENTERTE.

The Main menu appears, and ECM displays the
cardfile with which you were working.

Using File Manager E-13
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Getting a
Cardfile with
File Manager

E-14 Using File Manager

If ECM requests a cardfile’s name then rejects the name
you supplied, you may use File Manager to inspect your
directory to see if that cardfile exists.

1. Start from the Main menu.

2. Choose to display the Cardfile Tasks
labels:

3. Choose I

ECM requests the name for a cardfile.

If you want to see what cardfiles exist under the
default pathname, take the following steps.

4. Choose to display the File Manager

menu:




5. Choose [REESEEN-

This displays the Return File menu:

Return File:

Displayed Dir: MY
4058040 bytes available.
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6. Look for the names of the three files that make up
the cardfile you want.

If you see the names on this screen, you are ready to
pass this information back to ECM.

If you don't see the three file names, they may be on
another screen or in a different subdirectory.

Using File Manager E-15



E-16 Using File Manager

To display other files:

1.

Press the key.

File Manager updates the display with the next
screen-full of names.

Pressing the key returns the display to the
previous screen-full of names.

To took for files in another subdirectory:

1.

Choose SITTISYEN.

File Manager displays the Choose Directory menu and
asks you to:

Select the directory name to display-
Type the pathname of the directory you want to see.

Pressing ends the pathname and directs File
Manager to continue.

File Manager displays the requested directory. (If you
want to see the contents of another directory, repeat
steps 2 and 3 until you find the required files.)



4, Choose TIPS

The File Manager Main menu appears with a listing
of the last directory you were inspecting.

To send the cardfile to ECM:

Since you have found the files that make up your cardfile,
you are now ready to send this information to ECM.

1.

Move the pointer to the name of one of the three files
that make up your cardfile.
Press the key to choose this file.
File Manager displays that file’s name and asks you
to:
Press F1l (ReturnFile) if selection is
correct.

Be sure you have chosen a file from the cardfile you
want to see.

If you made a mistake, choose and
choose another file name.

Using File Manager E-17
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E-18 Using File Manager

4,

When you are satisfied with your choice, choose

[ ReturnFile B

This displays the File Manager Main menu where the
full name for that file is given as the Return File (for
example, Return File: B:\IMPORTS.EDT).

Choose FHTEIA .

Since you left ECM while getting a cardfile, ECM
returns to the Cardfile Tasks menu, and the name for
the cardfile appears on the input line. Furthermore,
ECM still requests that you:

Type a cardfile name and press ENTER.-

Because ECM ignores extensions, it will interpret
B:\IMPORTS-EDT as if it were B:\IMPORTS.

6. As the cardfile’s name already appears, press to

direct ECM to continue.
ECM informs you it is:
Opening the cardfile.

In a few seconds ECM displays the cardfile you
requested on the Main menu.



Reference Guide to
Error Messages

This appendix lists the various messages that ECM
provides to alert you that something has gone wrong. Most
messages fall into one of two categories:

B user-input errors

m hardware-related errors

Most user-input errors have simple solutions. In many
cases, the diagnosis of the problem (for example, Can't
create cardfile--no fields were defined) suggests
the solution (that is, define a field).

3 xipuaddy

The solution to other user-input errors may be less
obvious. For example, when initiating an operation, you
may have given ECM incomplete or inaccurate information.
Although the message explains why ECM can’t continue
(for example, Can't copy to the current cardfile), you
should consult this appendix for an analysis of the
condition under which this message appears and the
corrective action (or remedy) to take.

Reference Guide to Error Messages F-1



The other major category identifies system problems. In
some cases, ECM fails to communicate with a supporting
device. For example:

# Can't dial--check your modem

@ Can't print ... Check your printer

In these situations, you should refer to the owner’s manual
for that device to ensure that you have connected the
device properly.

Another system problem that may occur is the failure of
ECM to read a disc. This may indicate that the information
on the disc has been scrambled or that the disc itself is
faulty.

Caution Since disc errors can occur, you should routinely back up the
w work discs that contain your cardfiles and use a working copy
of the ECM Application disc and keep the master application

disc in a safe place.

F-2 Reference Guide to Error Messages



When a disc error occurs:

When ECM displays a message suggesting a disc error has
occurred, you should take the following steps to try and
isolate the problem.

1.

Use File Manager to inspect the contents of the
questionable disc. (See Appendix E.)

When the message involves a name, verify that the
disc contains the cardfile (or file) within the directory
and pathname you used.

If the operation requires disc space, be sure that
sufficient room exists to complete the operation.

Check that the disc is not write-protected.

If the disc is not write-protected, try using another
disc.
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If none of these steps work, get the back-up copy of
the suspect disc, make a new copy of that disc, then
continue the task you were doing.

If you must go to your back-up disc to continue, you
should check your cardfiles to see how up-to-date they are.
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Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

F-4 Reference Guide to Error Messages

Can't complete getting this format.
Check your disk-

ECM encountered a problem when
attempting to access a previously saved
print format.

Use File Manager to verify that the disc you
are accessing contains the required file.

Can't complete the Load- Check your
disk-

ECM encountered a problem when
attempting to access values that were
previously stored for the Modem menu.

Use File Manager to verify that the disc you
are accessing contains the required file.

Can't complete the Save. Check for a
full disk.

When you attempted to save a print format
or values from the Printer Setup or Modem
menu, ECM failed to complete the task.

ECM requires a certain amount of disc
space for its own use. Therefore, use File
Manager to determine how much space
remains on the disc you are using. If
sufficient room exists, follow the steps
under When a disc error occurs.



Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Can't copy to the current cardfile.

You have attempted to replace or append a
copy of the current cardfile onto itself.

If you want to append a copy of a cardfile
onto itself, first make a copy of the current
cardfile using another name, and then
append a second copy of the cardfile to the
new cardfile.

Can't create cardfile--no fields were
defined.

When creating the form for a new cardfile,
you failed to include any fields in the final
design.
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Place at least one field on the card form.
l2next; next

Can't dial--check your modem-

ECM failed to establish contact with your
modem when you attempted to place a
telephone call.

Check that the modem is connected
properly, and all switches are set correctly.

Can't dial--invalid use of code names
and/or substitution values.

When you attempted to place a phone call,
ECM used information from the Modem
menu, only to find that an inconsistency
exists.

Consult Chapter 16 for the proper way to
use “Dial Codes”.
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Message: Can't dial--modem instructions do not
include a place for the phone number.

Condition: When you attempted to place a telephone
call, ECM sent the information you
supplied in the Modem menu but you
omitted placing a substitution character for
the phone number.

Remedy: When you enter the Modem Instructions in
the Modem menu, be sure to include an
exclamation point (.) after the dial code
(ATD). When placing the call, ECM
substitutes the proper number for this

symbol.
Message: Can't find file.
Condition: ECM can't find a disc file with the name

you supplied.

Remedy: Follow these steps:

1. Be sure you have spelled the name
correctly and provided the proper
pathname.

2. If you have, use File Manager to
determine if the file is on this disc.

3. If it is, follow the steps under When a
disc error occurs.
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Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Can't finish copying to the disc file.

When you attempted to transfer out
information to a holding file, ECM couldn't
write to the destination file.

Follow the steps under When a disc error
occurs.

Can't Merge or Append-cardfile forms
do not match.

ECM cannot merge or append data from
one cardfile to another unless card forms
have these characteristics:

1. same key field,

2. same number of fields,

3. same order of fields,

4. same length of fields.

4 xipuaddy

Use TRANSFER IN & TRANSFER OUT
copying to get information from cardfiles
with dissimilar forms.

Can't open or read the file ECM.MNU-
Check your disk.

Something has gone wrong with the
application disc.

Make another copy of the ECM Application

program from the Master disc, then use
this new copy.
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Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

F-8 Reference Guide to Error Messages

Can't print. Check your printer.

When trying to print the information from
a cardfile, something happened to cause
the printer to stop (i.e. out of paper).

ECM will pause and wait for you to correct
the problem by ensuring that your printer
is connected, turned on, supplied with
paper, and ready to print. When you have
done so, press and ECM will attempt
to continue printing.

Can't print. Printing cancelled.

ECM made a second try at printing but was
still unsuccessful.

Check the device Config menu to see that
the printer setting is the one you want (see
Appendix C). Check to see whether the
system is configured correctly for the
printer. If none of these steps work, follow
the steps under When a disc error occurs.

Can't read. or write to- the error
file. Check your disk-

While you are printing a cardfile, ECM
places any error messages into an error file.
ECM encountered problems in trying to
access this file.

Use File Manager to determine the amount
of available space. If sufficient room exists,
follow the steps under When a disc error
occurs.



Message

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Cardfile already exists.

You have supplied the name for a cardfile
that already exists.

Choose a different name or provide another
pathname.

DATA ERROR -- file is not ''Basic'"’
format. Transfer halted-

The “Basic” format expects data as one card
per line with commas between fields, and
(opt.) double quotes around each field.

Browse the file to be sure it is not in a

“DIF” format, or incorrect “Basic” format.

1. If it is in “DIF” format, change the
transfer type to “DIF” format, then
transfer files.

2. If there are double quotes within a field
in a “Basic” format file, remove them.
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DATA ERROR -- file is not ''DIF"'"’
format. Transfer halted-

The “DIF” format starts with the word,
TABLE, on the first line of the file, and
specific ordering of data following.

Browse the file to be sure it is not in a
“Basic’” format. If it is in a “Basic” format,
change the transfer type to “Basic” format,
then transfer files.
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Message:

Condition 1:

Remedy 1:

Condition 2:

Remedy 2:

Message:

Condition 1:

Remedy 1:

Condition 2:

Remedy 2:

F-10 Reference Guide to Error Messages

DISC ERROR-unable to close the
cardfile.

No disc resides in the specified drive.

Put the proper disc in that drive and make
sure the drive is turned on.

A disc or a disc drive is not working
properly.

Follow the steps under When a disc error
occurs.

DISC ERROR-unable to close the file.
No disc resides in the specified drive.

Put the proper disc in that drive and make
sure the drive is turned on.

A disc or a disc drive is not working
properly.

Follow the steps under When a disc error
occurs.



Message:

Condition 1:

Remedy 1:

Condition 2:

Remedy 2:

Message:

Condition 1:

Remedy 1:

Condition 2:

Remedy 2:

DISC ERROR-unable to create the
cardfile.

No disc resides in the specified drive.

Put the proper disc in that drive and make
sure the drive is turned on.

A disc or a disc drive is not working
properly.

Follow the steps under When a disc error
occurs.

DISC ERROR-unable to create the file.

No disc resides in the specified drive.

>
T
°
1]
=
2
x
-n

Put the proper disc in that drive and make
sure the drive is turned on.

A disc or a disc drive is not working
properly.

Follow the steps under When a disc error
occurs.
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Message:

Condition 1:

Remedy 1:

Condition 2:

Remedy 2:

Message:

Condition 1:

Remedy 1:

Condition 2:

Remedy 2:

Message:

Condition 1:

Remedy 1

Condition 2:

Remedy 2:
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DISC ERROR-unable to create the
workset.

No disc resides in the specified drive.

Put the proper disc in that drive and make
sure the drive is turned on.

A disc or a disc drive is not working
properly.

Follow the steps under When a disc error
occurs.

DISC ERROR-unable to delete cardfile.
No disc resides in the specified drive.

Put the proper disc in that drive and make
sure the drive is turned on.

A disc or a disc drive is not working
properly.

Follow the steps under When a disc error
occurs.

DISC ERROR-unable to delete the card-
No disc resides in the specified drive.

Put the proper disc in that drive and make
sure the drive is turned on.

A disc or a disc drive is not working
properly.

Follow the steps under When a disc error
occurs.



Message:

Condition 1:

Remedy 1:

Condition 2:

Remedy 2:

Message:

Condition 1:

Remedy 1:

Condition 2:

Remedy 2:

Message:

Condition 1:

Remedy 1:

Condition 2:

Remedy 2:

DISC ERROR-unable to get the card from
the cardfile.

No disc resides in the specified drive.

Put the proper disc in that drive and make
sure the drive is turned on.

A disc or a disc drive is not working
properly.

Follow the steps under When a disc error
occurs.

DISC ERROR-unable to open cardfile-
No disc resides in the specified drive.

Put the proper disc in that drive and make
sure the drive is turned on.

A disc or a disc drive is not working
properly.

Follow the steps under When a disc error
occurs.

DISC ERROR-unable to open the file-
No disc resides in the specified drive.

Put the proper disc in that drive and make
sure the drive is turned on.

A disc or a disc drive is not working
properly.

Follow the steps under When a disc error
occurs.

Reference Guide to Error Messages F-13
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Message:

Condition 1:

Remedy 1:

Condition 2:

Remedy 2:

Message:

Condition 1:

Remedy 1:

Condition 2:

Remedy 2:

Message:

Condition:

Remedy:
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DISC ERROR-unable to read the file-
No disc resides in the specified drive.

Put the proper disc in that drive and make
sure the drive is turned on.

A disc or a disc drive is not working
properly.

Follow the steps under When a disc error
occurs.

DISC ERROR-unable to save the card
data.

No disc resides in the specified drive.

Put the proper disc in that drive and make
sure the drive is turned on.

A disc or a disc drive is not working
properly.

Follow the steps under When a disc error
occurs.

Disc removal detecteds when correct
disc is inserted. press ENTER to
continue-.

ECM detected that you have removed a disc
from its drive.

Insert the proper disc into the drive and
continue the task you were doing.



Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

ECM is out of memory space.

ECM lacks sufficient memory space to
continue operation.

Exit the ECM program, do a hard reset of
your computer, then get back into ECM
and try the task over again.

Error. Attempt to do arithmetic on
non-numeric field.

One of the fields that you directed ECM to
sum or average while printing contains
textual information or is blank. Note that
these fields are ignored for the purposes of
sum or average calculations.

Ensure that all fields used in calculations
contain only numbers.

File already exists.

The name you supplied for a file name is
already in use within that directory.

Use a different name or provide another
pathname.

Reference Guide to Error Messages F-15
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Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:
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Improper cardfile version-not an ECH
cardfile.

You attempted to use a PCF cardfile with
Executive Card Manager.

Use the convert utility to change the PCF
cardfile to a form that Executive Card
Manager can use.

Internal error #N. Press a key to
ATTEMPT TO CONTINUE .

An error with the number shown
(represented by #N) has occurred.

Follow these steps:

1. Press any key to clear the message.

2. Follow the steps under When a disc
error occurs to ensure that the disc is
working properly, then try the same
action again.

3. If the message appears repeatedly, record
the steps that preceded it together with
the error number and call your HP
support person.

Invalid number entered-

When you specified the order on the
Reorder Fields menu that ECM should use
to transfer information, one of the values
you gave is inappropriate.

Inspect the Reorder Fields menu and make
sure that all fields contain proper values.



Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

No cardfile is open.

You tried to add or find cards or print a
cardfile when there is no current cardfile.

Get the cardfile you want and try again.

No fields have been selected. Press
''"Reorder'' to select fields.

You blanked out all the numbers on the
Reorder Fields menu, and then failed to
enter a number in any of the fields.

Display the Reorder Fields menu and enter
the appropriate numbers into the fields to
specify the transfer order.

Not a valid directory name.

You gave an incorrect response for a
directory’s name.

Follow these steps:

1. Be sure you spelled the name correctly
and provided the proper pathname.

2. Use File Manager to see if that directory
exists on the disc you are using.

Not a valid file name-
You are asked to name a new file
Follow the rules for file names given in

Chapter 7, the section on Naming a
Cardfile.
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Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:
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Note that the cardfile is open for
reading only.

The cardfile disc is write protected.

Change the write protection on the cardfile
disc.

Please put the application disc back
in the drive and press ENTER.

You have removed the ECM application disc
from its drive, and the program must
access this disc to continue.

Insert the ECM Application disc back into
its drive.

Printer configuration informationis
missing-

ECM failed to load the values stored in the
Printer Setup menu, so it used the default
settings instead.

Display the Printer Setup menu, enter the
proper settings, then save these values.

Replace the cardfile disc indrive #.
You have removed a disc with which you
were working to access a file on another
disc and then forgot to replace the original

disc.

Return the work disc to its disc drive.



Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

The card form cannot be displayed-.

ECM could not display the requested card
on the Select screen.

Exit the ECM program, and then restart
ECM and try the operation over again.

The cardfile could not be found-

ECM can't find a cardfile under the name
you have requested.

Follow these steps:

1. Ensure that you have spelled the name
correctly.

2. If you have, ensure that you have
provided the proper pathname.

3. If you have, use File Manager to see if
the cardfile is in the directory you are
using.

4. If it is, follow the remaining steps under
When a disc error occurs.

The cardfile is empty-

You tried to print, find cards, or dial a
number but the cardfile contains no cards.

Put at least one card in the cardfile.
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Message:

Condition:

Remedy

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:
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The cardfile is full-no more cards may
be added-.

You tried to add a card but no more room
exists in that cardfile.

Delete all unnecessary cards; or divide the
cardfile by creating worksets and copying
them into separate cardfiles.

The data for the card cannot be
created.

You try to create or copy a cardfile, and
ECM couldn’t accomplish the task.

Use File Manager to determine how much
room is available. If sufficient room exists,
follow the steps under When a disc error
occurs.

The field is improperly positioned-

When creating a form for a new cardfile or
a printout, you have positioned two fields
so they overlap or have attempted to place
a field on the tab row.

Use the Make/Adjust or Adjust Fields menu
to move one of the fields to another
position.



Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

The File Manager is not available.

You try to use File Manager from the ECM
program but you started ECM by bypassing
PAM.

Exit ECM then start PAM and return to
ECM, or continue the current task without
using File Manager.

The form cannot be saved-

When you attempted to save the form for a
cardfile or printout, ECM could not
complete the task.

Use File Manager to determine how much
room is available. If sufficient room exists,
follow the steps under When a disc error
occurs.
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The form information cannot be loaded
into memory.

When you tried to display a card form,
ECM couldn’t complete the operation.

Use File Manager to see if the cardfile

exists. If it does, follow the steps under
When a disc error occurs.
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Message: The maximum number of fields has been
reached-

Condition: When creating a form for a new cardfile or
a printout, you have exceeded the
maximum number of fields.

Remedy: Redesign your form so it uses a fewer
number of fields. In print, try moving fields
around to make more room at the bottom
of the form.

Message: The order number #N cannot be
specified more than once.

Condition: You have attempted to use the same
transfer number more than once on the
Reorder Fields menu.

Remedy: Remove the duplicate number and use
another number in its place.

Message: There are no fields in the print
block-
Condition: You have requested ECM to print a

document that contains text but no fields.
Remedy: Press “Yes” if you want to print only the

text. Otherwise, return to the Print menu
and include some fields in the printout.
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Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

Message:

Condition:

Remedy:

This cardfile cannot be
modified-changes will not be saved-

You tried to change a cardfile which is
read-only.

Either unwrite-protect your disc and reopen
the cardfile, or make more room available
on your disc.

This cardfile does not have an
autodial field-

You tried to place a phone call from the
Main menu, but the current card form has
no Autodial field.
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Use the Select menu to choose the phone
number that you want to call.

This field has been selected already-

When using Get Fields to design a
printout, you have selected the same field
twice.

Place the fields you have selected; then
return to the Get Fields menu and select
another copy of that field.

This field was not selected-

When using the Get Fields menu, you tried
to unselect a field that was not selected.

If you don’t want to include this field,

simply continue selecting the fields you do
want.
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Message: Too many blocks across page-

Condition: You have specified printing more than one
block across a page, but that amount of
information won't fit on a page.

Remedy: Provide the proper numbers so the width
of the repeat block times the number of
blocks is less than the width of the paper.

Message: Unable to reopen the last cardfile-

Condition: ECM attempted to access the cardfile you
were using last, but you have removed that
disc from its drive.

Remedy: Put the appropriate disc back into its drive.

If the disc is already in the drive, follow
the steps under When a disc error occurs.
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Index

AT, 16-7
Adapting an old card form, 9-3
Add menu, 11-2
leaving, 11-13
Adding a card to a cardfile, 3-2, 11-12
text to a print format, 17-27
Adjust Field menu, 17-23
Adjust Repeat Block menu, 17-30
Appending cardfiles together, 18-13
Arranging cards, 2-10
Attention code, 16-7
Auto Date field, setting, 9-27
Auto Time field, setting, 9-27
Autodial field, setting, 9-24
using, 16-14
Automatic phone dialing, planning for, 8-10
Autostart, 6-3
Averages, 17-32

BASIC format, D-45

BASIC, transferring data from, D-22
transferring data to, D-14

Banner line, 6-7

Books in ECM series, 2

Break Options menu, 17-32

Break action field, 17-35

Break field, 17-35

Bypassing P.A.M., 6-3
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C Card, 6-4
changing the information on, 13-3
deleting, 13-10
displaying single, 12-13
marking, 13-7
printing from Select menu, 13-8
Card form, 6-4, 8-2
adding fields, 9-10
adding text, 9-4
changing the length, 9-33
creating. 9-1
layout, 8-3
title, 9-7
widening, 9-5
Cardfile’s size, estimating, 18-3
Cardfile, 12-4
copying, 18-6
deleting, 10-1
getting, 12-2
locating, 7-5
merging, 18-20
modifying the card form, 19-1
naming, 7-2
replacing with a workset, 18-18
replacing, 18-9
scrolling, 12-9
sorting, 15-1
updating, 18-20
Cardfiles, appending, 18-13
combining, 18-11
Cards, finding, 14-2
locating specific, 12-11
marking all, 14-16
unmarking all, 14-17
Changing a field’s location, 9-14
a file name, E-10
an old card form, 19-8
the information on a card, 13-5
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the length of a card form, 9-33
the length of a field, 9-12
the size of the repeat block, 17-43
the sort order, 9-6
Character Sets, D-3
Code name, 16-4
Combining cardfiles, 18-11
Compact save, 18-4
Completing a search, 14-10
CONDOR, transferring data from, D-20
transferring data to, D-11
Convert.mnu, B-6
Converting a PCF cardfile, B-1
an HP150 ECM cardfile, B-6
Copy menu (File Manager), 18-41
displaying, 18-2
Copy operations, choosing between, 18-4
Copying a cardfile, 18-6
a workset, 18-15
to an electronic disc, 18-33
to another disc, 18-26
Counts, 17-32
Create menu, 9-1, 9-2
Creating a card form, 2-2, 8-2
a cardfile, 9-37
a print format, 17-7
a workset, 14-3, 15-9

Database, D-2

Date formats, 9-26

Date, printing, 17-40

Dates, filling in Add menu, 11-7
searching by, 14-30

dBASEI], transferring data from, D-20
transferring data to, D-11

Deciding upon fields, 8-3

Default pathname, 7-7

Index 3



Default pathname, changing, 7-7
Definition of common terms, 6-4
Deleting a card, 3-6, 13-10
a large workset, 10-8
another cardfile, 10-4
the current cardfile, 10-1
Defining a report format, 5-3
Dial codes, 16-4
entering, 16-9
DIF Clearinghouse, D-7
DIF format, D-7
Directory names, 7-6
Disc error, F-3
Disc, electronic, 18-10
removing, 6-13
Discarding a card, 11-13
Discs, copying between, 18-24
Displaying a card, 12-12
Drawing a form, 2-2
moving the cursor, 2-3
Drive names, 7-6
Duplicating a cardfile, 18-6

E ECM Main menu, 6-6
ECM application disc, removing, 6-13
ECM disc, making a working copy, 6-1
ECM, leaving, 6-12
starting, 6-3
Editing fields, 11-11
Electronic disc, 18-33
Empty string, BASIC format, D-4
Equipment to run ECM, 6-2
Exiting a workset, 4-3
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Failure, to print a cardfile, 18-57
to transfer a cardfile, 18-57
Field Types menu, 9-19
Field, moving, 9-15
removing, 9-16
shortening, 9-12
widening, 9-13
Fields and labels, 9-4
Fields, grouping, 9-28
removing, 9-16
reordering for transfer operations, 19-12
File extension, 7-3
File extensions to avoid, 7-4
File Manager Main menu, E-7, 18-37
File name, changing, E-10
locating, E-8
Files, storing, E-2
Filling out a card, 11-5
Find menu, 14-2
Find menu, leaving, 14-15
Finding cards, 14-2
Finding the same information in fields, 4-2
Fixed discs, using, C-2
Floating the default drive, E-3
Form letters, 17-5
Form, D-2
Format, BASIC, D-4
DIF, D-7
Full disc, 11-14
Function key labels, 20-1

Get Fields menu, 17-11
Getting, a cardfile, 1-7, 12-2
a print format, 17-16
fields for a print format, 17-18
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Group Fields menu, 9-29

Group field, defining, 9-30
searching, 14-9

Grouping fields, 9-28

H 1P Touch, using with ECM, 1-11, 1-15, 12-8
Hayes compatible modem, 16-1
Headings, 17-28
Holding file, 19-1
Home key, 6-9
Hyphen in index tab, 11-6

| Improper cardfile version, B-1
Input line, 6-7

K Key field, clearing, 9-23
reversing sort order, 9-22
Key fields, 9-20, 15-3
Keyboard, using with ECM, 12-6
HP Vectra, 5
IBM AT, 6

L rabel format, 17-21
Labels, 15-8
function key, 20-1
Leaving ECM, 1-20, 6-12
Lengthening a card form, 9-35
Literal searches, 14-22
Locating specific cards, 1-10, 12-11
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Looking at an ECM menu, 1-4

Looking for file names, E-8

LOTUS 1-2-3, transferring data from, D-22
transferring data to, D-15

Mailing labels, 17-5
MailMerge, transferring data to, D-12
Main menu, 6-6
Make/Adjust Field menu, 9-10
Making long entries in Find menu, 14-7
Marked cards, viewing, 14-19
Marking a group of cards, 14-16
Marking cards in a workset, 14-18
Marking individual cards, 13-7
Memory requirement, 6-2
Menu

Add, 11-2

Adjust Field, 17-23

Adjust Repeat Block, 17-30

Break Options, 17-32

Copy (File Manager), 18-42

Create, 9-2

ECM Main, 6-6

Field Types, 9-19

File Manager Main, E-7, 18-41

Find, 14-2

Get Fields, 17-11

Group Fields, 9-29

Make/Adjust Field, 9-10

Merge, 18-22

Modem, 16-3

Print (initial), 17-10

Print (placed fields), 17-12

Print Options, 17-13

Quick Save, 18-3

Rename File (File Manager), E-11

Reorder Fields, 19-12
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Return File (File Manager), E-15
Select, 7-2, 12-13
Set Breaks, 17-38
Sort, 15-2
Transfer In, 19-9
Transfer Out, 19-4
workset, 14-11
Merge, 18-4
Merging a cardfile, 18-20
Modem instructions, 16-6
Modem menu, 16-3
Modem menu, displaying, 16-2
filling in, 16-9
Modem name, 16-6
Modifying a cardfile, 2-7, 19-1
Mouse, using with ECM, 1-11, 1-15, 6-11

N Naming a card form, 9-37
Naming a cardfile, 7-2
Narrowing a search, 14-13
Negative searches, 14-27
New page, starting, 17-39
Numbers, filling in Add menu, 11-7
Numeric searches, 14-24, 14-30

o Open-card area, planning for, 8-5
Open-card area, 6-9
Open-card position, 6-5, 12-9

P rawm, bypassing, 6-3
PCF-to-ECM conversion menu, B-2
PCF-to-ECM conversion utility, B-1
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Page number, printing, 17-40
Pathname, changing, E-4
Pathnames, 7-5, E-3
Personal work disc, removing, 6-14
Placing a phone call, 16-13
Positioning text on a page, 17-42
Primary key field, 9-21, 15-4
Print format, 17-11

adding text, 17-27

building, 17-18

creating, 17-9

getting, 17-16

saving, 5-18, 17-15
Print menu, displaying, 17-10

initial, 17-10

with placed fields, 17-12
Print Options menu, 17-13
Printer Setup menu, 17-46

displaying, 17-46

Printer settings, 17-48
Printing a card, 1-9, 13-8

a full listing, 17-13

a report in sections, 17-3

blocks across the page, 17-44

form letters, 17-5

headings, 17-28

mailing labels, 17-5

reports, 5-2, 5-16, 17-3

statistics, 17-4

wide reports, 17-4
Pulse dialing, 16-8

Q Quick Save, 18-4
Quick Save menu, 18-3
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Removing a disc, 6-13
a field from its group, 9-32
bottom border of a card, 9-6
fields, 9-16
side borders of a card, 9-5
the old border, 9-35
Rename File menu (File Manager), E-11
Renaming a cardfile, E-6
Reorder Fields menu, 19-12
leaving, 19-20
Reordering fields, 19-12
Repeat block, 17-28
Replacing a cardfile with its workset, 18-18
a cardfile, 18-9
the bottom border, 9-35
Report format, 17-22
Reset command, modem instructions, 16-8
Restoring key values, 15-8
Return File menu (File Manager), E-15

Sample formats, 5-19
Saving a card form, 2-12, 9-37
Saving a report format, 5-18
Scrolling a cardfile, 1-10, 12-9
Search, literal, 14-22

narrowing, 14-13

negative, 14-27

numeric, 14-25

widening, 14-20

wildcard, 14-27
Searching by dates, 14-30

by telephone numbers, 14-32

by times, 14-28

group fields, 14-9
Secondary key field, 9-5, 9-22



Select menu, 12-13, 13-2
leaving, 13-11

Selecting a card, 1-13, 12-10

Set Breaks menu, 17-38

Setting break fields, 17-38
key fields, 9-3

Sharing information between programs, planning for, 8-11

Shortening a card form, 9-33

Side pages, 17-4

Slash symbol ( /), 16-4

Sort menu, 15-2

Sorting a cardfile, 9-1
by date or time, planning for, 8-9
by name, planning for, 8-7

Space limitations, 18-40

Special terms, 6-4

Splitting a cardfile, planning for, 8-13

Starting ECM, 1-2, 1-3, 6-3

Statistics from a report, 17-4

Status line, 6-7

Substitution numbers, 16-5

Subtotals, 17-38 < Mitseum |

Sums, 17-32

‘vamputer

T Telephone call, placing, 16-13
Telephone numbers, filling in Add menu, 11-8
searching by, 14-32
Telephone, using with ECM, 16-1
Templates, 3, 9-1
Terms, common, 4, 6-4
Tertiary key field, 9-22
Text on a card form, 9-4
Text, filling in Add menu, 11-6
Time formats, 9-26
Times, filling in Add menu, 11-8
Times, searching by, 14-28
Timing parameter, modem instructions, 16-8
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Tips for ECM, 1-5

Touch-tone dialing, 16-8

Transfer in, 18-5

Transfer In menu, 19-9

Transfer out, 18-5

Transfer Qut menu, 19-4
Transferring in information, 19-9
Transferring out information, 19-6

U Unmarking individual cards, 13-7

Updating a card, 3-5, 13-3

Updating a cardfile, 18-21

Using ECM with HP Touch, 1-11, 1-15, 6-11
with a keyboard, 1-3, 6-8
with a modem, 16-1
with a mouse, 1-11, 1-15, 6-11

Using File Manager, E-6

Using the Autodial Field, 16-13

\"/ VisiCalc, transferring data from, D-23
VisiCalc, transferring information to, D-16

W Widening a card form, 9-5
Widening a search, 14-20
Wildcard searches, 14-27
Workset menu, 14-11
Workset, creating, 14-3, 15-9
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HELP US HELP YOU!

By taking a moment to fill out this card, you can help HP identify your
needs as our customer. This will also guarantee that your name will be
on our mailing list to receive any special notices about this particular
software product.

Executive Card Manager (68331-90001)

Date Purchased or Received:

Month Day Year
Name:
First Initial Last

Street:

City

State: Zip Phone ( )
1. In what industry do you work?
301 O Banking, Finance, Investment 307 O Transportation, Communication, Utilities
302 O Manufacturing 308 O Insurance
303 O Distribution, Wholesale, Retail Trade 309 O Health and Medical Services
304 O Real Estate 310 O Education
305 O Agriculture, Forestry, Livestock 311 O Business and Consulting Services
306 O Construction 312 8 Public Administration/Government
2, Please check the box which best describes your occupational category.
101 O Professional Staff 105 O Educator
102 O Middle Manager 106 O Student
103 O Top Manager 107 O Retired

104 O Owner or Principal 108 O Other.

3. Please check the box which best describes the principal function you perform.

201 O Research and Development 206 O Manufacturing
202 O Marketing 207 [ Sales

203 O Finance or Accounting 208 O Personnel

204 0 Mgmt./Administration 209 O Data Processing
205 O Customer Service 210 O Other.

4. What other software products, if any, did you purchase?

Please tear out and mail in.

HEWLETT
(';1”] PACKARD Printed in US.A. 8/85
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Reader Comment Card

Executive Card Manager (68331-890001)

Comments:

We welcome your evaluation of this manual. Your comments
and suggestions will help us improve our publications. Please use
and attach additional pages if necessary.

Please circle the following Yes or No:

M Is this manual well organized?

8 Is the information technically accurate?

B Are instructions complete?

B Are concepts and wording easy to understand?

B Are examples and pictures helpful?

B Are there enough examples and pictures?

Yes No
Yes No
Yes No
Yes No
Yes No
Yes No

Please tear out and mail in.

A

HEWLETT
PACKARD

Name:

Title:

Company:

Address:

City:

State:

Zip:

Printed in U.S.A. 8/85
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Reader Comment Card

Executive Card Manager (68331-90001)

Comments:

We welcome your evaluation of this manual. Your comments
and suggestions will help us improve our publications. Please use
and attach additional pages if necessary.

Please circle the following Yes or No:

M s this manual well organized?

B [s the information technically accurate?

B Are instructions complete?

B Are concepts and wording easy to understand?

M Are examples and pictures helpful?

M Are there enough examples and pictures?

Yes No
Yes No
Yes No
Yes No
Yes No
Yes No

Please tear out and mail in.

(D

HEWLETT
PACKARD

Name:

Title:

Company:

Address:

City:

State:

Zip:

Printed in U.S.A. 8/85
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